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Micro Focus Enterprise Developer 8.0 for
Eclipse Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note:

• This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

• Check the Product Documentation section of the Micro Focus Customer Support Documentation
Web site for any documentation updates.

Product Overview

Upgrading from earlier Micro Focus products

Note: Windows-only.

This version of your product is dependent on a later version of the Microsoft C run-time system than earlier
Micro Focus products. This means that COBOL executables (.exe) built with a version earlier than 4.0
might not be compatible with the current version of the run-time products. If the behavior of your application
changes with the current version, we strongly recommend that you relink the main executable with the
current version. This will ensure that the COBOL run-time system fully handles any run-time error
conditions that might occur.

A new executable that is fully compatible with the current version can be produced without recompiling the
application, as long as the original object code is available and it is relinked with the current version.

To allow your executables to benefit from the product's latest programming and performance
enhancements, we recommend a full recompilation of your source code.

If you are using Eclipse, Enterprise Developer can automatically relink existing projects created with
Enterprise Developer earlier than 4.0 that have executable link artefacts. Eclipse displays a warning in the
Problems view that the project requires relinking. It then offers a Quick Fix action for you to execute that
will link your project with the most recent version of the Run-Time System.
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What's New
This What's New? document covers some of the new features and functions in the latest release of the
Micro Focus Enterprise Product Suite. Updates apply to the following products:

• Micro Focus Enterprise Developer which provides a contemporary development suite for developing
and maintaining mainframe applications, whether the target deployment is on or off the mainframe.

• Micro Focus Enterprise Test Server which provides a comprehensive test platform that takes
advantage of low cost processing power on Windows environments, to supply scalable capacity for
testing z/OS applications without consuming z/OS resources.

• Micro Focus Enterprise Server which provides the execution environment to deploy fit-for-purpose
mainframe workload on Linux, UNIX and Windows (LUW) environments on IBM LinuxONE (IFLs),
standalone servers, virtual servers, or the Cloud.

• Micro Focus Enterprise Server for .NET which provides the execution and modernization platform to
deploy fit-for-purpose mainframe workload on a scale-out .NET infrastructure and the Azure Cloud.

This document helps you to quickly understand the new capabilities within the 8.0 release.

Enhancements are available in the following areas:

• Micro Focus Enterprise Extension for Visual Studio Code
• Application Workflow Manager
• CICS Support
• COBOL Language Enhancements
• Code Analysis
• Compiler Directives
• Data File Tools
• Debugging
• Eclipse Integration
• Enterprise Server
• Enterprise Server Common Web Administration
• Enterprise Server Security
• JCL Support
• Mainframe Access
• Micro Focus Database File Handler
• Micro Focus Unit Testing Framework
• Open ESQL
• PL/I Support
• Terminal Emulation

Micro Focus Enterprise Extension for Visual Studio Code
Back to Top

The Micro Focus Enterprise extension for Visual Studio Code provides the following enhancements:

• The use of the Micro Focus Enterprise extension with Enterprise Developer 8.0 provides PL/I editor,
compiler and debug support. The PL/I debug support includes data breakpoints, conditions, and
signals.
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Note: The Micro Focus Enterprise extension is available from the Microsoft Visual Studio Marketplace
- click here.

Application Workflow Manager
Back to Top

This release offers the following improvements:

• A new "Select Element List" button in the action bar of the Table Results view enables you to directly
select an existing list. Navigation in the history using the backward and forward arrows is now per
Eclipse session.

• A new relationship for an action, Create Element List.
• A new JES function package - enables you to define tools in an AWM model to browse, cancel, or

delete z/OS jobs.
• The IDz Function Package Tools now support the new tool interface introduced with release 5.0.
• A new Filter Data Tool in the AWM function package.

CICS Support
Back to Top

This release introduces the following new features in Eclipse:

• A CICS Resources context menu command for CICS-enabled native enterprise server regions in
Server Explorer - enables you to manage the PCT, FCT, and PPT resources.

• Enterprise Server validation in the IDE for CICS Web Services.

• Reports validation errors where the associated enterprise server region configuration requires
adjustments to support the CICS Web service.

• Enables you to change the current configuration of the enterprise server region.
• Validates that the enterprise server region supports the CICS Web service when all validation errors

are resolved.

COBOL Language
Back to Top

The following enhancements have been made to the Micro Focus COBOL language:

• Further support for IBM Enterprise COBOL 6.3:

• JSON PARSE and JSON GENERATE statements - for JSON GENERATE, anonymous objects can
be generated using the OMITTED key word; the SUPPRESS phrase has been enhanced; the
CONVERTING phrase is supported. For JSON PARSE, anonymous objects can be parsed using the
OMITTED key word; the CONVERTING phrase is supported.

• Intrinsic functions - the following list of functions is now supported: COMBINED-DATETIME,
FORMATTED-CURRENT-DATE, FORMATTED-DATE, FORMATTED-DATETIME, FORMATTED-
TIME, INTEGER-OF-FORMATTED-DATE, SECONDS-PAST-MIDNIGHT, SECONDS-FROM-
FORMATTED-DATE, TEST-FORMATTED-DATETIME, and UUID4.

• The AMODE Compiler directive has been enhanced to allow COBOL programs full access to the 64-
bit address space (AMODE"64"). This emulates the LP"64" option in Enterprise COBOL.

• The DYNAMIC LENGTH clause, introduced in the last product release, is now supported in JVM
COBOL (as well native COBOL).
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• JVM COBOL enhancements:

• When no explicit type is declared for a variable, but the value is a non-integer numeric (for example
declare var1 = 1.23), it is assumed to be of type float-long.

• The NAME OF expression has been introduced. It returns the unqualified name of the type or
member specified.

Code Analysis
Back to Top

The Application Analysis Server enables you to access either Micro Focus Enterprise Analyzer or COBOL
Analyzer from the IDE. This release includes the following enhancements to this feature:

• A generate code search report and a single code search reports are available.
• An improved Get Direct References report.

Enhancements to the Analysis Services include:

• An enhanced Program Flow Graph
• Support for displaying the Data Flow analysis as a Graph.
• A new Eclipse preference page, Application Wide Knowledge in Window > Preferences > Micro

Focus > COBOL > Code Analysis. This enables you to adjust certain timeout settings for certain long-
running queries executed against a remote Enterprise Analyzer or COBOL Analyzer server.

Enhancements in the Rule-Based analysis include:

• The Rules preference page in Window > Preferences > Micro Focus > COBOL > Code Analysis
now supports nested rules.

Compiler Directives
Back to Top

The following Compiler directive is new in this release:

• DISPLAY-PICU - defines the way PIC U data items are displayed: either as ANSI or UTF-8.

The following Compiler directive has been enhanced in this release:

• AMODE - a new parameter "64" stores pointers in 64-bit format - see COBOL Language Enhancements
for more details.

Data File Tools
Back to Top

The following enhancement has been made to the Data File Tools:

• The Data File Editor now supports opening and editing KSDS VSAM files stored in an MFDBFH
datastore.

Debugging Applications
Back to Top

This release includes the following enhancement:
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• Enterprise Server debug configurations can now configure the Program breakpoint on main entry
point only option, which if selected, only breaks execution when the Procedure Division entry point is
called.

Eclipse
Back to Top

Enhancements are available in the following areas:

Product:

• Enterprise Developer for Eclipse is now available on Linux platforms. Includes features such as:

• Building and debugging of mainframe COBOL projects
• Support for PL/I background parse, running and debugging
• CICS Web services
• Server Explorer
• IMS support for PSB, DBD, and MFS Files
• Data File Editor
• Code analysis using the Application Analysis server

• This release supports Eclipse 4.20 (2021-06), which is shipped and installed with Enterprise Developer.
Versions of Eclipse prior to this one are not supported.

Projects:

• Apache Maven support - native COBOL and native COBOL Unit Testing projects can be incorporated
into your Maven-based lifecycles. They now accept a pom.xml file, which can be configured to run the
Maven AntRun plugin, which allows Ant-based projects to work with Maven.

• Automatic directives determination - it is now possible to specify if this should run and if you will be
prompted to perform it from Perform automatic directives determination preference, available from
Window > Preferences > Micro Focus > COBOL|PL/I > Directives Determination.

• Code Clean Up - you can configure code clean up preferences, which you can apply to your code to
ensure consistency throughout your COBOL code (for example consistent use of the PIC or PICTURE
keyword). These preferences are stored in profiles, which allows them to be shared among
development teams.

• Multi-file compilation - right-click a selection of files, and click Compile when Automatic Build is
disabled. This utilizes the Maximum compilations/links to execute concurrently option (available
from Window > Preferences > Micro Focus > Builder > Project) for native COBOL projects.

• Order of the Dependency Paths list - it is now possible to control the initial position of the new directory
in the list. Use the Insert to the beginning of dependency paths list or Append to the end of
dependency paths list options to determine the position. These options are available from Window >
Preferences > Micro Focus > Builder > Project.

COBOL Editor:

• COBOL code mining - code minings are additional content shown in the COBOL editor to give extra
context to certain code elements. Use the Window > Preferences > Micro Focus > COBOL > Editor
> Code Minings page to enable an indicator showing the number of times that a section or a paragraph
is called in your native or procedural JVM COBOL code. Select the link shown to show a list of
references in the Search view, where you can use the matches shown to jump to the actual call within
your code.

• end- delimiter tooltips - within the COBOL editor, if you hover over the end- delimiter of a statement
such as an IF or an EVALUATE statement, a tooltip showing the opening clause of the statement is
displayed. You can enable/disable this behavior from the Block matching section in the COBOL editor
preferences.

Enhanced BMS tools integration with Eclipse on Windows and Linux:
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• A BMS Preview view inside Eclipse enables you to preview the BMS screens on Windows and now on
Linux where the standalone Micro Focus BMS Painter utility is not supported.

To invoke the preview, open a BMS file in the editor and click Toggle the BMS previewer view  in
the Eclipse toolbar.

• The BMS text editor in Eclipse now offers enhanced writing support with smart editing and smart tabs,
smart Home/End caret support, collapsible sections in the BMS code, and initial syntax checking and
error reporting on background parse.

• The tree structure inside the Outline and Program Outline views now includes the mapsets and maps,
and any macro attributes and strings. Hovering an element in the views shows their properties.

• Enhanced navigation - when you navigate inside the BMS source file, the relevant fields in the BMS
Preview view are highlighted. The same fields are highlighted in the tree view inside the Outline and
Program Outline views and this works both ways - clicking on any of the nodes in the tree view
highlights the line in the editor that includes the relevant field.

Enterprise Server
Back to Top

This release provides enhancements in the following areas:

• EZ Sockets now supports up to 4096 sockets on Linux, up from 1024, and enhanced tracing.

• EZ Sockets applications, including ones that use the CICS listener CSKL (EZACIC02), can have
more simultaneous connections.

• EZ Sockets tracing now has options for logging the recent history only when any error or one of a set
of particular errors occurs. This makes it easier to use tracing to diagnose EZ Sockets issues.

• Enterprise Server dataset management - dataset maximum retention period with the ability to alter and
create reports:

• ES_JES_ENFORCE_EXPIRE_DATE - helps determine whether or not to check the expiration date
when deleting a catalogued dataset, and if expired, delete the dataset. If it hasn't expired and the
PURGE option has not been specified, the dataset is not removed. The PURGE keyword is required
to delete non-expired datasets. PURGE removes the underlying physical dataset file unless it is
referenced by another catalog entry. SMS MANAGEMENTCLASS now supports maximum RETAIN
days. See Using SMS MGMT Classes and the %SMS example command in the same topic.

• ES_JES_LISTCAT_YMD - helps determine the date format used in the HISTORY report generated
when the IDCAMS LISTCAT command specifies the ALL option.

• The EXPDT entry in a DD statement must be a four-digit year (YYYY); otherwise 1900 is the default,
which is in-line with the mainframe processing, and prevents unexpired datasets from being
erroneously removed (as was the case with the previous default of 2000). The ALTER command now
takes the TO and FOR options to enable specification of the retention period for the entry being
altered. The maximum retention period might be limited by the management class. The IDCAMS
LISTCAT command ALL parameter now generates a separate HISTORY report that shows the
creation date time and job, the last changed date time and Job, and the expiration date.

• HTTP compression - the Communications Server supports compressing large HTTP responses with
gzip, and handles gzip-compressed HTTP requests. The Common Client supports gzip-compressed
HTTP responses. Some large HTTP responses are compressed automatically if the client supports it.
Large HTTP messages can be compressed, saving network bandwidth and improving performance.

• Task-cleanup performance - the performance of post-processing for tasks in MFCS has been improved.
• ICETOOL emulation - now supports the COUNT+n and COUNT-n syntax during trailer processing,

where n is a numeric between 0-999. This adds to or subtracts from the COUNT value.
• DSNRLI now implements one-phase commit optimization where appropriate.
• Listing DEQ errors - a new caspac action, CasDEQs, enables you to list all errors that might have

occurred on DEQs either at the end of a task or while a job or a transaction was executing.
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• Enterprise Server configuration - you can now change the recording directory of the dump, trace, HSF,
and the console.log files of each region. See Alternative Enterprise Server Output Locations for
more information.

• CICS API support - the CICS API GET CONTAINER option BYTEOFFSET is now supported.
• Compression on ECI calls via CASBNCCL Client - when using the Micro Focus External Call Interface

(ECI) over TCP/IP, the request and response data flows are now compressed using RLE.

Enterprise Server Common Web Administration (ESCWA)
Back to Top

This release includes the following enhancements:

• Oracle Coherence is now available as a PAC Scale-Out repository as an alternative to Redis.
• Reduced number of Redis instances required when a PAC incompatible upgrade is performed - it is now

possible to have multiple PSORs in one REDIS instance. This allows for the REDIS instances
provisioned in the PAC to be reused.

• Enhanced PAC diagnostics via CTF - a new option on the ES Control page is now available to enable or
disable CTF for a running region without the need to recycle the region.

• ESCWA API, version 2 - includes updated versions of some of the existing API, version 1 endpoints,
with improved JSON property names, more sensible URIs. The version 2 API is a single API standard
across API endpoints. It includes a number of usability enhancements, has a better readability and
discoverability, and includes an improved API documentation.

• Enterprise Server Configuration Manager

• A variety of configuration options are available in ESCWA on the General >Advanced page for a
region.

The property grid in ESCWA shows the full list of configurable properties, categorized by group,
along with help text and some additional meta-information. Properties marked as dynamic in the
property grid can also be updated in a running region.

• A number of properties that were previously set with environment variables are now available in the
ESCWA UI. The environment variables are still supported for backward compatibility.

• Accessibility enhancements - the ESCWA UI includes a number of improvements in the areas of
usability with screenreaders, color contrast, and text and icon sizing and alignment. This is to give it an
improved compliance with the 508 and WCAG 2.1 standards.

Enterprise Server Security
Back to Top

This release includes the following enhancements:

• AWS Secrets Manager - support is available for using an AWS Secrets Manager, mfsecretsaws, as a
remote vault. See The mfsecretsaws Vault Provider .

• Protection for sensitive data - some sensitive data is now protected in the memory. This helps reduce
the risk of exposing sensitive data such as passwords in core dumps and similar scenarios.

• An option to update short names - the ESF Update mechanism enables you to change between OS
users ("long names") and ES userids ("short names") in running regions. This requires a non-default
configuration setting.

• Caching improvements - ESF caching now caches more types of requests. This helps improve the
Enterprise Server latency and throughput when external security is configured with caching.

• Support for Argon2 in password history - when Micro Focus passwords are used with the MLDAP ESM
Module and password history is enabled, use Argon2 password verifiers in the history to avoid the
potential exposure of passwords via weaker verifiers. This helps improve the security of the password-
history mechanism.
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• The product Help includes a new section, Securing Enterprise Server, which provides guidance on
improving the security of Enterprise Server installations and the applications they host. This includes
information on security and how to reduce security exposure.

JCL Support
Back to Top

This release provides the following enhancements:

• In Eclipse, a Show Spool and a Show Catalog context-menu command are available in Server
Explorer for MSS-enabled enterprise servers. These enable you to display and manage the regions'
JES spool queues and catalogs, respectively.

• Support is available for the DSENQSHR JOB statement parameter with options of ALLOW, USEJC, and
DISALLOW. You can configure the use of this parameter with the new ES_DSENQSHR environment
variable for Enterprise Server.

Mainframe Access
Back to Top

This release introduces:

• UNIX client support (EAP) - a subset of the MFDAS command-line functionality is now supported on
UNIX. Features include:

• Download, upload, and administration of data sets and JES.
• Client post-processing such as DFCONV conversion.
• UNIX Vault storage for user credentials

Attention: This feature is in Early Adopter Program (EAP) release status. We intend to provide the
finalized feature in a future release. Please contact Micro Focus Customer Care if you require
further clarification.

The Micro Focus Database File Handler
Back to Top

The Micro Focus Database File Handler offers the following enhancements:

• PostgreSQL and Microsoft SQL Server now support storing datastores, region databases, and cross-
region databases in a single physical database, instead of storing them in separate databases.

• Configurations that use a single physical database can now use a single database connection to access
all MFDBFH resources stored within.

Micro Focus Unit Testing Framework
Back to Top

The following enhancement has been made to the Micro Focus Unit Testing Framework in the IDE:

• IDE support has been added for self-contained tests.

The following enhancement has been made to the command-line version of the Micro Focus Unit Testing
Framework:
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• You can now use the Micro Focus Unit Testing Framework to build and run test cases from within
a .NET 6 environment. Install the NuGet package supplied with Enterprise Developer to enable the
mfunit extensions to the dotnet command line utility.

OpenESQL
Back to Top

This release includes the following enhancement:

• The new SQL Error Mapping feature enables you to customize how error information is returned in
SQLCODE, SQLSTATE, SQLERR and MFSQLMESSAGETEXT. For details, see SQL Error Mapping in
your product Help.

PL/I Support
Back to Top

Enhancements are available in the following areas:

PL/I compiler compatibility:

Support has been added for the following:

• Decimal Floating Point (IEEE-754-2008) when running on Intel architectures. This enables data to be
held in Densely Packed Decimal (DPD) format or in Binary Integer Decimal (BID) format. This feature is
in Early Adopter Program (EAP) release status.

• NOEXECOPS when running under the control of JCL.
• PL/I built-in functions including: ENDFILE, EPSILON, EXPONENT, ISFINITE, ISINF, ISNAN, ISZERO,

MAXVAL, MINVAL, PLACES, PRECVAL, PRED, RADIX, ROUNDAWAYFROMZERO, ROUNDTOEVEN,
SCALE, SQRTF, SUCC, and XMLSCRUB.

• The IEEE attribute on a FLOAT DECIMAL variable declaration.

PL/I compiler listing enhancements:

PL/I compiler listings now include:

• Display of options in effect and option defaults
• Unreferenced variables
• The OPTIONAL attribute for parameters

PL/I debugging:

PL/I debugging now supports:

• Hardware breakpoints in the IDE.
• STEP out of a CICS LINK level
• Much larger call stacks
• Remote debugger support on AIX and Solaris for PL/I programs running under the control of Enterprise

Server.
• Callstack generation using DWARF debug information on Linux.

PL/I EXEC Preprocessor:

• Early adopter support for an EXEC SQL statement that specifies a compiler-generated exit.

PL/I Macro Preprocessor:

• COMPILETIME/COMPILEDATE builtin functions now output without %SDEBUG/%RDEBUG pairs
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• New GETENV built-in function
• Support for CALL within a PL/I Macro
• Support for ITERATE, DEPRECATE, DEPRECATENEXT

PL/I Run-Time System:

• Improved performance of JSON builtin functions
• Improved PLIDUMP callstack accuracy on the newest Redhat and SUSE releases
• PLIDUMP Display of the offset within prologue code a signal is received within the prologue of a PL/I

Procedure
• FIXEDOVERFLOW generated upon assignment to FIXED DECIMAL variables where truncation occurs
• Support for NOEXECOPS when running under the control of JCL
• PLIHSSR now allows for use of PCB in addition to PCB Pointer in call

Terminal Emulation
Back to Top

• This release installs the Session Server component of Micro Focus Host Access for the Cloud
(HACloud). HACloud provides browser-based HTML5 access to 3270 host applications on Windows
and Linux for multiple connected users. HACloud is configured to work out-of-the-box with the default
configuration for ESCWA and MFDS and might need to be configured before you start using it.
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

The numbers that follow each issue are the Support Case Number followed by the Defect number (in
parentheses).

• Code Analysis
• Common Communications Interface
• Compiler
• Containers
• Eclipse IDE
• Enterprise Server
• Machine Administration
• Mainframe Access
• File Handling
• JCL Support
• Micro Focus Batch Scheduler Integration
• Micro Focus Communications Server
• Micro Focus Directory Server
• PL/I Support
• REXX Support
• Run-time System
• SQL: OpenESQL
• SQL Option for DB2

Code Analysis

Back to the list

• Rules in nested folders are now correctly processed, as well as rules with the same name.

(207020)

Common Communications Interface

Back to the list

• For improved security, SSL/TLS connections are now restricted to TLS versions 1.2 and 1.3 by default.
This is an industry best practice. If you need to use older, less-secure protocol versions with legacy
clients or servers you should consult the product online help for instructions on configuring TLS protocol
versions.

PSEC:103001 (87188)

Compiler

Back to the list

• When a RELEASE or RETURN statement is executed in an input or output procedure of a sort
statement, if the SORT-RETURN special register is found to contain a value of 16, then the sort should
be aborted, even in a case where the RELEASE or RETURN statement is at a lower perform level than
the input or output procedure itself. Previously, this was not happening for programs compiled to JVM
or .NET COBOL, but this erroneous behavior is now fixed.
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01723392 (104114)
• When a variable is defined in a DECLARE statement with no explicit type, but a value that is a non-

integer numeric literal, the type is assumed to be float-long (i.e. a 64 bit floating point).

(148103)

Containers

Back to the list

• The containers image build tool now supports custom Java run-times which helps to keep the size of
Java-based applications smaller. 

(182004)

Eclipse IDE

Back to the list

• COBOL formatter functionality has been enhanced with the introduction of a 'Code Clean Up' feature.
The code clean up preferences are stored in profiles, similar to the COBOL formatter preferences, and
are also applied in a similar way, within the COBOL editor. See Formatting COBOL code in the
documentation for more details.

(123034)

Enterprise Server

Back to the list

• The Security Manager passwords no longer appear in the commonwebadmin.json configuration file.

(203052)
• The X-XSS-Protection header will now be set on all requests instead of only on API requests.

01938835 (138176)
• In ESCWA, the colors and contrast have been adjusted to improve visual accessibility.

01995403 (158071)
• ESCWA now displays an improved message if there is an issue with loading the application, especially

in the case where there is a browser incompatibility.

(241013)
• ESCWA now handles enterprise server regions that use character encodings other than windows-1252.

00370773 (11742)
• In ESCWA, the Console Log page now enables you to easily traverse and navigate the log. The new

paging feature uses an API call from the Communications Server group documented in the Enterprise
Server Administration Server API, typically located at http://localhost:10086/docs/#/
Communications_Server on the machine where you have the product installed.

02085456 (191017)
• ESCWA now supports multiple PACs in a single Redis store.

(248003)
• ESCWA now handles enterprise server regions that use character encodings other than windows-1252.

(91001)
• In ESCWA, the IMS MPR Processes table on the Monitor > SEPs page now displays the new IMS Type

and PROCLIM columns from MPR PWFI support.

(182066)
• In ESCWA, on the Communications Process page you can now specify a Requested Status for the

communications process.
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00669779 OCTCR50A69378 (69378)
• In ESCWA, the CICS DCT resource now displays all fields regardless of the type. See Transient Data

Queue in your product Help for more information.

(173056)
• In ESCWA, the Catalog DCB page now displays the file size in bytes.

01909652 (138002)
• ESCWA now supports Circular Logging. On the Tracing and Logging Settings page you can now

specify the Log Max File Size and the Log File Count fields. By default, these fields are set to 1024kB
and 5 respectively. See Tracing and Logging Settings in your product Help for more information.

02083633 (191019)
• In ESCWA, a new optional Logon security resource has been added. This can be used to control

users' ability to log on. See Security Resources to Control ESCWA and API Access in your product Help
for more information.

01886579 (124022)
• CICS THRESHOLDS now support IMS. Notes modified in the following three topics:CICS Defined

THRESHOLDThresholdActive Threshold

(246113)
• You can now define and install shared SOR Models. In the SOR Model dialog box, check Shared to

enable the SOR Model to be shared between PACs. 

(244088)
• CICS Resources can now only be created via the group if they are appropriate for the functionality of

the enterprise server region.

01858819 (148068)
• For LDAP-based security in Enterprise Server, the processing of password changes has been modified

to address security issues, inconsistencies among configurations, and other issues. See Understanding
passwords with LDAP-based security in your product Help for more information.

(118088)
• Enterprise Server with LDAP-based security now denies a sign-on attempt by default if it includes a

password-change request (a new password is supplied), and the password change fails. This was the
existing behavior in some configurations but not in others. It is now consistent and configurable. See
MLDAP ESM Module Custom Configuration Information in your product Help for more information.

(108046)
• A change has been made to the way that TS queues and TD queues are stored in a PAC. This was to

ensure that deleting a 0TSQ did not also delete all queues that had a 0TSQ_ name prefix.

Note: After the update is applied you must cold start your PAC.

(183044)
• In a PAC, the SIT setting is now honored when a TS or TD is to be applied to the enterprise server

region if the TS or TD is not under a SOR, MFDBFH, or Fileshare. This means that if a SIT has to cold
start for TS or TD and the files are either in the workarea or on disk then the SIT settings will be applied,
otherwise the PAC-wide settings will be applied.

02149316 (204020)
• EZASOKET traffic will now be assigned to Communications Process instance #1. You might need to

consider this if you use load balancing.

02060014 (201009)
• When a PAC is cold started, the configuration file specified by MFDBFH_CONFIG will be uploaded to

the PSOR and a temporary file created in the enterprise server region’s workarea. This temporary file
will be used by all the processes for that enterprise server region. Subsequent enterprise server regions
joining the PAC will then create a temporary file in its workarea for the MFDBFH_CONFIG from the
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PSOR store. If an enterprise server region in the PAC is killed or is terminated abruptly than the restart
of the enterprise server region will try to recover the previous UUID left in the PAC and DEQ all
remaining ENQs in MFDBFH that were created from the previous run. New messages will be created in
the console.log identifying if the recovery was initiated and successful, if the enterprise server region
could not be recovered automatically, the region will stop. A log file will be created in the workarea with
the following file naming convention:

 Caspac_Recover_UUID_xxxxxxxxxxxx.log

For example: CASCD4012W Region was not stopped properly, recovering previous region UUID
14BAAA87B4C010BFBDE278A5F65B350C 18:15:17CASCD4014I UUID recovery file log C:\Users
\mag.CORPDOM\Documents\Micro Focus User\Enterprise Developer\WORKAREA
\RAS1\Caspac_Recover_UUID_14BAAA87B4C010BFBDE278A5F65B350C.log 18:15:18. Using
the caspac utility with the -aStatus parameter will display if the enterprise server region in a PAC has
lost its connection to the PSOR. If you determine that the region is no longer in the PAC, then you can
run the caspac utility with the -aRecoverUUID parameter to recover the enterprise server region. If
the -aRecoverUUID parameter is used, then a file will be created in the current directory with the
following file naming convention:

02081952 02123645 (182093)

Caspac_Recover_UUID_xxxxxxxxxxxx.log. 

See caspac in your product Help for more information.
• Functions have been added to file_utilities which check a given file name against either a default

blacklist containing operating system reserved file names, or a passed blacklist. Read, write, and delete
in AES and MSCPD use this function to disallow secret names which are inappropriate names.

OCTCR50A7844 (112022)
• The default users are now able to access only the corresponding areas:

mfuser -- esmaccicsuser -- CICS and enterprise server region start and stop.
jesuser -- JES related operations and areas.imsuser -- IMS related operations and areas.

01990931 (138369)
• Fileshare is no longer used to locate the Resource Definition and CNV file.

00468648 (69010)
• MQ updates did not rollback on step failure. This has been fixed.

01976727 02161235 (155010)
• PSOR stores are now prefixed by the PAC NAME and a version number enabling you to run multiple

PACs in the same PSOR, simplifying the incompatible upgrade process. The caspac utility enables you
to add the PAC Name as part of the command line parameters using -pPACName or if not specified
using the ES_PAC environment variable. See caspac in your product Help for more information.

(202162)
• The XA reconnect mechanism now attempts to reconnect to all XA entries marked as "enabled" at the

start up of the enterprise server region. To prevent the reconnect attempts, do one of the following:

• Remove the XA manager from the enterprise server region definition.
• Set the XA manager as disabled before starting the enterprise server region.

01991481 02003277 (151008)
• A new MLDAP ESM custom configuration section has been added. The [Prefix Search] option

enables the Prefix Search wildcard optimization for limiting the scope of wildcard resource entities
checked under a resource class. See MLDAP ESM Module Custom Configuration Information in your
product Help for more information.

00726158 (73180)
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• For LDAP-based security in Enterprise Server, the processing of password changes has been modified
to address security issues, inconsistencies among configurations, and other issues. See Understanding
passwords with LDAP-based security in your product Help for more information.

(118088)
• Enterprise Server with LDAP-based security will now by default deny a signon attempt if it includes a

password-change request (a new password is supplied), and the password change fails. This was the
existing behavior in some configurations but not in others. It is now consistent and configurable. See
MLDAP ESM Module Custom Configuration Information in your product Help for more information.

(108046)

File Handling

Back to the list

• The connection registration process has been enhanced to rectify a problem where XA registrations
sometimes failed to register with MFDBFH in an Oracle RAC environment.

Note: This fix is dependent upon the Oracle XA switch module being recompiled with the latest XA
switch sources.

02214893 (246077)
• SYMNAMES support has been added to the ON operand in the SELECT statement of ICETOOL.

02040047 (167028)
• When using the SELECT operator of the ICETOOL emulation, a validation check has been

implemented to ensure that when making use of the DISCARD operand, the data set opened for output
does not have an LRECL greater than the LRECL that ICETOOL is expecting. If it does, the job will
fail.This check may now cause jobs that previously ran successfully to now fail, but this behavior is now
consistent with that of the mainframe.

01978959 (199001)
• Micro Focus' ICETOOL emulation now sends carriage control characters in the LIST data set by default.

The RECFM of the LIST data set will be FBA. If NOCC is set, the carriage control characters are
suppressed and the RECFM of the LIST data set will be FB.

01685295 (97066)
• There have been some performance improvements for files opened exclusively (i.e. DISP=OLD,

DISP=NEW, and DISP=MOD), in batch jobs running under Enterprise Server.

00780741 (101034)
• The dbfhadmin utility has been enhanced to allow the integrity of a datastore to be verified, and

optionally, fixed up: use the dbfhadmin -verify -list|-recover options. See The dbfhadmin
Command Line Utility in your product Help for more information.

00778044 (90143)
• The dbfhadmin command-line utility has been enhanced to provide the capability for verifying and

optionally repairing (cross-)region databases.

02123645 (193071)
• The cross-region database heartbeat interval can now be configured using the dbfhconfig -add|-

update -heartbeat interval-in-seconds command. The default heartbeat interval remains as
5 seconds. A warning message is now output to the Enterprise Server console during region database
start-up if the heartbeat interval is configured to be >15 seconds. The larger the heartbeat interval, the
longer the time that is required to be able to recover (cross-)region database resources. Recovery can
only take place for a process if its associated heartbeat record has not heartbeat within the last
"heartbeat-interval + 5" seconds.

02155269 (202149)
• The performance of PostgreSQL optimized I/O has been improved. If you use the psqlodbc device

driver, you will need to ensure that you are running with version 12.02.0000 or later. This change has
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been tested with version 13.01.0000. To take advantage of the performance benefits of this change,
specify BatchSize=100 for each of your ODBC DSNs. Using a version of the driver earlier than
12.02.0000 could result in a performance degradation when deploying large files to datastores.

(125032)
• Table record locking and database record locking are incompatible and may lead to data corruption if

used together by separate processes when processing the same file. MFDBFH has been enhanced to
ensure that if a file is already opened in a process with table locking, all other processes attempting to
open the same file, even if requesting database locking, will also use table locking. However, if a
process has a file opened using database locking, other processes attempting to open the file will only
be allowed to do so if they are transactional files (i.e. database record locking can only be used for
transactional files). An attempt to open the file as non-transactional will fail. Refer to the Record Locking
Strategies documentation for more information.

(102011)
• MFDBFH now enforces the existing requirement that a region database used by a PAC, or a region

database used by an ES region configured to use ES_LOCK_DB, is not used by any other PAC or
ES_LOCK_DB regions. This is necessary to avoid problems such as jobs with the same name
submitted to two separate regions, but erroneously using the same region database, from being blocked
by waiting on SYSZJOBD and/or SYSZJOBN ENQs. A check is now performed during region start-up to
ensure that the region database is not already being used by another region, If it is, the region start up
will fail, with error messages indicating the cause of the failure output to the ES console. Existing ES
PACs/regions will need to be stopped and restarted for these new region database state checks to take
effect. The dbfhadmin -region -status [-reset] command has been introduced to allow a
region database's state to be displayed and, optionally, reset. See Resource Locking in your product
Help for more information..

(121030)

JCL Support

Back to the list

• The User Exit event has been updated to contain the date and time of the job submitted when the job-
ready event occurred in the past. To make use of this functionality, you must recompile the CAS User
Exit Event Manager. See mfjdjevt.cpy for more information.

(177018)
• A new environment variable, ES_JES_ENFORCE_EXPIRE_DATE , has been added to determine

whether or not to check the expiration date when deleting a catalogued dataset, and if expired, delete
the dataset. If it hasn't expired and the PURGE option has not been specified, the dataset is not
removed. The PURGE keyword is required to delete non-expired datasets. PURGE removes the
underlying physical dataset file unless it is referenced by another catalog entry.SMS
MANAGEMENTCLASS now supports maximum RETAIN days. See the example of the %SMS
command in the Using SMS MGMT Classes topic in your documentation.The EXPDT entry in a DD
statement must be a four-digit year (YYYY); otherwise 1900 is the default, which is in-line with the
mainframe processing, and prevents unexpired datasets from being erroneously removed (as was the
case with the previous default of 2000).

3190103 00368441 (12368)
• A change in behavior of the evaluation of step COND CODES has been made. The new behavior is that

step ABENDS now take precedence over normal return codes. This corrects a problem that caused a
step that returned a higher decimal value than an earlier step ABEND code to take precedence and
become the job COND CODE.

02210859 (244066)
• It was possible to run a job without required enques. To correct this, an error now occurs at the start of a

job if the required enques are missing, and the job does not run.

02164345 (203249)
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• SYSOUT datasets that were referenced in later steps were incorrectly marked as temporary, and
therefore 'PASSED' on in the job. This caused them to be deleted at the end of the job. To correct this,
those SYSOUT datasets are now 'RETAINED'.

00713567 (69460)
• The ALTER command now takes the TO and FOR options to enable specification of the retention period

for the entry being altered. The maximum retention period may be limited by the management class. 

3190103 00368441 (12249)
• The IDCAMS LISTCAT command ALL parameter now generates a separate HISTORY report that

shows the creation date time and job, the last changed date time and Job, and the expiration date.A
new environment variable, ES_JES_LISTCAT_YMD, has been added to determine the date format used
in the HISTORY report generated when the IDCAMS LISTCAT command specifies the ALL option.

3190103 00368441 (11429)
• The validation of configuration settings used by JES has been improved, together with more detailed

error messages.

02041040 (165046)
• Support for DSENQSHR has been added to JES via the ES_DSNQSHR environment variable. See the

ES_DSENQSHR topic in your product documentation for full details.

01818520 (111002)
• Two new spool housekeeping performance options, USE_DISK_HK and

DISABLE_LOCK_FOR_BULK_DELETE, have been added to enable spool housekeeping to be
processed on a local disk instead of the server. See Configuring the MVSSPLHK Housekeeping
Process in your product Help for more information.

00367284 (79030)
• GDG model support has been updated to support the assignment of an empty subdirectory value in the

allocation override configuration (see the JCL - Allocation Override sample in the Mainframe Samples
Browser).

02177846 (209041)
• In a security-enabled region, the REXX SYSEXEC or SYSPROC dataset used by IRXJCL was not

validated for user access. This has been corrected. If the user does not have permission to access
(READ) the dataset, an S913 security violation abend is generated, and "MVSAF0222S Insufficient
authority to read dataset '<DATASET NAME>'." is written to the SYSTSPRT. A message is also written
to the job log: "*MSG User not authorised to access SYSEXEC <DATASET NAME>". This fix might
require updates to the DATASET access rules.

02144158 (248013)
• In a security-enabled region, the dataset containing a REXX or TSO command was not validated for

user access. This has been corrected. If the user does not have permission to access (READ) the
dataset, an S913 security violation abend is generated, and "MVSAF0222S Insufficient authority to read
dataset '<DATASET NAME>'." is written to the SYSTSPRT. This fix might require updates to the
DATASET access rules.

02144158 (208030)
• A problem that erroneously caused some user-supplied parameters to translate from EBCDIC to ASCII

when calling DSNRLI has been corrected. The dsnrli.cpy copybook and dsnrli.inc PL/I include
file have been revised to have the full declaration of ACCOUNT-STRING. You must recompile
copybooks that use either of these modules.

(161065)
• The JCL spool file has a new format. Starting with this release, you must use the mfsplcnv tool to

convert spool files created using a previous release from the old format to the new. See Spool Files and
mfsplcnv Spool Conversion Utility in your product Help for more information.

(113011)

20 | Significant Changes in Behavior or Usage



• An excess of 999 duplicate DD statements per step caused a hang in JCL processing. This has been
corrected and an error message indicating that this number has been exceeded is now generated
(JCLCM0640U).

00775329 (90002)
• The new MFJ_LEX_LOCATION JCL environment variable enables you to specify an alternative location

for the storage of JCL lexigraphical files, which are created when a job is parsed, and stored in the
same directory as the job log by default. The alternative directory location must be accessible by all
regions that both submit and run jobs.

(116002)
• The layout, including the position of fields, in the IHAPSA.MAC and IKJTCB.MAC copybook files used to

hold information for the JCL control blocks for PLI programs has changed. To apply this fix to existing
applications, recompile and validate all PLI programs that include these copybooks.

(105043)
• MFFTP now converts from EBCDIC to ASCII in PUTs and from ASCII to EBCDIC in GETs, for files

cataloged as EBCDIC when a TYPE A or ASCII sub-command is issued and when the new
environment variable MFFTP_ASCII_CMD_XLATE is set to Y (default is N).

02157927 (202176)
• JCL job behavior has been updated to address an issue that caused the generation of a //SYSIN entry

when non-JCL statements, such as blank lines, preceded the first step. The generated //SYSIN entry
is now marked as invalid, and a JCLCM0642U parsing error is issued.

00368443 (11497)

Machine Administration

Back to the list

• A problem with using the .NET 3.5 framework has been fixed.

(204144)
• A problem with CPU conversion has been corrected.

(199042)

Mainframe Access

Back to the list

• Previously when authenticating with the mainframe, login failure messages provided too much
information which could potentially be exploited for username enumeration. Login failure messages will
now only state that invalid credentials were provided. This applies to MFDAS, MFDASMX, Mainframe
Explorer in Eclipse and Visual Studio, MVS Explorer in Eclipse, and SyncMon.

01868545 (119073)

Micro Focus Communications Server

Back to the list

• When an enterprise server region is configured to use External Security, access to the Communications
Server's "statistics" Web page is now restricted, just as access to the Communications Server log is. To
permit access to this page for secured enterprise servers do one of the following:

• Disable Communications Server control listener security by adding the following to the
Configuration Information field for the communications server:

[security]control listener=noInstruct
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Users must provide Enterprise Server credentials when prompted. This can occur when you attempt
to view the page, and when Allow unknown resources is checked in the region security
configuration (use this with caution)

• Add a resource security definition named "Statistics" to the "Communications Server" class, with an
ACL that grants READ permission to those users who should have access to the page

00368582 (11442)

Micro Focus Batch Scheduler Integration

Back to the list

• The Micro Focus Batch Scheduler Integration (MFBSI) no longer hangs while waiting for a response
from the license manager.

02006571 (162055)

Micro Focus Directory Server

Back to the list

• The mfds /s option supports the specification of the optional Enterprise Server user id and
password parameters using a configured Micro Focus Vault Facility location rather than using literal
strings for credentials. For example:

mfds /s 1 mfsecret:user/user_001/id mfsecret:user/user_001/pwdwhere user/
user_001/id and user/user_001/pwd

Are secrets stored in the default-configured vault. These values can be populated and administered
using the mfsecretsadmin utility. See Vault Facility in your product Help for more information.The
mfds /x and /g command-line options also support credentials stored in the vault.

02131532 (193088)
• If MFDS is configured to store sensitive values in the vault (for example, XA openstring or autostart

credentials), these values were not being included in legacy data format or XML export of Enterprise
Server configuration information. Subsequently, these values could not be reimported. These sensitive
values are now included in the exported data. Micro Focus recommends that you protect the exported
files with appropriate access control.

(202272)

PL/I Support

Back to the list

• Previously, if STRINGRANGE had been enabled by the -prefix stringrange compiler option, and
a user program did not contain an ON STRINGSIZE statement, there was no message printed out
indicating that STRINGRANGE had been triggered. The message now appears in this scenario.

00696776 (73031)
• Nested TYPEs (TYPE of TYPEs) are now supported.

00366179 (11649)
• Nested LIKEs (LIKE of LIKEs) are now supported.

00366181 (13419)
• A problem that prevented the CONTROLLED parameter from displaying correctly in the compiler listing

has been fixed.

01916288 (130002)
• The compiler listing file has been updated to provide enhanced output when the -xref compiler option

(cross-reference listing) is in effect. The listing file now indicates which variables and other identifiers,
such as procedures and labels, are unreferenced, and where they are declared. This helps you to

22 | Significant Changes in Behavior or Usage



eliminate unnecessary declarations, thus reducing storage requirements and improving code readability.
Where a member of a structure is referenced, this flags the entire structure as referenced. External
variables and procedures are not flagged as unreferenced. To accommodate include files, the
nomenclature for a definition (DEF) or reference (REF) in the cross-reference listing is a number of the
form n.m, where n is the line number and m is a file identifier. A list of file indenters and corresponding
file names is generated at the end of the cross-reference listing. 

02159460 (203162)
• The compiler listing file has been enhanced to indicate which variables and other identifiers, such as

procedures and labels, are unreferenced, and where they are declared. This helps you to eliminate
unnecessary declarations, thus reducing storage requirements and improving code readability. Where a
member of a structure is referenced, this flags the entire structure as referenced. External variables and
procedures are not flagged as unreferenced. To accommodate include files, the nomenclature for a
definition (DEF) or reference (REF) in the cross-reference listing is a number of the form n.m, where n is
the line number and m is a file identifier. A list of file indenters and corresponding file names is
generated at the end of the cross-reference listing.

01858879 (120030)
• An application doing a WebSphere MQ SIGNON caused an invalid result from a PL/I exponentiation

calculation if WebSphere MQ was using a locale other than C/Posix. This has been corrected for the
de_DE or derivative locale.

01991479 (155012)
• I/O directed by PUT LIST now uses BX format for type OFFSET.

(195051)
• A problem with PLIDUMP prevented control from being returned to the ON ERROR after completing the

dump when PLIDUMP was driven with the H option from an ERROR on unit that had established ON
ERROR SYSTEM. This has been fixed.

02134496 (194112)
• The dumping of H(eap) memory in a PLIDUMP now checks for patterns of three or more identical lines

and issues a "same as above" message indicating the memory range instead of printing the entire
batch of lines.

02160703 (204151)
• When using the PLIDUMP facilities H option on a system that had an artificial limit on maximum file

sizes, an infinite loop sometimes occurred if that maximum file size was reached. This has been
corrected. The PLIDUMP is now truncated at its maximum allowed size.

02162046 (203155)
• Previously, when using PLISAXA, the document length as driven to the Start of Document event was

incorrect if the XML document contained characters that exceeded hex 7F. This has now been fixed.

00381945 (61228)
• A new built-in function. SQRTF, has been added to generate an ERROR condition if its condition

operand is negative. The SQRT function has been updated to do the same. Previously, SQRT
sometimes returned a floating-point NaN.

(193100)
• In previous releases, FIXEDOVERFLOW was not raised when an attempt was made to assign a value

to a FIXED DECIMAL variable that was too large, causing the value to be truncated. The behavior has
been changed to raise an error if FIXEDOVERFLOW is not present.

02163371 (204181)
• The PL/I run-time system has been enhanced to honor the READ FILE(xx) IGNORE(x) syntax for

sequential files.

02047425 (183067)
• The OPTIONS(NOEXECOPS) attribute of a procedure statement is no longer ignored, but is now

honored for programs running under the control of JCL.
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3238380 (11686)
• A new feature, PL/I data breakpoints has been added. A data breakpoint breaks execution when a

specified memory location is written. Use of data breakpoints assumes expert-level knowledge of how
memory works, how variables are allocated, and how data is written to memory. For complete details,
see the Using Breakpoints topic in your product documentation.             

00370003 (12178)

REXX Support

Back to the list

• In a security-enabled region, the REXX SYSEXEC or SYSPROC dataset used by IRXJCL was not
validated for user access. This has been fixed. You do not have permission to access (READ) the
dataset, an S913 security violation abend is generated, and "MVSAF0222S Insufficient authority to read
dataset '<DATASET NAME>'." is written to the SYSTSPRT. A message will be written to the job log:
"*MSG User not authorized to access SYSEXEC <DATASET NAME>".Note: This fix might require
updates to the DATASET access rules.

(247033)
• EXECIO * DISKW was stopping on the first line containing no characters, writing out no further records.

Now after encountering an empty record, a line with only a linefeed is written and processing stops.

01991499 (158007)

Run-time System

Back to the list

• The native COBOL multi-threaded demo is now available for Windows development products.

(3765)
• Basic support for xterm-256color has been implemented.

(57591)

SQL: OpenESQL

Back to the list

• A performance problem in a SQL program using fixed-length character arrays when compiling a COBOL
program and using array fetch has been resolved.

02152406 (203060)
• A new feature to assist migration between databases has been added. SQL error codes and messages

may be mapped to different values or supressed to match those expected by the application.

(193003)

SQL Option for DB2

Back to the list

• An incorrect SQLCODE of -406, indicating a decimal value was too large, has been resolved by an
update that ensures flag bits for query constants are full initialized within the query common space.

00739861 (86050)
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Known Issues
Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

• The Server Core form of Windows Server 2019 is not supported.

• In Enterprise Developer 4.0 and 5.0 in an extremely small and limited set of cases, an issue could occur
with running .NET executables and .dll files, or JVM .class files, created with an earlier version of the
product. This issue only occurred if:

1. The application performs an IS NUMERIC condition test on a variable declared with USAGE
NATIONAL.

2. The application has been created with Enterprise Developer 3.0 or earlier, then executed in
Enterprise Developer 4.0 or 5.0.

In these rare cases, the IS NUMERIC test could provide the wrong answer.

In order to resolve this issue, in Enterprise Developer 6.0 and later, the .NET COBOL and JVM COBOL
run-times reject any program using IS NUMERIC on a NATIONAL item which was compiled with a
version 5.0 or earlier of the product. You receive a "missing method" exception. To resolve the issue,
you need to recompile any programs that use this construct in the newer versions of Enterprise
Developer.

Program that do not use NATIONAL data, or those that have been recompiled in Enterprise Developer
6.0 or later are not affected.

• The ChangeMan Attachment models of release 5.0 and earlier are not working in the expected manner
under Enterprise Developer 8.0. This is a result of several tools that are called with a static value=`*` in
the input parameter CMG_PROP_STATIC_SUBSYSTEM. If you want to run a ChangeMan attachment
model 5.0 and earlier under Enterprise Developer 8.0 you must remove the static value=`*` from all
CMG_PROP_STATIC_SUBSYSTEM input parameters.
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Defect number (in
parentheses).

• Application Workflow Manager
• AppMaster Builder
• Character Animator
• Code Analysis
• Common Communications Interface
• Compiler
• Containers
• Data Tools
• Dialog System
• Debugger
• Documentation
• Eclipse IDE
• Enterprise Server
• File Handling
• IMS Support
• Interface Mapping Toolkit
• JCL Support
• Mainframe Access
• Micro Focus Batch Scheduler Integration
• Micro Focus Common Client
• Micro Focus Communications Server
• Micro Focus Directory Server
• Micro Focus License Administration
• Micro Focus Support
• Panels
• PL/I Support
• REXX Support
• Run-time System
• Setup
• SQL: COBSQL
• SQL: HCO for DB2 LUW
• SQL: HCO for SQL Server
• SQL: Mainframe Batch Database Tools
• SQL: OpenESQL
• SQL Option for DB2
• Visual Studio Code

Application Workflow Manager

Back to the list

• A new AWM tool, New PL/I Project from Template, is now available.

00779503 (97001)
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• The AWM Action Descriptor Related_Save_Action now works after restarting Enterprise Developer.

02057079 (174028)
• Modeled AWM Related Close Actions were not executed if the editor was split horizontally or vertically.

This is now fixed.

01945616 (148049)
• Overrides of parameters with enabled conditions caused an error message. This has been fixed.

02225718 (238030)
• Enabled/Visible conditions of modeled AWM dialog fields were not evaluated correctly if the dialog field

properties were also returned by previous tools. This has been fixed.

01812446 (104216)
• Improved error handling when saving and uploading mainframe files has been added.

01941348 (158091)
• Local paths can now be used as a linked path by the Eclipse Create Resource tool.

01869880 (130012)
• You can now specify simple (non-object) JSON arrays in AWM JSON file descriptors. Currently, only

single-value arrays are supported. See File Descriptor for more information.

01825653 (124032)
• AWM now enables you to specify a static value in a property reference of a Table structured file

descriptor in a similar way as for JSON structured file descriptors.

(195084)
• Fixed sizing of TextArea modeled dialog fields. Read-only fields will now be sized to only fit the

contained text.

02163434 (204152)

AppMaster Builder

Back to the list

• When importing or generating a Data View, a PSB file with a .psb extension resulted in errors. This has
been fixed.

02175692 (207025)
• A problem that caused IMS Data View generation to produce an empty DDISYMB file has been

resolved by modifying the IMS Data View module code.

02004758 (156027)
• A problem with IMS Data View generation that caused a "RECORD IS LOCKED" error message has

been resolved by modifying the IMS Data View module code.

02003243 (157063)
• A problem with the GROUP BY logic for validating and parsing APSMACS member APDB2DB

erroneously caused a correlation name to be appended. This has been corrected.

00748268 (92050)

Character Animator

Back to the list

• The cobesdebug command now functions correctly on s390 Linux machines.

02126702 (204053)
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Code Analysis

Back to the list

• Some memory leaks causing a crash in the process have been fixed.

00506227 (69251)
• An issue with Data Flow analysis has been fixed.

(245019)
• Added support for analysis using the ChildrenCount attribute.

02068434 (174080)
• A new code rule has been added to general queries to identify COBOL statements ending with a period.

00488450 (204164)
• A new code rule has been added in general queries that identifies COBOL statements ending with a

period.

00488450 (202186)

Common Communications Interface

Back to the list

• An invalid request no longer gives an unexpected "GkCWI: OPEN: unable to open connection: (8)" on
Solaris 64-bit.

(221007)
• Improvements have been made to the validation of server certificates for SSL/TLS connections.

(244007)

Compiler

Back to the list

• 32-bit Intel x86 generated code only: when a statement of form 'set length of dynamic-item to var-a' is
followed immediate by an arithmetic statement using var-a, incorrect code could be generated. This has
been fixed.

(124033)
• JVM COBOL only: with ARITHMETIC(OSVS|VSC2|ENTCOBOL) set, a multiply expression that resulted

in zero due to truncation of least significant digits could result in a
java.lang.ArrayIndexOutOfBoundsException exception. This bug has been fixed.

02194495 (220102)
• SORT operations using files greater than 4Gb no longer fail for JVM COBOL programs launched with

the 'java' command instead of 'cobjrun'.

00779891 (101099)
• For JVM COBOL applications running in time zones that follow daylight savings, CURRENT-DATE

returns the wrong offset when the run-time tunables, current_year, current_month, current_day,
current_hour, current_minute, and current_second are set to a datetime that falls outside of daylight
savings, and the machine's time zone falls within daylight savings. This also occurs in the opposite case
where the datetime set falls within daylight savings but the machine's falls outside. Additionally, if
timewarp_dynamic is set to false, issues might occur if the machine's current time zone falls within
daylight savings while the datetime set by the run-time tunables does not (and vice versa). The hour
output in the return from CURRENT-DATE can differ depending on the actual machine time zone
setting.

When run-time tunables are left at their default values, JVM_COBOL CURRENT-DATE behavior is
correct.
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(246040)
• The following code:

move address of item-1 to ptr-item

Where item-1 is a group item, created incorrect code. This has been fixed.

02108263 (189014)
• The following command:

cob -x prog.cbl

Where prog.cbl contained user-defined functions, would create an executable with the wrong name,
which did not behave correctly. This has been fixed.

(7760)
• Spurious background parse errors no longer occur when switching between DIALECT"ENTCOBOL"

and DIALECT"MF" programs.

(246064)
• An EXEC statement containing incorrect syntax now receives a single appropriate error without

additional spurious messages.

(5093)
• COPY statements specifying a filename with an extension longer than 10 characters are now

successfully processed, as they were in earlier products.

02223965 (246061)
• A WRITE statement following a WRITE AFTER statement no longer produces extra, spurious blank

lines.

02177282 02212276 02202768 (212006)
• Use of ANY LENGTH arguments in user functions now work as expected.

00507152 (98059)
• Generation of a program with implied linkage parameters now completes successfully.

(202177)
• Use of $DISPLAY VCS = syntax in a multi-program source now compiles as expected.

02033283 (167013)
• The NATIVE"EBCDIC" Compiler directive now works as expected for programs that have a

CONFIGURATION SECTION header but no content. 

02260605 (255016)
• A syntax error for a statement appearing on the same line, and after a COPY statement, is now

reported with the correct error location.

(4795)
• A syntax error for a statement appearing on the same line, and after a COPY statement, is now

reported with the correct error location.

(3860)
• INSPECT REPLACING operands of unequal size now receive a run-time system error, thus preventing

data corruption from occurring.

(4667)
• A STRING statement in a program with a large amount of data now executes as expected.

02132926 (202023)
• When scrolling upwards in Character Animator, correct source lines for nested copybooks are now

always shown correctly.

02209782 (246075)
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• A bracketed abbreviated condition with implied subject and leading 'NOT' now compiles as expected.

(5249)
• A program compiled with the CHARSET"EBCDIC" directive, with a VALUE OF FILE-ID clause on a file

description entry, now executes with a correctly named file.

(7258)
• Non-ASCII characters in comment entries now appear correctly in EA reports.

00428434 (87204)
• Compilation of a DECLARE statement that is missing the AS keyword now reports a syntax error and

completes without looping.

(202291)
• A Quick Browse of data names containing DBCS characters now returns correct results.

(2840)
• Reference modification on the results of an intrinsic function now returns the correct result in all

scenarios.

(3877)
• SSRANGE messages have been enhanced to show line and file information.

00732371 (91169)
• The reference count for data items used in CALL statements is now shown correctly.

02130511 (193060)
• A program using AS as a data name now compiles successfully and is processed correctly by EA when

using an Enterprise COBOL dialect (where this is a context-sensitive reserved word only.)

(221073)
• All currency sign values that are valid for Enterprise COBOL are now correctly accepted under that

dialect.

(220072)
• EA analysis is now correct for an item referenced in the COUNT clause of an XML GENERATE

statement.

(222066)
• Non-ASCII characters in long comment lines are now correctly processed by Enterprise Analyzer

tooling.

(120026)
• A SEARCH ALL operation that contains another SEARCH ALL operation inside of the AT END clause

now evaluates its WHEN clauses correctly.

01829511 (110077)
• The EA and XMLGEN directives now produce separate XML files if the file name option in the EA

directive and the path option in the XMLGEN directive are both used.

01726038 (110026)
• Reference information in the IDE for qualified paragraph names is now correct.

(73204)
• The insertion of large amounts of replacement text from the REPLACE statement no longer causes

execution to hang.

01803571 (106074)
• A new directive, DISPLAY-PICU has been added to determine how PIC U items are displayed to the

console: either as UTF-8 or ANSI.

(142003)
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• The TYPEDEF clause cannot be used in conjunction with the DYNAMIC LENGTH clause.

(254008)
• The new NAME OF expression is now available in JVM COBOL, and returns the unqualified name of

the type or member specified.

(158040)
• The IS GLOBAL clause is now permitted for Linkage Section items in JVM COBOL code.

(70254)
• When compiling for JVM COBOL, large programs could sometimes produce invalid code, leading to a

java.lang.VerifyError on program load. This has been fixed.

01976935 (170014)

Containers

Back to the list

• When building a base Docker image on UNIX/Linux platforms, you can now supply the odbc or odbc-
dev parameters to install the odbc run-time library or odbc developer tools library respectively.

(183056)

Data Tools

Back to the list

• When a filter is set on a data file, records outside of the filter are no longer inadvertently deleted when
deleting filtered records.

02151283 (204027)
• In the Data File Editor, records are now inserted correctly, even when the files are not stored on the C:\

drive.

02084190 (194028)
• Within the Data File Editor, when data files are opened through Enterprise Server, they will now close

correctly when the related SEP is manually removed.

(235011)
• When working with data sets via ESCWA in the Data File Editor, if you attempt to filter the catalog

without first logging in to ESCWA, you will now be prompted to log in instead of being shown an error.
Also, entering correct login credentials after a previous failed login attempt no longer shows a 403 error,
but will instead correctly log in and open the catalog.

01984967 02031391 (163059)
• Cosmetic changes have been made to some of the Data File Editor dialog boxes to ensure that all

button/screen text is displayed correctly.

01984967 02031391 (162069)
• Within the Data File Editor, MFDBFH files (that is, those stored in a database) can now be opened as

either shared or exclusive.

(234017)
• In the Data File Editor, hexadecimal values can now be used in the Value field when applying a filter to

a data set.

02306658 (246107)
• In the Data File Editor, when the ruler is on, a vertical guideline is displayed down the page every 10

columns. Toggle the ruler off to remove the guidelines.

02306661 (246106)
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Debugger

Back to the list

• Opening a large core dump file in the debugger now displays an error if the file is too large to be
debugged.

01872464 (124123)
• Core files larger than approximately 1.5Gb can now be debugged on Windows, provided enough

memory is available to the debug process. If there is insufficient memory, error 1050 will be displayed by
the debugger.

02166754 (220131)
• When remote debugging to Enterprise Server, with a 3270 terminal, it no longer hangs when

connecting.

00379622 (40023)
• Level-78 items longer than 512 bytes no longer cause the debugger to crash when querying.

02096915 (185023)
• A new argument (progbponly) is available to allow program breakpoints to be used when dynamically

debugging Enterprise Server applications - see How to debug services and applications with Enterprise
Server Dynamic Debugging in the product Help for more details.

00468081 (70023)

Dialog System

Back to the list

• The create-window, show-window and create-dialog-box events are now correctly handled when
multiple versions of a dialog system application are running.

02074907 (181035)

Documentation

Back to the list

• The list of available samples in the documentation has been corrected. Previously, it incorrectly stated
that the 'airport demo' was an available sample on Linux/UNIX platforms.

(10126)
• Due to restrictions now placed on the target type of applications from which a program test originates

has meant a tweak to the Running Unit Tests in the IDE tutorial in Eclipse.

(231020)
• Additional details have been added to the documentation for Calling MVSCASPB about calling the

program for different bitisms, on UNIX platforms.

3177268 (8027)
• Context-sensitive help now exists when editing a clean-up profile (Window > Preferences > Micro

Focus > COBOL > Code Style > Clean Up)

(211016)
• Some minor changes have been made to the Packaging JVM COBOL tutorial in the documentation.

(230027)
• Minor amendments have been made to the Compiling a COBOL Program to JVM Byte Code tutorial in

the documentation.

(230025)
• Minor and cosmetic changes made to the documented Creating a Native COBOL Application tutorial in

Eclipse products.
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(232012)
• The definitions for the ASSIGN directive parameters have been corrected in the documentation.

(10604)
• A restriction has been added to the documentation stating that you cannot call COBOL programs

containing COMP-1 or COMP-2 parameters specified BY VALUE, and conversely, you also cannot call
a C program using a COBOL program containing COMP-1 or COMP-2 parameters specified BY
VALUE.

(8415)
• The documented syntax for CBL_GET_ERROR_INFO has been corrected.

(124059)
• The parameter block for CBL_GET_OS_INFO has been updated. The cblte-osi-rts-

capabilities flag now contains a bit that indicates MFDBFH enablement.

(118068)
• When debugging in the IDE, you cannot extend the length of dynamic-length variables beyond their

current size at the point of execution. Any data beyond the current size is truncated.

(209031)
• The documentation has been updated to clarify that the PREPLIST directive only affects preprocessors.

It will not produce additional content for external compiler modules (ECMs), such as the DB2 and CICS
ECMs. 

01717477 (97172)
• A note has been added to the mftrace.application and mftrace.time CTF documentation

topics to state that these properties cannot be altered once the specified application has been started.

(4881)
• The documentation for the TEXTFILE and BINFILE Emitter properties has been updated to state when

the LOCATION property is used.

(3896)
• The properties for the mf.rts CTF component have been updated/corrected in the documentation.

(195073)
• Additional links have been added to the documentation for 'dynamic length' items, to allow easier

access to all information relating to this subject.

(230024)
• The documentation has been updated to better explain some of the options available when installing the

Micro Focus License Manager.

(97130)
• A note has been added to the documentation to point out that the level numbers used in a segment

layout file do not correspond to the level numbers that are used in the COBOL source (although the
same group structure is maintained).

00778667 (97101)
• The Data File Tools restriction 'National data items are not supported in record or segment layouts' has

been removed from the documentation.

(123088)
• The Large File Support for Fileshare documentation now points you towards the permissible file limits

for indexed files.

(104263)
• The Prerequisites topic in the Scale-Out Performance and Availability Clusters section has been

updated to include the support for Oracle 19c.

02038850 (167027)
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• The Application Server JCA support for Enterprise Server topic has been updated to clarify support for
64- vs. 32-bit, and to remove indications of support for Red Hat 6.x EL on UNIX platforms.

(161102)
• The Configuring Security using Active Directory topic contained a broken link to the video covering how

to define an external security manager. This has been fixed.

02004032 (158052)
• The documentation has been updated with an example of how to initialize local-storage in exit programs

used with MFJSORT. See Exits for more information.

00780225 (105099)
• Anonymous binds have been disabled by default on MFDS instances which use "Restrict administration

access". This means that applications such as ESCWA and MFCS which query MFDS Enterprise
Server configuration data will be required to specify some form of credentials based on the MFDS
security configuration. See Class - Enterprise Server Administration in your product Help for more
information.

02209662 (244017)
• Within the documentation, refinements have been made to the tutorial: Developing a PL/I application in

Eclipse.

(236024)

Eclipse IDE

Back to the list

• Catalog Explorer filters now persist.

02113386 (191001)
• Message about Drag and Drop lacking metadata is no longer repeated in the message log.

(123022)
• An issue when opening copybooks using F3 (Go To Definition) has been fixed.

02168679 (216016)
• In Breakpoint view, the line description for COBOL JVM line breakpoints is now displayed.

02163641 (207044)
• Alphanumeric fields that contain a low-values character are no longer truncated when using the

Variables view (or Expressions view) for JVM COBOL.

02159374 (204133)
• An issue when creating a new remote project using a SAMBA connection, through a template, has been

identified and fixed.

02122144 (203185)
• An issue where the incorrect line may be highlighted when debugging COBOL has been fixed.

02173765 (202295)
• An issue has been resolved where the Show TN3270 Display context menu item sometimes did not

shown for a started server in Server Explorer when a TN3270 listener was available.

(181071)
• An issue has been fixed where copybooks may not have been found during compilation when using

linked folders with Copybook projects and Pl/I Include projects.

(224013)
• You can now successfully import an enterprise server instance from a path name containing spaces.

(244144)
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• An issue has been fixed where 'COPY statement hovers' in the editor were being shown for incorrect
lines.

(209044)
• The Console view in Eclipse no longer hangs.

02085456 (190013)
• A problem where the spool or catalog tables in Eclipse could lock up whilst editing has been resolved.

(186032)
• A fix has been applied for the font used in the Catalog view in Eclipse.

(158058)
• A focus issue has been resolved in both the COBOL and Server explorers, as well as in the context

menu handlers. Previously, consecutive context menu actions in some places would cause context
menu to appear empty until refocused; also, the Enterprise Server sub menu on a project in the COBOL
explorer did not seem to do anything.

(167113)
• On Linux, layout screen corruption has been fixed in the Spool view.

(158057)
• A restriction has been removed which prevented associating a project with an enterprise server region

through a remote ESCWA and further remote MFDS.

02026484 (162106)
• The generate process for Profiler/Code Analysis set on an enterprise server instance is no longer

performed when the instance is stopped during Eclipse's shutdown process.

(233009)
• You can now enter values larger than 100 in the record length fields when editing data sets in the

Catalog view in Server Explorer.

02099686 (190009)
• A bug in Server Explorer was expecting all servers underneath an mfds to have debug settings, which

is not the case for Fileshare servers. This has been fixed so that all valid servers are shown in both
Server Explorer and the launch configuration.

02155887 (203066)
• The target path for linked folders was not being calculated correctly when determining the output folder

for profiling results. This has been resolved.

(110096)
• There was a bug in the environment variable handling when starting regions from Server Explorer,

which caused existing environments to be overwritten, as well as aborting when comment characters
were encountered. This has been fixed.

02132903 (193080)
• A problem was identified when deserializing preprocessor settings when opening mainframe COBOL

projects, which caused selected settings to not be displayed in the IDE. This has been resolved.

02158037 (204081)
• COBCPY was not being constructed correctly when generating IMTK information and when using linked

folders in a copybook project. This has been resolved so that all expected paths are now resolved and
included in the path.

(10252)
• When generating IMTK information, the copy path for the COBOL program was not being correctly

constructed in the case where copybook paths are defined in a dependent project. This has been
resolved.

02104242 (191018)
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• The string used for constructing the path to the destination of symbolic links on Windows was not being
processed correctly. This has been resolved so that all target paths of Windows symbolic links are now
resolved correctly.

(62176)
• Within the IMS database editor, paths were not being correctly handled when non-default locations were

specified for the IMS database. This has been resolved.

02172524 (204265)
• Remote COBOL Unit Testing projects can now be created using SSH connection types.

02232653 (246125)
• It is now possible to specify input/output parameters with the same name but different direction for 01

level data items. For any other cases on same level, duplicate names are not allowed.

01894253 (124128)
• While debugging on UNIX, the variable structure is now displayed consistently when you hover the

cursor over a variable in the program.

01717087 (161001)
• The error thrown when resolving conflicts in COBOL source files using the Git Merge tool has been

fixed.

02075324 (182051)
• The Perform automatic directives determination preference has changed from a check box to a

group of radio buttons (Always, Never, and Prompt). This change has been made for PL/I and COBOL
directives determination.

(6335)
• When running the client-side connection tests for a remote server connection, the test for the Java

version on the remote host requires a minimum of version 1.8.0.192 in order to pass.

(226012)
• A new preference page has been added in the Eclipse preferences, which allows you to adjust certain

timeout settings for certain long-running queries executed against a remote EA server. Access the
preference page via Window > Preferences > Micro Focus > COBOL > Code Analysis >
Application Wide Knowledge.

(238015)
• The Determine Directives option is not supported for JVM COBOL projects, and so has been removed

from context menus relating to such projects.

(97069)
• Two new options are available to control the behavior of new dependency/copybook paths, available

from the Preferences pane - Micro Focus > Builder > Project. Select Insert to the beginning of
dependency/copybook paths list or Append to the end of dependency/copybook paths list to
control the initial position of new items added to the list.

02168679 (216017)
• Local enterprise server instances (running on a local MFDS, connected to a local ESCWA) use the

casstart and casstop commands when started/stopped. These commands are run under the local
user's credentials.

02147034 (198054)
• The ESCWA field has been added to the dialog box you must complete when using the Submit JCL to

Enterprise Server context menu option in Eclipse.

(232002)
• The Program breakpoint on main entry point only option has been added to the COBOL Enterprise

Server debug configuration. If selected, a program breakpoint causes execution to stop only when the
Procedure Division entry point is called.
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02159204 (203241)
• An enhancement has been made to enable nested rule sets (sub folders) in the XML used for rule set

import.

01947033 (148047)
• When working with Web Services within Eclipse, the Mapping Properties dialog box has been

renamed to the Properties dialog box, and the Mapping Properties tab within this dialog box was also
renamed Exit Point Handler.

(10172)
• The New Enterprise Server dialog now contains a CICS Resource definition location field that

enables you to override the use of the default CICS resources file, for CICS-enabled servers.

(231034)
• The Analysis View page from the Code Analysis preferences has been renamed to Analysis

Results. An additional colorization option has also been added for remote analysis servers.

(233003)

Enterprise Server

Back to the list

• Incorrect TS model could be used if a brief loss of connection to Redis occurred whilst writing to a
queue. This has been fixed.

(202041)
• A write to a TS or TD queue could fail (returning IOERR) once reconnected to Redis following a loss of

connection. This has been fixed.

(199057)
• The CPU Warning for a threshold incorrectly calculated that the process was using CPU. This has now

been fixed.

00367274 (26052)
• An RTS 114 resulted when using the MQPUT1 with the ES_MQMONEX exit. This has been fixed.

02026475 (161077)
• CICS transactions that are started by the EZASOKET listener EZACIC02 no longer store START data in

a TS queue. Instead the data is stored in memory as part of the interval control element. This improves
performance, particularly in a PAC, because there is no access to the PSOR (or disk) by either the
listener or the SEP running the STARTed transaction to retrieve the data.

01902124 (124038)
• CICS transactions that are started by the CKTI MQ listener no longer store START data in a TS queue.

Instead the data is stored in memory as part of the interval control element. This improves performance,
particularly in a PAC, because there is no access to the PSOR (or disk) by either the listener or the SEP
running the STARTed transaction to retrieve the data.

(152001)
• In an HSF-enabled enterprise server region, a task that was killed for exceeding a threshold sometimes

caused shared memory corruption if it was purged during a local trace table rollover. This would cause
casmgr to trap and bring down the enterprise server region. This has been fixed.

02133017 (194118)
• A SEP could stop producing system traces. This has been fixed.

02068443 (195029)
• The list of SOR models was truncated if it exceeded 256 bytes for a given type (TS or TD). Previously,

truncation could occur midway through a prefix, resulting in an incorrect prefix being applied to TS/TD
processing. This has been fixed so that truncation occurs only after the last complete prefix. In addition,
a warning message (CASSI9042W) is sent to the console log. If this message is detected, then the
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SOR models need to be reviewed and reduced to less than 256 bytes or, if not possible, then the user
exit TSTDSRUE can be used instead.

(245129)
• A performance improvement has been made so that there is no attempt to access a TSQ during REQID

generation in the START processing triggered by the EZASOKET listener.

(153017)
• A transient SEP in a PAC could hit a runtime error on process shutdown. This has been fixed.

(221080)
• The casmgr could crash after killing a process that exceeded a threshold and the enterprise server

region was configured with a positive dump_limit value. This has been fixed.

(204106)
• When a terminal is installed without a termtype defined, and the netname is already in use, a new

message "CASCL0002S Auto-install error, NETNAME xxxxx already in use" will be written to CSSL.

02166861 (221052)
• When using casout in a PAC, the PACNAME was not added as a prefix to the security call. This has

been fixed.

02008463 (156097)
• A memory corruption when synchronizing a PSOR in shared memory has been fixed.

02211316 (245052)
• When using an assembler data table that contained the Assembler Compiler Directive RLD, the length

returned by the EXEC CICS LOAD API was the total length of the data table including RLD fields and
not the data length. This has been fixed.

02178769 (216004)
• If an application was compiled in EBCDIC, the CICS SIGNON GROUPID was not converted to ASCII

before calling the ESM resulting in the specified group not being found and using the default group
instead. This is now fixed.

02065465 (176051)
• If an alias transaction was marked disabled and used in a URIMAP, the transaction was still executed.

This has been fixed.

02180247 (222112)
• The EZASOKET listener will now reject connections when no more sockets are available instead of

terminating and waiting for new sockets to be available to continue working.

02049614 (170013)
• A timing issue that could have resulted in a SEP registered in the dispatch chain even after a

registration error has been fixed.

02176557 (211023)
• An issue where a job could be dispatched after the enterprise server region had started to shutdown

has been fixed.

02103857 (191022)
• Previously a dump of all the SOR stores was taken when a dump command was issued. In future, a

dump of the SOR stores will only occur when a system dump has been requested. This will reduce the
number of dumps generated in the system.

02131841 (193081)
• When using query security for TRANSATTACH the wrong class XPCT was used instead of XTRAN, this

has been fixed.

02198966 (244051)
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• In a PAC, if an enterprise server region could not be started and casmgr failed in initialization before
connecting to the PAC, cascd could decrement the number of enterprise server regions contained in
the PAC. This has been fixed.

02055658 (176012)
• A dead lock could occur if a process had been killed whilst in a third-party program by the threshold

monitor thread. This has been fixed.

02064488 (175076)
• PCT block was not addressed under certain circumstances. This has now been fixed

02202935 (224016)
• If the entry point mapper was used to map MQ calls and the connection had been lost to MQ, a trap in

dfheibmq could occur. This has been fixed.

02082822 (182086)
• When an enterprise server region is running in a PAC, certain locks that were unnecessarily stored in

the database will now be stored in the enterprise server region’s shared memory, improving
performance.

01932670 (146018)
• Values returned in ESCWA/ESMAC for active TRANCLASS could be corrupted if CTF was active. This

has been fixed.

(244052)
• When switching for MIQM from one MQSERVER to another MQSERVER, a network error could be

returned by MQ resulting in an XA error code -5. If this happens the SEP will be recycled as the work
cannot be processed in that state any longer.

02211334 (246063)
• If an error occurs when calling SAFMGR on SEP initialization after the enterprise server region was

started successfully because the LDAP connection was lost,the SEP will now stop but the enterprise
server region will not, and the next SEP will have a chance to reconnect to LDAP.

02031096 (174010)
• If the casout utility times out, it will now close the session enabling another request to reconnect to the

server side.

01994995 (203057)
• If a TCLASS key contained the ‘@’ character then Enterprise Server could not correctly read it. This has

been fixed.

02287206 (260120)
• An issue where the group name specified on the casstart command line was not being passed and

used correctly causing the region to not stay up has been fixed. The condition was that the default
group associated with the user did not have permissions to start the region (OPERCMDS casstart).

02163023 (245046)
• In a PAC setup, ENQ's on the pipeline and webservice resources are no longer stored in the DB. They

are stored in SHM.

00775012 (91020)
• An issue with EXEC CICS DELAY API when compiling with DIALECT(OSVS) has been fixed.

02206914 (236048)
• The TABLE resource under MFESMAC now controls whether the user can modify the services in

ESMAC or ESCWA.

02131841 (194095)
• Security checks were being performed against an incorrect resource when cataloged datasets were

accessed using the data file editor. This has been fixed.
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02160499 (203144)
• A mutex was taken too early resulting in a serialization of work been processed when a terminal

disconnect was issued. This has now been fixed.

02068931 (181001)
• A link to a remote PPT was not correctly removing the PPT from the PAC resulting in a subsequent

inquire to find the PPT local. This has been fixed.

02206930 (235037)
• Improve performance by opening spool files once at the start of the process and not open/close for

each request.

01994995 (194119)
• Custom HSF fields now correctly handle the maximum data length of 255 characters.

(5794)
• In ESMAC, a Cross-Site Scripting (XSS) vulnerability has been fixed.

00376857 (104212)
• The very first record written by an initialized SEP to an extended variable length ESDS file gave an error

of EIBRESP2=110 with EIBRESP=0. This has been fixed.

00367116 (86028)
• When using the Micro Focus External Call Interface (ECI) over TCP/IP, the request and response data

flows are now compressed using RLE.

3207572 (13314)
• Under some conditions, when a security look up failed the administrative LISTRESOURCE request

would be driven. If the target class contained a significant number of members, the time taken to
complete this could impact performance. A change in the ESM interface means the LISTRESOURCE
request is no longer being executed.

00748245 (88213)
• When a LINK explicitly or implicitly specifying a remote transaction ID, EIBTRNID would be incorrectly

populated with the target transid. This has been fixed.

02250109 (252012)
• The wait time for an internal event has been reduced to 2 milliseconds improving the responsiveness

when cancelling a blocking CICS API - for example DELAY.

01894081 (127029)
• When performing a dynamic remote LINK; that is, when using the SYSID option a PPT entry was being

erroneously created in the local enterprise server region. This has been fixed.

02156790 (203165)
• The JCL user impersonation feature was returning an invalid long name length and value. This has

been fixed.

00753324 (92042)
• Long running TN3270 (Terminal and Printer) conversations where data was sent to the device would

result in a memory leak in the MFCS process. This has been fixed.

02055505 (182071)
• The response fields EIBRESP & EIBRESP2 returned by EXEC CICS QUERY SECURITY were not

correct in all cases. This has been fixed.

00725682 (86163)
• When starting a debug session, particularly when remote, an internal shared memory lock would result

in the enterprise server region becoming unresponsive until the session was established. This has been
fixed.

02158284 02177256 (203215)
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• Enterprise Server now appropriately populates the entity name when validating remote file access for
mfDataTools2.

02111703 (191045)
• CASCD will no longer clear all remaining locks in the region database if it is being shut down while in

quiesce mode.

(185025)
• A buffer insertion logic error resulting in a truncated Enterprise Server Environment has been fixed.

01920281 (142016)
• The ESMAC HTTP status codes have been updated to be more appropriate for certain errors.

(202271)
• Enterprise Server will no longer perform a recursive call while waiting for a TRANCLASS dispatch in a

PAC.

02168754 (204246)
• The THRESHOLD CICS resource and its attributes are now prefixed by an underscore when exported

with casrdtex as they are Micro Focus specific. The casrdtup import utility now also requires this
underscore.

(245063)
• Parameters given to mfconfigmanagerapi calls were misaligned. The API was also using an

incompatible library causing exception handling to fail when attempting to read the definition file. This
has been fixed.

(194046)
• Dynamic debugging port operations are now under a Mutex.

02155297 (203227)
• Fixed an issue with the display of RTS error messages in the console.log file.

01838001 (116004)
• An issue where a SEP did not recycle on xa-start failure has been fixed.

01839273 (112032)
• The new user exit BKAUXTRC has been added. The BKAUXTRC exit will be called when a trace switch

occurs in an enterprise server region. The current aux trace will be closed and renamed to .bkp and
the BKAUXTRC exit is then called to archive the file so that trace is not lost in a busy system. See Exit
When a Trace Switch Occurs in an Enterprise Server Region in your product Help for more information.

(162021)
• Processing of an FCT open was inefficient for catalogued files which could give performance issues in a

PAC. This code has been improved to minimize catalog access at FCT open time.

02155752 (204036)
• If an enterprise server region is running in a PAC and a DCT is declared to be an Internal Reader, if the

Disposition field value is set to SHR then the Internal Reader queue will be stored in the SOR.
Otherwise, it will be stored on disk.

02016912 (174040)
• MQ monitor exit has been enhanced to include:- Job name (for batch jobs)- Transaction ID (CICS)-

Terminal ID (CICS)- Queue handle (so that queue names can be mapped to handles). The duration field
was incorrect when MQOPEN was called from a job. This has been fixed. There is now a new version of
casmqmon.cpy (the interface for the exit), which is shipped in $COBDIR/cpylib.

00775531 (148028)
• A new RemShrQueues action has been added to the caspac utility. This option enables you to delete

all stores called Shared_CasTSQ_RC, Shared_CasTSQ_NR, Shared_CasTDQ_RC, and
Shared_CasTDQ_NR. See caspac in your product Help for more information.
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(217010)
• In ESCWA, a new option has been added to the ES Control page to enable CTF to be dynamically

enabled/disabled on a started enterprise server region. See ES Control in your product Help for more
information.

01926245 (142040)
• A new caspac action, RemOldPAC, has been added to enable the removal of old PAC stores not

prefixed. See caspac in your product Help for more information.

(252007)
• You can now use the caslock command to view a list of locks for enterprise server regions that are

members of a PAC. See Lock Processing in your product Help for more information.

Note: You cannot use caslock to remove locks in a PAC.

02205807 (236041)
• The CICS API GET CONTAINER option BYTEOFFSET is now supported.

02112217 (190050)
• The XA recovery transaction will now be triggered after a number of seconds specified by the

ES_XA_RECONNECT environment variable. For example:

ES_XA_RECONNECT=Y,120

Where Y indicates that the reconnect processing is required, and 120 is the number of seconds before
the XA recovery transaction is triggered after a two-phase commit failure. See CICS-Specific
Environment Variables in your project Help for more information.

Note: The maximum delay is 300 seconds or 5 minutes.

01891785 01965103 (137135)
• The HTML document lang attribute now changes when the language of the ESCWA application

changes.

02010059 (156074)
• In ESCWA, removing a dynamic debugging session was incorrectly returned from the API request. This

resulted in a "Request Failed: Unexpected error processing request" message on the dynamic
debugging request page in the UI. This has been fixed.

02135527 (193107)
• The ESCWA UI files are now included in Solaris builds.

(103080)
• An issue with ESCWA encoding when operating with SJIS encoding has been fixed.

02157606 (204076)
• The ESCWA Client Web API documentation has been corrected for two endpoints:/native/v1/regions/

{host}/{port}/{region}/enqmodel/view/{resource}/discardhas been corrected to:/native/v1/regions/{host}/
{port}/{region}/enqmodel/view/{resource}/uninstallIn addition:/native/v1/regions/{host}/{port}/{region}/
tsmodel/view/{resource}/discardhas been corrected to:/native/v1/regions/{host}/{port}/{region}/tsmodel/
view/{resource}/uninstall

(259031)
• The MfRequestedEndpoint value in the ESCWA configuration file (typically commonwebadmin.json)

was being set to an invalid endpoint. When the ESCWA server starts, it uses this value as the endpoint
for it to start on; if it is invalid, the ESCWA server would error and fail to start. This issue has been fixed
by added server-side validation for the MfRequestedEndpoint field: the value must be in the format
protocol:host:port; protocol must be "tcp" or "tcpssl"; host must be a valid hostname, IPv4, or IPv6
address, or "*". The port must be a valid port number or "*". Any request attempting to set
MfRequestedEndpoint to a value that does not meet these validation requirements is rejected with a
400 "Bad Request" HTTP error. If the ESCWA configuration file has already been set to an
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MfRequestedEndpoint value, the ESCWA server will still fail to start, but will now output a more specific
error message. In this case, the issue can be resolved by either manually editing the
MfRequestedEndpoint value in the ESCWA configuration file, or by starting the ESCWA server with the
following command line options:BasicConfig.MfRequestedEndpoint=tcp:localhost:10086 --
write=trueReplacing "tcp:localhost:10086" with the required endpoint.

01983736 (148074)
• Timeouts and performance issues on initially loading the spool table have been mitigated by preventing

the spool table from sending an automatic request upon visiting or reloading the page. The "List" button
now needs to be pressed to trigger the load or to apply a filter. This enables you to avoiding
unnecessary requests that might timeout.

02152418 (203033)
• The ESCWA server now has improved handling of unexpected and unsupported properties in the

configuration (commonwebadmin.json by default). An unsupported property in the default configuration
file will result in the ESCWA server logging a warning, removing the property in question, and
continuing. If an unsupported property is found and the configuration has been supplied or overridden
using command line arguments, the ESCWA server will log an error and exit. This behavior can be
controlled using the new --strict-config command line argument.

(143008)
• Safety checks for POST/PUT requests with empty bodies have been improved.

(178001)
• Improved usability of IMS API endpoints by expanding property descriptions in schemas to incorporate

relevant sections and labelling from the product documentation. The improvements will enable you
correlate API to relevant UI functionality, and to discern the purpose and relevance of schema
properties in an endpoint from reading the descriptions.

00372390 (24044)
• The browser title is now set to the name of the selected enterprise server region.

00748187 (90012)
• In ESCWA, you can now download the information you can display on the JES Catalog Entry and Spool

Job Output pages. The download functionality retrieves the values starting from page 1 and is not
restricted to a page limit. Note: The download will use the Codeset and Details values as set on the
page.

00366654 (12735)
• Issue where table row buttons could be moved past the right edge of the table and made inaccessible

has been fixed. In addition, the cosmetic bug where table row separators and row highlighting did not
extend to the right edge of the table in some circumstances has been fixed.

(237046)
• In ESCWA, to switch users you now need to logoff and then log back in using the appropriate

credentials.

(101032)
• In ESCWA, incorrect instances of "Job Control Table" have been corrected to "Journal Control Table".

(87028)
• The spool table now caches the results of the last query executed and persists those results between

pages, preventing the query from being unnecessarily rerun.

02198043 (221138)
• In ESCWA on the JES Catalog page, the RECFM list now has the VBS option.

00777434 (91091)
• In ESCWA, the catalog table now displays the error or information message when ESMAC would have

display one, including when accessing a corrupt CATALOG.

00779645 (97184)
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• There is no longer an issue with incorrect error/success messages when deleting a dataset without
relevant permissions in ESCWA. In this case, ESCWA now correctly handles the response from
ESMAC.

01810271 (123009)
• In ESCWA, modifying the SOR Connection Path(s) field in the Scale-Out Repository Configuration

dialog box  did not update the SOR connection information. This has been fixed.

01907342 (127044)
• In ESCWA, you can now resize the columns for the Spool table.

02022132 (162025)
• Errors in the ESAdminAPI.yaml file have been fixed.

(124111)
• In ESCWA, while submitting JCL through the browser, special characters are now correctly preserved.

(91119)
• The issue where the Apply button was left disabled when changing values on a Communications

Process page has been fixed. The 'Client CA Root Certificates File' field is now correctly disabled when
'TLS Enabled' is unchecked. This will not have affected Communications Processes that had 'Client
Authentication' set to "Accept all clients" before unchecking 'TLS Enabled' as the 'Client CA Root
Certificates File' is removed under that condition.

02183154 (222089)
• In ESCWA, the Spool page no longer uses deprecated ESCWA API.

(71382)
• In ESCWA, the services table now auto resizes correctly when expanding tree elements.

(99075)
• In ESCWA on the Services page, the name fields in the Service table rows are now aligned correctly.

(62209)
• In ESCWA on the Monitor page, the graph now displays Milliseconds on the left y-axis label when it is

set to display milliseconds.

(57469)
• In ESCWA, URIMAP creation is now possible when Usage is set to Pipeline. Previously, an issue with

the field validation incorrectly set the form to be in an error state when Usage is set to Pipeline, which
disabled the Save/Apply button; the validation logic has been corrected.

01858819 (118078)
• In ESCWA, the Monitor Control page has been fixed for an enterprise server region that does not have

MSS enabled.

(203107)
• In ESCWA, error messages can now be read by the screen reader.

01995465 (162038)
• In ESCWA, the keyboard navigation of the add widget's dialog has been improved.

02010047 (157066)
• The ESCWA UI has been re-themed to conform to Micro Focus standards. This changes the font, and

uses title case where appropriate along with many other style and color changes.

01995207 (157061)
• In ESCWA, the keyboard navigation of the tree has been improved.

02010055 (156075)
• ESCWA now supports various accessibility technologies including text-to-speech voice readers and full

keyboard-only navigation.
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01995445 (163045)
• A redundant error message, triggered when shutting down ESCWA, has been removed.

00370913 (126001)
• ESCWA better reflects the status of enterprise server processes in error cases when starting and

shutdown.

02229975 (246126)
• ESCWA abended when an empty body was sent in a PUT or POST request. This has been fixed.

(175064)
• An error occurred in ESCWA when trying to log on to an enterprise server region when already logged

on. This has been fixed.

(231033)
• In ESCWA, keyboard navigation issues with tree controls have been fixed.

01995458 (157059)
• The German translation for ESCWA has been updated.

(181003)
• The Content Security Policy HTTP headers on ESCWA has been improved.

(71455)
• In ESCWA, it was not possible to kill running Jobs on JES Initiators via the SEPs page. This has been

fixed.

02182889 (221070)
• In ESCWA, once modifications for a security group had been saved you could not make subsequent

saves till the page was refreshed. This has been fixed.

(138140)
• When creating an ESM user, specifying a group did not add them to that group. This has been fixed.

(143028)
• In ESCWA, the display of region trace has been fixed.

(221090)
• ESCWA will now display transient SEPs on the SEP List Page.

(198051)
• The occasional "Unable to locate translation string!" messages from ESCWA Server on AIX were

incorrectly displayed. This has been fixed.

(151015)
• Setting the IMS Transaction Log Path field on an enterprise server instance though ESCWA has now

been fixed.

(246119)
• In ESCWA, the Web Services field on CICS URIMap resources was being marked as required when it

is not. This has been fixed.

01983729 (148077)
• In ESCWA, the CICS URIMAP Cipher field now supports .xml filenames.

(122016)
• The URIMap Cipher field's validation now account for xml files as permitted input.

(107003)
• In ESMAC, a new option has been added to the Control page to enable CTF to be dynamically

enabled/disabled on a started enterprise server region. See Control in your product Help for more
information.

(146114)
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• ESCWA now supports displaying Queued Requests by TRANCLASS when the enterprise server region
is a member of a PAC.

(189004)
• Support has been provided for Pseudo Wait-for-Input enablement in IMS MPRs. See IMS Configuration

in your product Help for more information.

(70273)
• In ESCWA, on the IMS Transaction page the SPA Truncate list has been converted to a check box

and the ULC list has been converted to the To Uppercase check box.

(194113)
• In ESCWA on the Control page, a warning has been added above the Dynamic CTF File Location

field and to the API documentation informing you to set the CTF Action field to All Off before
changing the Dynamic CTF File Location field or the file being referenced.

(244057)
• In ESCWA, check mfcm on the ES Control page to trace the Configuration Manager. See ES Control

in your product Help for more information.

(220010)
• The Enterprise Server Administration Configuration dialog now has an External Communications

Response Timeout number picker, which is used to set the timeout for ESCWA requests that go
through MFCC. This timeout is equivalent to setting the MFC_TIMEOUT environment variable, but is
only applied on a per-request basis rather than an environment-level setting.

00502152 (76011)
• In ESCWA, on the Monitor page the graph's x-axis has been corrected to display time in order from

oldest to latest from left to right.

(158066)
• UDP sockets are now closed when not required by MFDS communications.

02181946 02193815 (222040)
• An issue with newly created Communications Processes being set to the started state but not actually

being started has been fixed.

(88221)
• Mfsecrets would intermittently crash on HP UNIX when certain messages were loaded. This has

been fixed.

(106063)
• The mfsecretsadmin utility no longer displays spurious allocation errors on AIX PPC.

(105093)
• When using MFSecretsAPI with the HashiCorp provider on a Solaris SPARC platform you will no

longer get an error for referenced symbol not found.

(103082)
• The mfsecretsadmin error callback formatting has changed to improve readability and remove

unnecessary information.

(8552)
• Secrets written from now on are transferable across platforms with different endianisms.

(104103)
• In the ESMSSQL switch, version 17 calls to SQLSetConnectAttr now check both the sqlrtn code

value and the status item of the XACallParam.

(110060)
• An extraneous MQ rollback for TM processes has been fixed.

(231005)
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• The DB2 switch module now provides more traces regarding CLI failures.

02202803 (239025)
• XA switches now contain logic to trace XID in the Consolidated Trace Facility (CTF).

01965103 02055821 (162072)
• The logic to parse the Open String option ESLOGGING now works correctly.

02172047 (208024)
• The Oracle switch source now has the correct data alignment to prevent RTS 114 error when more than

one Oracle XARs are specified in the enterprise server region.

01802747 (103172)
• When using ESF in Redundant mode and having multiple ESM in the relevant Security Manager List,

even though a request was successfully handled by one of the first ESM, an event failure would be
returned if the last ESM in the list reported a failure. This has now been fixed so that if the request is
successfully handled by any ESM in the list then the last ESM will not return its failure status, instead it
will be logged.

00372409 (11512)
• The MLDAP ESM, OS ESM, and PAM ESM modules now use the RACF password alphabet for

encoding short passtokens rather than the base64 alphabet.

02168078 (202221)
• The esfadmin utility is now delivered in 32 and 64-bit versions.

02182768 (218011)
• The caching mechanism of Enterprise Server's External Security Facility (ESF) is now able to cache

some requests it previously could not, such as Verify (signon) requests with long usernames or
passwords, and Auth requests for some MQ-related resources. These changes make cache records
somewhat larger, so fewer will fit in a cache of a given size. If you are using ESF caching you might
want to increase the size of your cache by 20% to 40% to account for this change if you observe a
decrease in the cache hit rate reported at enterprise server region shutdown.

02154022 (203072)
• In some configurations, Enterprise Server security could lose track of users' group membership

information in a running region or instance of MFDS after an ESF Update request. This has been fixed.

00741997 02182494 (86057)
• The validation of server certificates for SSL/TLS connections in the Micro Focus Common Client has

been improved. Specifically the standard PKIX (Public Key Infrastructure, X.509) rules are now followed
except when connecting to the server using information obtained from the Micro Focus Directory Server
(MFDS), if that information only contains an IP address and not a host name. In earlier product releases
MFCC did not enforce PKIX when using information from MFDS regardless of whether the information
included a hostname.

(52097)
• An invalid invocation of the SAFROUTE API under certain non-default configurations could cause a

divide-by-zero trap. This has been fixed.

02016793 (163052)
• The performance of the optional "prefix search optimization" feature of the MLDAP ESM Module has

been improved.

00726158 (142020)
• The External Security Facility can now optionally update the "short name" of signed-on users. See

Renaming ACEEs in your product Help for more information.

00657507 (70355)
• A CICS ASSIGN incorrectly returned a STARTCODE of TD instead of SD for transactions started by

EZASOCKET. This has been fixed.
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02004784 (156016)
• HSF statistics for some hexadecimal TS/TD queue names could be incorrectly reported. This has been

fixed.

(146013)
• HSF records for transactions PIP1, PIP2, SDP1, and SDP2 would not show a user. This has been

corrected to be the user that started the enterprise server region (or the default CICSUSER) or the user
specified by ES_ESM_PLTPIUSR.

02015176 (156099)
• HSF records would be missing when the task number rolled over from 99999. This has been fixed.

02026013 (165049)
• HSF records for transactions that were killed due to having exceeded a threshold would sometimes

have a response time of 0. This has been fixed.

01687237 01817975 (97116)
• When the casmgr process was recovering locks in mfdbfh, it was holding the shared memory lock.

While recovery was in progress, no other processes in the enterprise server region was able to access
shared memory. This was unnecessary and casmgr now releases the lock before initiating the
recovery.

02088479 02086462 02085808 (185024)
• An issue with EXEC CICS SECURITY where the the length of the entity could be passed as 0 has been

fixed.

02016793 (162070)
• A memory corruption that could occur when the monitor thread killed a process under heavy load has

been fixed.

02006375 (158087)
• New messages have been added to the console.log for startup sequences in order to be able to

troubleshoot enterprise server region startup issues.

01935739 (138172)
• If a TSQ in the SOR contained a space x'20' in the name, then the delete of the queue failed. This is

now fixed.

01829779 (182032)
• An RTS 173 occurred on an ES_mF_write_record_in_store entry point when an enterprise server

region was not in a PAC and SSTM was used. This has been fixed.

01806033 (103156)
• If a transaction executing in a PAC environment with TRANCLASS max priority active was killed by the

threshold mechanism, a hang could result on subsequent transactions executing in the same class due
to the counter not being decremented. This has now been fixed.

02168754 (209029)
• If a queue name contained an x'00' in it, the queue name was truncated when using Redis as the

repository. This has been fixed.

01872664 01890335 (123010)
• An RTS 114 occurred when a transaction had a TRANCLASS defined and the purge threshold was

reached. This has been fixed.

02144961 (204147)
• When an application, compiled with EBCDIC, issued a CICS ENQ in a PAC, the resource name

displayed in ESCWA was not correctly displayed. This has been fixed.

01965470 (148020)
• MFDBFH connections are now closed when a task is idle.
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01984788 (150015)
• When a TRANCLASS is defined for a transaction, the Active Count was not being incremented when a

CICS INQ TRANCLASS statement was performed. This has been fixed.

02094425 (189009)
• An RTS 200 that occurs when cancelling a job (that is waiting for a reply) has been fixed.

(204153)
• Enterprise Server now handles bundle manifest files that can contain multiple JSON transform

resources.

01991361 (150057)
• Latency for queued transactions in a TRANCLASS was attributed to their response times, not latency.

The latency is now correctly displayed in the latency field.

02176385 (209033)
• SCB was not being freed after normal shutdown of a transient SEP. Behavior modified to free the SCB

after this occurs to avoid issues when a SEP with the same PID is launched.

02190327 (220061)
• Loading and calling the single-threaded version of support modules within a multi-threaded process was

resulting in a hang. This has been fixed.

00779469 (92169)
• DSNRLI now implements one-phase commit optimization where appropriate.

00779302 (97165)
• Fixed an issue with CICS Web Service SOAP request handling if an invalid header is provided.

(204277)
• On an EXCI link, the COMMAREA is now returned after a user abend terminated the target CICS

program.

02016643 (161056)
• An issue with parallel one and two-phase XA connections has been fixed.

00700923 (73098)
• The value of the COMMAREA is now correctly returned after an XCTL in an EXCI request. ECI/EXCI

link to the target program is now secured, MCICSPP rules must be specified.

01827754 (111029)
• A new caspac action, CasDEQs, has been added to enable you to list all errors that might have

occurred on DEQs either at the END of Task or while a Job or Transaction was executing. See caspac
in your product Help for more information.

01941366 (157022)
• In a PAC, CICS resources could get out of synchronization in some enterprise server regions if the

resource in the PSOR was locked at update time. Previously, 3 attempts were made to acquire the
resource. The default is now 10.The environment variable ES_SOR_RETRIES can be used to modify
the number of retry attempts to between 3 and 1000. See Configuration Options in your product Help for
more information.

(143021)
• The –b option has been added to the castran utility, enabling a specified Assembler data table name

that uses RLD to be reloaded from disk. See castran in your product Help for more information.

00485855 (70095)
• The XA recovery processing now supports a retry mechanism:

 ES_XA_RECONNECT=Y,delay,retry_count
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Where retry_count is the number of recovery retry attempts to be made if the XA verbs return an xa-
retry (04) return code. In this case, messages are sent to the console. See Environment variables
in alphabetical order in your product Help for more information.

02157658 (203087)
• The command-line utility caspac, now has the RecoverUUID action that enables you to specify the

UUID of an enterprise server region that has left the PAC. The action will remove all entries related to
that enterprise server region from the PSOR. See caspac in your product Help for more information.

(185013)
• The casToken and csrf-token security has been increased by increasing the token regeneration

frequency.

00368452 (12551)
• The performance of the ESCWA Spool View has been improved when using a database hosted catalog

file and when specifying a filter with a leading wildcard character.

01856008 (138119)
• An issue with the format of messages caused ESCWA to report success as a failure. This has been

fixed.

(125020)
• The "job user" filter string entered in ESCWA or ESMAC were being folded to upper case and

sometimes resulted in records not being displayed. This has been fixed.

00469828 (57335)
• Missing JSON properties have been added to the ESCWA active PCT API.

(222149)
• Character validation for HTTP cookie values in secure regions has been added.

02132269 (202051)
• IMS support for the THRESHOLD resource has been added.

(245086)
• The fix for OpenSSL Denial-of-Service (DoS) issue CVE-2022-0778 has been applied to the product.

(221130)
• When Enterprise Server's MLDAP ESM Module is used for security, with Micro Focus password hashes

and password history enabled, history entries are now created with the correct type of hash (Argon2 by
default).

(120086)
• In Enterprise Server, when using LDAP-based security, all-groups mode, and username mapping ("long

names"), if a user's group membership was changed and the esfupdate utility was invoked with the
user option to update information in the region for that user only, the user's new group membership is
now calculated correctly. Previously some of the user's groups might have been missed when
determining the set of groups.

(98040)
• For LDAP-based security with Enterprise Server, a new configuration option (password change failure)

determines whether a failed attempt to change a password causes signon to fail. See MLDAP ESM
Module Custom Configuration Information in your product Help for more information.

00736902 (99142)
• When a PAC uses Enterprise Redis, set up a custom hashing policy using the following rules:

• Rule 1: .*?\{(?<tag>.*?)\}.*
• Rule 2: (?<tag>.*)

01872664 (152015)
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File Handling

Back to the list

• WRITE BEFORE/AFTER ADVANCING was incorrectly writing too many blank lines. This has now been
rectified.

02168624 (203229)
• The performance of opening files in SQL Server datastores has been improved.

01993173 (160010)
• The performance of opening files in Oracle datastores has been improved.

(191061)
• SQL URLs are no longer being incorrectly constructed for data set names containing '$' characters.

(245059)
• The dbfhadmin -region -list -usedb command now correctly lists SQL Server or PostgreSQL

regions which have associated legacy database names; previously, it was not.

(252010)
• A problem when attempting to deploy files greater than 2GB in size, using the dbfhdeploy utility on

Windows has been fixed. Previously, it would fail with a "file not found" error.

02047931 (165086)
• A 3/9 file status (key out of range) is now returned when an attempt is made to write to a

(line-)sequential file that would result in it exceeding a 2GB relative byte address or a 4GB relative byte
address for Oracle. Previously, it was possible to successfully write beyond the logical maximum file
size, resulting in possible data corruption. A future enhancement will allow (line-)sequential files up to
18446744073709551615 bytes (max 64-bit unsigned integer).

01720653 (99160)
• DB2 optimized I/O performance enhancements have been made for file writes.

01809549 (109025)
• When using MFDBFH, the performance of SQL Server optimised I/O writes has been improved.

(176033)
• Performance improvements have been made for cataloged files opened by CICS.

02152603 (202044)
• If an individual PAC region was killed, any resource lock acquired on behalf of the Data File Editor for

that region could not be recovered until all regions in the PAC had terminated and the PAC restarted.
These resource locks will now be automatically recovered when a PAC region is (re-)started, or as part
of the dbfhadmin -casprocess -recover processing.

02259996 (258002)
• Previously, when using SQL Server, file open operations could fail if a retriable (e.g. deadlock victim), or

transient (e.g. lost database connection) ODBC error occurred. This is now fixed.

(124075)
• A COBRT114 error that occurred intermittently when XA switch modules deregistered their MFDBFH

datastore connections has been fixed.

(146067)
• The 'Open file' processing has been enhanced to verify that attributes specified in the FCD (such as

maximum record length, file organization/format, and key definitions) are compatible with those of the
physical file. A 3/9, or 9/139 (ANSI74), file status is now returned if incompatible attributes are detected.

(163060)
• Indexes were not being created for alternate keys associated with files hosted in SQL Server databases

with record lengths greater than 8000 bytes. The dbfhdeploy upgrade command has been
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enhanced to create the required indexes for existing files with record lengths greater than 8000 bytes
(e.g. JES catalog.dat files).

02038202 (167010)
• Various table record locking performance improvements have been made.

(104139)
• Enterprise Server region start-up will now fail if MFDBFH detects that the CSA record in the region

database is missing. An error message will be output to the console indicating the cause of the problem
and the dbfhadmin -verify -recover -usedb server-name -name region-name
command that needs to be run to restore the missing record.

02193998 (220081)
• The dbfhadmin -casprocess -list|-recover command was failing to identify "in doubt"

processes for Oracle Enterprise Server regions, which prevented the recovery of resources owned by
non-active processes. This has now been resolved.

(148038)
• A COBRT114 error sometimes occurred when executing a WRITE AFTER ADVANCING PAGE

statement. This has been fixed.

(182045)
• An ODBC error sometimes occurred when deleting a record from a recoverable TDQ hosted in a

PostgreSQL database. This has been rectified.

(221126)
• Vaulted Oracle connection strings (not passwords) were not being un-vaulted at run time, resulting in

database connection attempts failing with an "ORA-01005: null password given; logon denied" error.
This has been resolved.

02089410 (187010)
• Sequential file record locking is now working as expected for files hosted on SQL Server.

(204131)
• Wildcard catalog searches are no longer failing for Oracle datastores that do not have the name "JES"

and a datastore with the name "JES" does not exist in the same physical database.

02176630 (217008)
• UNLOCK RECORD (op-code 0x000F) was failing with file status 2/3 (key not found) or 3/0 (I/O error) if

the previous READ operation was performed using an alternative key. This has been fixed.

(182033)
• When database record locking was enabled for Oracle datastores, COBOL READ operations on a

transactional file's primary key would fail. This is no longer the case, and so it is now safe to set
MFDBFH_RECORD_LOCKING=database again for Oracle datastores.

(99200)
• MFDBFH now supports embedded environment variables in SQL URLs. These can be specified by

either of the following formats:

$name - for example, sql://$MYSERVER/$MYDATASTORE/myfile.dat
${name} - for example, sql://${MYSERVER}/${MYDATASTORE}/myfile.dat

When using the first format, the environment variable name is terminated by the next punctuation
character, or end of string. When using the second format, the environment variable name is enclosed
within curly braces.

Restriction: The second format is not supported if you are using a variable for SQL URLs within
an Enterprise Server environment, for example. when defining the JES catalog location or file
allocation folder.

00367109 (13342)
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• The dbfhadmin utility's syntax display incorrectly specified -outfile instead of -file as the
command-line option to be used to output diagnostics to a named file. This has been corrected.

(222151)
• dbfhadmin -diags -usedb server-name -name region-name can now be used to generate

diagnostics for a region and its associated cross-region database.

02123645 (193072)
• The dbfhadmin utility has been enhanced to display the RNAME value of each of the held and queued

ENQs in hexadecimal when using the following command: dbfhadmin -region -list -
usedb:db-name -name:region-name -hex

01965470 02025132 (150030)
• Region and datastore recovery was not working with SQL Server databases that had been created with

a case-sensitive or binary collating sequence. This is now fixed.

01989735 (148105)
• The mfdbcatc utility sometimes lost a directory element in a path when expanding an environment-

based pathname. This is now resolved.

00707621 (69585)
• In response to a SORT215E error, an identifier has been included to locate the fail position when the

reformatting error occurs; also, some OUTFIL variables are initialized.

01832594 (119050)
• Processing of SYMNAMES in OUTREC processing has been corrected. For INREC/OUTREC

processing, a symbol for p,m,f should result in substitution of p,m unless symbol,edit or
symbol,to or (symbol) is specified, or the symbol is part of an arithmetic expression.

02150120 (202029)
• When FORMAT=f is specified in an INCLUDE statement, and the p,m,f fields are specified using

SYMNAMES, the symbol for p,m,f should result in substitution of p,m.

01685305 (98082)
• A memory corruption issue during syntax checking has been fixed.

02177251 (207055)
• A memory violation issue when checking for a syntax error in MFJSORT has been fixed.

02181342 (218006)
• DFSORT allows multiple values for both positive and negative PD sign indicators. MFSORT now

correctly identifies these sign indicators, so that the sort order is not affected by a sign indicator of the
same kind.

01919912 (138001)
• An issue which caused the TRAILER1 COUNT to be formatted in binary rather than in M10 format has

been corrected.

02117640 (193004)
• ICETOOL Header strings no longer truncate to 16 characters. (The maximum string size is 50

characters.)

02108822 (191037)
• The intermittent crash in mfjsub after running ICETOOL has been fixed.

00487201 00700562 (69210)
• A fault causing memory corruption during SORT or ICETOOL operations has been fixed.

01843660 (157081)
• SORT now honors the DCB attributes specified in the JCL job, to calculate the record length of the

OUTFIL.

00488474 02199053 02266620 (70115)
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• An issue when editing numeric data has been corrected.

01981672 (148085)
• A problem where OVERLAY would not apply spaces when nX notation is used in INREC/OUTREC has

been fixed.

02114313 (189049)
• When performing a SORT, low values are no longer converted to spaces for non-empty files.

02257313 (254001)
• Files are now close properly when called by an error routine.

(61223)
• MFJTOOL now supports multiple titles (a maximum of 3). A new error message is now displayed when

the limit is exceeded.

01870335 (119075)
• When performing a SORT with an empty input file, spaces are now correctly displayed.

02149621 (203032)
• SORT now displays the same output as the mainframe when there are multiple blank lines in

HEADERn/TRAILERn.

01960061 (138220)
• Trailer3 processing will now use the last record in a section, as opposed to the first.

01932820 (143055)
• MFSORT was not honoring the record format for LSEQ files. This has been fixed.

00670127 (73079)
• A new environment variable has been introduced: ES_ZOS_SYSPRINT_DCB, which when set to Y

(default is N) enables MFJAMS SYSPRINT to have the same DCB attributes as the IDCAMS
SYSPRINT.

02103788 (190021)
• ICETOOL emulation now supports COUNT+N and COUNT-N, where N is a numeric between 0-999,

during trailer processing. Its effect is to add to or subtract from the COUNT value.

01932287 (175060)
• An error message is now Issued, and processing is stopped, when the SUM field length is greater than

8 for the formats FI, BI and FL.

00424363 (58155)
• The maximum line length of fhredir.cfg has been increased to allow for the full MFPORT/MFNODE

to be set.

01971422 01970683 (138292)
• An issue with Fileshare performance has now been resolved.

(70294)
• An issue when trying to run Fileshare in background mode has been fixed.

(101104)
• An error where incorrect results may have been returned when a READ on an alternate index was

attempted without first performing a START has now been fixed.

(138152)
• Temporary files should now be created correctly in the Data File editor when connecting to a remote file.

(92087)
• WRITE operations to variable-length output pipes are no longer being treated as fixed-record-length

WRITE operations; previously, the variable length set by a program was being ignored.

02183108 (220017)
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IMS Support

Back to the list

• A problem that caused a transaction to sometimes hang when work was done after a QC has been
fixed.

02035581 (165062)
• When an application abended without doing a GU, a problem sometimes caused a transaction to stop

even when instructed by the NDM exit to continue running. This has been fixed.

02129687 (193084)
• A database no longer fails to close in certain situations when work has been done after a QC.

02030160 (166042)
• A problem with the IMS Bridge that caused excess MQ queue handles to accumulate has been fixed.

02215732 (245060)
• A problem with rollback processing that caused an RTS-114 error under certain conditions has been

fixed.

01977420 (150037)
• A /START TRAN command no longer intermittently results in castmc (IMS TM) becoming

unresponsive.

02079669 (183118)
• A problem that caused TM to crash when message queue data corruption was detected has been fixed.

02222345 (248001)
• The ACEE user ID and group ID are now passed to the MFS field exit.

01841414 (115018)
• A Signal 11 occurred when a PL/I application called AIBTDLI without an I/O area, and BTS tracing was

enabled. This has been corrected.

01937633 (143070)
• MFS Input Field exits are now called for all mapped and unmapped input fields.

(112029)
• A problem that prevented the pfkey from being formatted correctly from some LPAGES of the MFS has

been corrected.

02186348 (221012)
• A problem that prevented output fields from being terminated properly when they do not fill the output

buffer has been fixed to terminate them with the fill character PT or x'05'. When populated, these output
fields can now be right-justified and padded with a user-specified fill character.

02172291 (209056)

Interface Mapping Toolkit

Back to the list

• The HWTJGTST API now returns a correct value in the JSONType parameter when invoked with the
objOrEntryValueHandle parameter set to a value of null, indicating the top of the JSON tree being
parsed.

02102661 (220107)
• For CICS Commarea-based service interfaces, the convention to exclude any field mapped to a COBOL

depending-on item from the external interface has been changed to apply only to input fields, not output
fields.

02167110 (204208)
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• COBOL clients no longer have duplicate data names in certain scenarios when the WSDL or JSON field
name is greater than 30 characters.

01815167 (111010)
• COBOL client data items now have the correct size for JSON fields with "int64" format.

01815173 (104242)

JCL Support

Back to the list

• A problem that caused the expiration date for a dataset to be omitted when EXPDT=1999/365 was set
has been corrected to show the value in the catalog listing for the database.

00368441 02032294 (157025)
• A fault prevented the "Procedure Not Found" error message from inclusion in the JESYSMSG log when

a nested procedure followed one that contained parameters, and the job exported all symbols. This has
been corrected.

02168556 (220013)
• An error writing a spldsn record when output statements were included in a step that had the same

name as the previous one has been corrected.

02146950 (203051)
• The file status of a failed IDCAMS DELETE operation is now displayed in the error message.

00742124 (86064)
• A failure to find the correct COND step reference when the step was in the main body of the JCL has

been corrected.

01884928 (125006)
• A dataset that was originally defined with a disposition of PASS but later cataloged was incorrectly

removed when a job restarted at a step after the catalog. This has been corrected.

00364057 (11790)
• A problem with the IEBPTPCH utility sometimes caused the instream data using the EBCDIC character

set to print incorrectly as EBCDIC. This issue has been resolved. 

(7973)
• The IDCAMS delete statement sometimes deleted the wrong file when using certain combinations of

wild cards. This has been corrected.

02055802 (175033)
• An IEBCOPY command in JCL sometimes incorrectly accepted concatenated DD statements for input.

This is now reported as an error as per IBM behavior.

02137404 (198009)
• The ALLOCATE command in TSO accepts some parameters that contain comma-separated properties

enclosed in parenthesis. Some comma-separated properties were sometimes dropped when driving the
ALLOCATE command from IDCAMS. This has been fixed.

01865028 (118071)
• Using ESMAC to modify an sql://-based PCDSN entry in the JCL catalog by adding illegal

characters sometimes caused problems in reading the catalog. This has been corrected by validating
the sql://-based PCDSN before opening the catalog for reading..

(8340)
• If a region faulted as a job was taken from the input stage and placed into the dispatch queue, a lock

was sometimes left on the dispatch queue after the job was moved back to the input stage. This has
been corrected.

(167105)
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• A problem when starting a new region that sometimes caused a JCL job to be flushed from active, and
to complete with the RFLS status has now been corrected.

02074499 (183034)
• In some situations when running an SSTM job within an enterprise server region in a PAC, the SSTM

job could be left with an incorrect status when the enterprise server region was stopped. This has been
fixed.

(109003)
• When inserting records into the SPLDSN file, the job number was sometimes incorrect. This has been

fixed.

00713363 (104109)
• FTP output messages now display correctly when the Input cards are of length less than 80.

00370940 02015165 (11489)
• A problem that caused the SORT job to abend with S0C4 when the LRECL was greater than 8000 has

been corrected.

01797625 02177172 (103071)
• MFJTOOL SPLICE now adjusts the WITH fields so that the field extent is not beyond the LRECL of the

input file.

01690153 (97113)
• PROCLIB authentication should be done under the execution user IDinstead of the surrogate user ID.

(70094)
• Error COBRT153 ("Subscript out of range") sometimes occurred when using SPLCONV. This has been

corrected.

00364813 (11796)
• When the JOBLOG operation fails, an error is now reported and processing stops.

00367377 (13595)
• A problem that prevented datasets with DISP=(OLD,DELETE) from being deleted at the end of the

abended step as per mainframe behavior has been fixed.

00373283 (11402)
• An issue that caused an S913 error when using PROCLIB in JCL has been corrected.

01971349 (138306)
• When running splconv, an index out of bounds error sometimes occurred when jobs had a large

number of sysout datasets. This has been corrected.

01816834 (110027)
• A fault that caused resolved symbol values to overwrite the trailing spaces of the value has been

corrected. The system symbol values such as SYSJOBID, SYSJOBNM, SYSUID,
SYS_CORR_CURRJOB and SYS_CORR_USRDATA, when exported and used as replacement values
in in-stream data, incorrectly held trailing spaces in the value.

02169726 (221001)
• Performance has been Improved by opening spool files once at the start of the process and not opening

or closing on each request.

(219035)
• MFFTP generated a 550 error when more than one space occurred after the CD command. This has

been corrected.

02038344 (165013)
• The MFJTOOL now displays the BTITLE string correctly in EBCDIC mode.

02182489 (216015)
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• The MFJCTPBC utility program now provides the PL/I mfjctpbc.inc include file in the product
include folder. You can use mfjctpbc.inc in PL/I programs to call MFJCTLBP to retrieve job and DD
information.

(244003)
• Enterprise Server has been modified to process empty JCL files as is done on the mainframe, and no

longer throws an error when the include member is empty.

02071741 (181030)
• A fault that limited the number of JCLLIB entries loaded to 14 instead of the maximum of 15 has been

corrected.

02195057 (220070)
• A fault that shut down an SSTM job when a SEP shut down, but failed to shut down the region has been

corrected.

01979290 (148109)
• A problem in the VSAM Shareoption manager prevented changes of open intent within a job step. This

has been corrected.

02013866 (161052)
• A problem with spool housekeeping prevented the archiving of SUBSYS records for spool datasets that

were being archived. This has been fixed, and records from the active system are now removed when
all references have been removed.

(218024)
• A problem that caused the system to hang when a step specified in a COND was not found has been

corrected.

01993079 (156054)
• Spool housekeeping when run in a database environment sometimes unexpectedly reported file-status

42. This has been resolved.

02173606 (212002)
• In the scenario where multiple enterprise server regions in a PAC had active SSTM jobs running, those

active SSTM jobs could be seen in the spool. When an enterprise server region was shut down its
active SSTM job would stop and its status change to complete; however, its entry in the spool would
remain as active. This has been fixed.

(161038)
• Because of conflicting character set values, the REPRO utility of the IDCAMS program occasionally

reported an error if the source was a NULLFILE. This has been corrected. 

02051297 (173028)
• In some situations, when an enterprise server region that is part of a PAC was restarted the active jobs

might have been left running. This has now been fixed.

00372425 02006019 (71060)
• A problem that prevented SORT from executing correctly when the SORTIN had a concatenated

NULLFILE has been fixed.

01925271 (148082)
• The GDG version is now cataloged correctly after a SEP crashes.

01805894 (104205)
• Output has been added to spool housekeeping to show time spent extracting and uploading spool files

from MFDBFH. In addition, output has been added to show time cleaning up orphan spool files.

01947087 (156003)
• A problem that caused the ESMAC/ESCWA JCL submission module to make an invalid call to the job

submission API has been fixed.

01900454 (124039)
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• Additional messages have been added to to aid in diagnosing startup issues.

01935739 (141023)
• The number of library entries allowed in the System Procedure Library field on the JES

Configuration page has been increased to 15, each separated by a semi-colon.

02192800 (222070)
• The SPOOL_TIMEOUT environment variable has been added to enable greater control over record-lock

retries. SPOOL_TIMEOUT enables you to configure a timeout duration and an interval duration that
allow more flexibility in managing the spool file access, and thus reduce the likelihood of record-locked
messages, especially during shutdown of a region with an SSTM job. Specify both the timeout and the
interval in milliseconds as follows:

SPOOL_TIMEOUT=timeout:interval

The default is 500 milliseconds timeout at 100 millisecond intervals.

(165017)

Mainframe Access

Back to the list

• MFA tools now tracks whether TSO calls have been done on a session and logs off when the session is
closed.

(82103)
• MFDAS crashed when the database name, segment data, and name was not specified on an import

command. This is now fixed.

00364590 (12425)
• Support for 10-byte Endevor element names has been added.

(245075)
• MFDAS LOAD was previously failing to send the command to the mainframe. This has been fixed.

(218023)
• The MFDAS status of an empty filter now correctly returns an error.

(218033)
• MFA client now always sets the function code in the read loop.

(259001)
• In Mainframe Explorer for Eclipse, when downloading a QSAM file the number of records specified to

download in the dialog is now honored.

00775683 (91126)
• Using SyncMon2 to sync an Endevor area with 10-character element names has been fixed.

02029940 (162102)
• The functions ConvertMFA1252ToUTF8() and ConvertUTF8ToMFA1252() now return correct

error codes.

01941348 (148070)
• Executing an MFDAS IMPORT command with the /NUMREC parameter will now correctly limit the

number of records downloaded for all types except for USS and ChangeMan which are not supported.

(118020)
• In AWM, "FCD protocol error" messages will no longer occur when importing some data sets.

02214785 (246095)
• An issue with source connect using a blank username and password has been fixed.

00736415 (87067)

Resolved Issues | 59



• When using MFDASMX to submit remote JCL, it will now correctly detect when the job has completed.

(112015)
• Descriptions and default values have been corrected for Services and Application Servers. RIMS

Services can no longer be through the Configuration GUI as it is unused.

(82112)
• MFDAS will no longer give a Return Code (RC) of 26 if a member is not found after an mfdas dir

end command.

02029955 (163100)
• The server will send the correct keyword (memberName) and omit it for sequential data sets.

(258159)
• MFA has been modified to clean up its cross-memory termination so that linkage indexes are not left

active.

(125050)
• The MFA server will now correctly process Endevor elements with 10 byte names.

02029940 OCTCR50A162102 OCTCR50A245075 (173004)
• Using a passphrase will no longer cause MFA to abend 0C4.

02151118 (203101)
• FCD status indicating I/O errors will no longer get lost, leading to a 9/100 "FCD protocol error".

(258003)
• Logon failure error messages now include the MFA error code.

(260122)
• The Options function no longer does RACF checks.

(262005)
• MFA will no longer abend 806 when started under a z/OS 2.5 system.

02039175 (166055)

Micro Focus Batch Scheduler Integration

Back to the list

• MFBSI sometimes went into a loop when the batch initiator processing the submitted job was
terminated. This has been fixed.

(170044)
• MFBSI sometimes incorrectly issued a "Store for JOB not found in the PAC" message if the region to

which the job was submitted suffered intermittent Redis connectivity. This has been corrected.

02100246 (163099)
• When MFBSI is unable to update the Redis store while processing a job as part of a PAC, it now reports

this via an output message to the Enterprise Server console.

(167024)
• MFBSI Control-M substitution now correctly handles the %%OWDAY value.

02175786 (208029)
• When a cancel command was executed against MFBSI, the spool files were sometimes deleted when

the job terminated. This has been corrected.

02168103 (203220)
• Control-M substitution sometimes corrupted some Chinese characters. This has been corrected.

02109673 (202121)
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• Access to the MFBSIJCL execution log file (SjobID.log) is available again in the MFBSIJCL
termination exit.

3243992 (11763)
• Support for advanced JCL job restart has been added for Micro Focus Batch Scheduler Integration

(MFBSI). For details, see the Advanced Job Restart topic in your product Help.

(124021)
• When JobStart-Lookup-Freq or JobEnd-Lookup-Freq are set to AUTO, you can now use the

parameter Job-AUTO-Delay to customize the delay used by mfbsijcl to switch from high lookup
frequency back to the default values. Set the Job-AUTO-Delay to a value from 1 to 60 (minutes). The
default value is 3 minutes.

3236074 (12709)

Micro Focus Common Client

Back to the list

• The Micro Focus Common Client (used by COBOL web-service proxy programs) now supports the
"gzip" content-encoding for HTTP messages. MFCC recognizes gzip'd response and request
messages, respectively.

00370460 01901934 (12322)
• A 114 Attempt to access item beyond bounds of memory (Signal 11) no longer occurs during FST101A

test.

(231036)

Micro Focus Communications Server

Back to the list

• The MFCS resource leaked under certain circumstances. This has been fixed.

02257630 (254003)
• HTTP HEAD requests no longer cause a SIGSEGV in MFCS.

00780357 (99065)
• MFCS no longer crashes when no TLS 1.3 Ciphers are provided.

(110090)
• The log.html file now correctly rotates when multiple processes are writing to it.

02147299 (203103)
• ESMAC no longer hangs when TLS is enabled.

02175947 (207033)
• MFCS support for cipher suites contained in XML files has been added to the URIMap ciphers.

00371944 (27067)
• When Enterprise Server matches incoming client certificates to userids for CICS Web Interface, CICS

Web Services, or DCAS, the comparison between the certificate fingerprint and the filenames in the
user certificate registry directory is now case-insensitive on all platforms. This corrects an issue where
certificates sometimes were not matched on Linux and UNIX.

01863864 (124133)
• In some cases, garbage characters could appear before EZ Sockets trace messages in the Micro Focus

Communications Server log. This has been fixed.

(182013)
• The Advanced TLS setting in ESCWA Allow Certificate CN-IP Mismatch now works correctly.

(124132)
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• An issue that caused a connection authorization failure for TN3270 clients that use ELF or DCAS to
connect to Enterprise Server has been fixed.

(260042)
• A memory leak in the Enterprise Server multiprotocol connector (used for ES listeners of the Web

Services and J2EE conversation type) has been fixed.

02085456 (182114)
• The maximum number of supported descriptors on glibc platforms such as Linux has been increased.

This is so that when an application calls EZ Sockets SELECT with a socket that has an underlying OS
descriptor greater or equal to 1024, it will not fail with EINVAL. The new limit is 4096.

02060014 (174064)
• The Enterprise Server EZ Sockets implementation of the IOCTL function with the FIONREAD command

code has been fixed for big-endian 64-bit platforms (AIX, Solaris SPARC, and HP-UX). This corrects an
issue with MFFTP client support on those platforms.

(9595)
• The Micro Focus Communications Server (MFCS) component of Enterprise Server now delays the

addition of new tasks when the task queue grows excessively large. This prevents incoming
conversations and CAS from flooding MFCS with work and preventing it from making progress.

2830699 02055505 (5144)
• Under Enterprise Server, on rare occasions tasks started by the CICS EZ Sockets listener task CSKL

could receive the error code 113 (EBADF2) from the TAKESOCKET API call, even if invoked within
CSKL's "give timeout" period. This was due to a bug in the implementation of the SELECTEX API which
could sometimes erroneously indicate a socket had been taken. This has been fixed.

02027700 (161101)
• The Micro Focus Communications Server (MFCS) component of Enterprise Server could sometimes

become blocked while shutting down. This could result in Enterprise Server killing MFCS after a 2-
minute delay when stopping an enterprise server region. MFCS has been modified to prevent or
minimize this condition.

02096133 (191020)
• -p and --shutdown options have been added to ESCWA to enable you to stop a running instance.

00370913 (11789)
• A number of improvements have been made to thread-abend handling in the Micro Focus

Communication Server (MFCS). Recovery from unexpected exceptions and signals in MFCS is now
faster and more robust.

01828728 (104314)
• The Micro Focus Communications Server now supports the "gzip" content-encoding for HTTP

messages. MFCS recognizes gzip'd response and request messages, respectively, and attempts to
compress some large HTTP response messages with gzip if the client indicates it supports that
encoding. Not all MFCS HTTP responses currently enable gzip encoding.

00370460 01901934 (12322)

Micro Focus Directory Server

Back to the list

• The MFDS TLS redirect code has been hardened to improve security.

01938276 02124054 02232906 (157050)
• HPUX snprintf caused TLS redirects to fail. This has been fixed.

(216005)
• If a shortened hostname fails to resolve, then resolution of the full hostname is attempted.

02207755 (240012)
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• If there is a problem resolving the machine local hostname the MFDS process will display the following
startup failure message rather than a "Bind fail=136" message:"CCITCP2-0252E hostname resolution
error."

(221047)
• On import of an MFDS repository, some configuration types (such as XRM, JES Initiator, JES Printer,

IMS MPR and MQ Listener) were double-counted, which could result in the configured object limit being
breached even though the number of imported items did not exceed it.

(202284)
• The status of whether the vault is enabled and in use by the MFDS process was not displayed in the

MFDS Web user interface as it was in Visual COBOL and Enterprise Developer 5.0. This has been
fixed.

(217031)
• The MFDS process could hang if too many enterprise server regions were defined and started. This

has been fixed.

02190282 (222092)
• MPR PWFI support has been added to MFDS via the mfIMSMPRPWFIDispatch MLDAP API MPR

property.

(80014)
• In ESCWA, an error would occur when trying to modify a listener on a communications server other

than the first. This has been fixed.

02191654 (222078)
• There is no longer a long delay when attempting to shut down an enterprise server region that is

retrying an ISC connection.

01689657 OCTCR50A193010 OCTCR50A181100 (101059)

Micro Focus License Administration

Back to the list

• In a system where many licensed processes are attempting to get responses from the mfcesd daemon,
it is possible for the underlying system kernel to constrain resources used by the UNIX domain sockets.
This can cause the send response to fail with a resource unavailable temporarily error. This caused the
ces daemon to lose its contact with the requesting client, resulting in a hung client process.

The CES daemon now recognizes this temporary constraint condition and throttles the connection
slightly and retries. The daemon now always sends a response to the client process.

Micro Focus recommends that you also tune the kernel parameters shown below to allow more
resources for a heavily used system, to prevent the underlying condition.

The following examples show the parameters to change and show very high values. Micro Focus
recommends that a network expert or an administrator reviews these values and adjusts them to
achieve a sensible balance:

# Increase number of incoming connections

net.core.somaxconn = 65535

# Increase number of incoming connections backlog

net.core.netdev_max_backlog = 65535

02196423 (245004)
• Before performing a Repair of the Enterprise Developer installer, Micro Focus recommends that you

create backups of any configuration files of the product that you might have changed.

02084082 (227001)
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Micro Focus Support

Back to the list

• The mfpoll.txt file now includes a new section that has information about whether the machine the
mfsupport script is running on is a Virtual Machine or a physical one.

00466174 (59146)

Panels

Back to the list

• Windows 10 Console Windows resizing has different behavior than some previous releases where the
screen buffer size was constantly resized. Some applications, such as a COBOL Accept/Display
applications, depend on this behavior, which uses a fixed line and column format. To work around this
problem, enable legacy mode in the Console's properties. This disables automatic window resizing. If
legacy mode is not enabled, the screen buffer resize event is captured and the window is resized back
to the original size, which causes some flickering.

02179388 (212008)

PL/I Support

Back to the list

• A code generator bug on Redhat, originating from having the input for the MOD built-in be the float bin
output of another built-in, has been fixed.

02202322 (225001)
• A problem that caused the compiler to abort when converting between precisions of float decimal data

under -fdasdb has been fixed.

02037669 (165002)
• The -pmod compiler option now supports fixed decimal and float binary data. This affects the output of

the MOD built-in function, ensuring that it always produces a positive result. If the result would otherwise
be negative, the absolute value of the second argument is added to the result, which produces a
positive result.

00370007 (12593)
• When using the -ctf compiler directive with -ebcdic, the output 6/7 event pairs contained garbled

unreadable text. This has been corrected.

02077150 (182052)
• When an implicit OPEN was attempted on a PRINT file after it had been explicitly closed, the

subsequent LINESIZE used on the implicit open was one byte longer than necessary, resulting in
skewed output in the JES SYSOUT DD. This has been corrected.

01906859 (131013)
• PL/I JSON has been updated to allow '0' as a numeric value.

01946685 (138232)
• A problem that caused the macro pre-processor to incorrectly evaluate IF statements with THEN as

variable/entry has been fixed.

02053477 (173053)
• Macro built-in function PARMSET now matches the IBM behavior.

02090681 (186002)
• A problem that prevented the PL/I EXEC preprocessor to correctly strip comments that appeared

immediately after string literals in an EXEC SQL statement has been fixed.

00778615 (97003)
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• A problem related to the use of the ALLOCATION built-in function within an ALLOCATE statement has
been fixed.

01940725 (143085)
• The DEFAULT RANGE alignment attribute was being incorrectly applied when a structure had an

explicit attribute specified. This has been fixed.

01915640 (129002)
• Compiler listings now include details about compiler options when the -options compiler option is

specified.

00368495 (12736)
• Freeing a non-allocated CONTROLLED variable now behaves the same as IBM z/OS.

(109039)
• A problem that prevented the compiler from issuing a warning for a non-repetitive loop due to a missing

semicolon has been corrected.

00368492 (12685)
• A problem with the SUBSTR built-in function abort-on-structure assignment has been fixed.

02037667 (165001)
• The STRING built-in now supports the ALIGNED bits member as a parameter.

02048696 (165088)
• A problem that caused the compiler to abort on complex DECLARE statements has been fixed.

02054987 (174001)
• A problem related to include statements with leading and trailing spaces in the filename has been fixed.

(8335)
• An internal error related to the STRING pseudo-variable has been fixed.

01862678 (121043)
• Block-level information in compiler listings has been enhanced.

00368496 (11723)
• A problem when using the -bigendian compiler directive sometimes caused a MFPLI04450S

compiler error because the code generator could not generate code for intermediate opcode
BRANCH_EQ. This has been fixed.

02094187 (185020)
• A compiler abort failure with -zalign has been fixed.

02053453 (167107)
• The STRINGRANGE condition, if raised on a SUBSTR, now uses a revised length when the length of

the first operand is less than the SUBSTR length.

02145179 (200040)
• When GET DATA is used incorrectly, a more accurate diagnostic is returned.

02091547 (186004)
• A problem that produced an inaccurate UNSPEC diagnostic has been fixed.

02053474 (167109)
• A problem matching GENERIC entries has been fixed.

00777296 (92136)
• A problem with GENERIC matching for the BIGENDIAN attribute has been fixed.

00777296 (158054)
• The IEEE and HEXADEC attributes are now parsed with appropriate diagnostics; however, HEXADEC

floating point format is not supported..
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3218202 (11391)
• The HBOUND, LBOUND, and DIMENSION functions now return a result type and precision of fixed bin

(31). In previous releases, these functions returned a result type and precision of fixed bin (15) for
constant values <= 32767.

(90096)
• Macro preprocessor omits %SDEBUG and %RDEBUG tags when the replacement text of a built-in

function fits the line. To correct this, use the -tagmin option.

00384329 (46037)
• PL/I now supports the XMLSCRUB built-in function. See the XMLSCRUB topic in your product

documentation for details.

(182040)
• The ENDFILE PL/I built-in is now supported.

00366172 (11598)
• Open PL/I now diagnoses for semicolons within a comment when -nolaxcomment is specified.

00368493 (12662)
• When printing out a stack trace in PLIDUMP, a PL/I frame on the stack in its %ENTRY line did not print

the offset into the function to aid in debugging. This has been corrected.

02150748 (202027)
• A new optimization has been added to significantly increase the speed of PL/I SELECT statements

when selecting a CHAR VAR variable.

01945899 (138207)
• A problem with a CONTROLLED structure allocated with incorrect array bound has been fixed.

01976700 (146099)
• A compiler error caused by an SDK update has been fixed.

(200043)
• A problem that caused a stream LINE to be continued after ENDPAGE processing has been fixed.

02051016 (175007)
• An IMS program compiled/linked on Windows, and then executed outside the control of IMS returned a

condition code of 0. This has been fixed.

02157836 (202143)
• A memory leak sometimes occurred when a program compiled with -opt used a PL/I built-in function

as both the left and right side of a comparison in an IF statement on a parameter passed in as CHAR(*).
This has been corrected.

02056033 (175011)
• A problem that prevented PL/I XMLCHAR built-in function from correctly closing member tags on

subscript change has been fixed.

02266090 (259005)
• A problem with PL/I SQL-Descriptor-Area alignment has been fixed.

02191840 (225006)
• Macro GOTO statement to a label in a different file caused %FILE tag issues. This has been fixed.

02127833 (194051)
• The PL/I linker's limit for objects has been increased.

00696713 (71413)
• The OPTIONAL attribute has been added to the listing file.

02123565 (193019)
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• An internal consistency error related to the SUM built-in function with another built-in function as an
argument is now fixed.

02035926 (161118)
• A problem related to the ENTRY VARIABLE array with option -dc has been fixed.

01931912 (138145)
• A problem with a CONTROLLED argument incorrectly diagnosed as not matching its corresponding

descriptor has been fixed.

01981698 (146128)
• A problem when using the OPTIONAL attribute applied to a parameter with star-extent has been

resolved.

00475039 (61130)
• A problem with CONTROLLED structure mapping with CHAR VAR members and -bigendian has

been fixed.

01981738 (146127)
• A problem with ALLOCATE of a CONTROLLED structure that caused erroneous diagnostics related to

ambiguous references has been fixed.

01996245 (155008)
• The MFPLI00109W diagnostic is no longer generated when an empty function call with no parentheses

is used in an AND or OR (& or |) expression.

02153429 (204045)
• The codewatch/plidump stack trace on Linux has been modified, so that it will primarily use DWARF Call

Frame Information to unwind.

00416678 (8113)
• A problem that caused the evaluation of elements for structures belonging to arrays to return the wrong

information back to the IDEs and failed to correctly evaluate the element has been fixed.

(57331)
• A problem that caused disabled data breakpoints to be honored has been fixed.

(235033)
• A fix for the debug engine that was previously overlooked has now been applied.

(173030)
• When stepping on the last statement of a CICS program that was called via a CICS LINK, the debugger

returned to the calling program and stepped to the next line after the CICS LINK statement. This has
been corrected.

(124098)
• The maximum limit of debuggable shared objects whose symbols can be processed by PLIDUMP and

Codewatch has been increased from 64 to 256.

00368468 (11668)
• When attempting to debug optimized code, the %exit line was sometimes incorrectly triggered when

stepping past the end of a procedure or on a unit. This has been corrected.

(186001)
• Using bit(1) constants sometimes caused a comparison to fail under -opt. This has been resolved.

02285824 (258108)
• On 64-bit Windows and Linux platforms, an incorrect value was returned when comparing a character

expression against a null string (aka "). This has been fixed.

02258692 (258009)
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• A problem that occurred when creating a PLIDUMP with the H option and triggered by a SIGSEGV
caused the dump to be incomplete due to private memory segments, and to terminate early. This no
longer occurs.

02134496 (202024)
• PL/I execpp now correctly identifies the %SDEBUG tag.

01885251 (123026)
• The macro pre-processor sometimes ended with SIGSEGV on a PARMSET statement. This has been

fixed.

02148893 (202019)
• A problem related to DEFAULT RANGE (*) ALIGNED has been fixed.

02126973 (193073)
• A problem that caused a diagnosis of incorrect limited entry initialization for static storage class has

been fixed.

00779817 (103024)
• A problem related to DEFAULT RANGE with externals has been fixed.

01856273 (121025)
• The -nolaxtype option incorrectly generated an error. This has been fixed.

01920392 (137140)
• A problem that caused the PTRADD built-in function to malfunction when PIC variables were used for

the increment has been fixed.

01839882 (114013)
• A problem matching GENERIC attributes has been fixed.

00777296 (103042)
• A problem matching GENERIC attributes has been fixed.

00777296 (104046)
• A problem generating PL/I code using SQL array insert statements with varying length host variables

with the DB2 ECM has been fixed.

01832992 (104312)
• Open PL/I has new compiler and EXEC pre-processor options, -multiclose and -nomulticlose,

to allow or disallow multiple closure of blocks and groups, including automatic insertion of missing END
statements. The default is -nomutliclose, which produces an E-Level diagnostic.

01848364 (118009)
• A problem that sometimes occurred in high load situations when an attempt was made to access 20

bytes beyond a protected heap memory block. This has been fixed.

01868066 (120049)
• Previously, if a file declared in JCL as DD DUMMY which contained no ENV attribute on the FILE

declaration was opened, read to EOF and then closed, it would incorrectly fail on a subsequent OPEN
with UNDEFINEDFILE() condition. This no longer occurs.

00368457 (13612)
• A locale change coded using the uselocale() API caused a cleanup failure in a SIGSEGV upon

return to the routine as an attempt was made to free the PLI RTS locale. This has been corrected.

02049362 (167097)
• A performance issue with JSON strings has been optimized to provide better performance

02099805 (187016)
• Previously, PLIDUMP would not successfully emit an automatic variable that consisted of a multiple

dimension structure that was larger than 92MB in size. This has been corrected.
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00368470 (12613)
• A problem with PL/I condition handling related to a non-local goto inside ON UNIT has been fixed.

02207593 (238032)
• A problem that caused the PL/I source formatter to erroneously remove blank lines has been fixed.

(123055)
• The PL/I macro pre-processor now correctly adds a line-break instead of splitting keywords.

02160523 (202153)

REXX Support

Back to the list

• MVSVAR('SYSNAME') now returns the value of SYSNAME if it has been set by JCL.

02177701 (217003)

Run-time System

Back to the list

• The correct set of synchronization routines using semaphores are now defined in $COBDIR/cpylib/
cblproto.cpy and $COBDIR/include/cblproto.h.

(166016)
• There was an issue in the internal logic of the cobutf8 utility, which could have resulted in a hang

when a very large amount of data was converted to the application's input and the application was
unable to process the data quickly enough. This has now been fixed.

02115599 (190051)
• Timeouts larger than 35 minutes are now permitted with the use of CBL_SEMAPHORE_ACQUIRE, for

32-bit UNIX applications.

02168295 (220103)
• On Solaris platforms, the escwa32 command now starts ESCWA, as expected.

(104059)
• If a shared object was created with cob -z -d symbol_name -l shared_library, where

symbol_name is resolved in the shared library linked into the shared object, then a potential SIGSEGV
sometimes occurred when the shared object was unloaded. This has been resolved.

01848664 (118012)
• The Consolidated Tracing Facility (CTF) is now better protected when the process is processing

asynchronous signals on UNIX.

(218021)
• Issues relating to MFDBFH after a recoverable error that occurs in Enterprise Server have been

resolved.

(97119)
• The -U option of the Micro Focus Configuration Utility for the Microsoft Build Tools and SDK (command

name: cblms) now works correctly if it specifies both a path and a version.

(86023)
• A memory stomp, which was caused by text wrapping code when multi-byte characters were used, has

been fixed.

02175685 (208014)
• A memory leak caused by alias symbols has been resolved.

01912000 (146043)
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• Code has been removed that assumed that Disk space exhausted was the only failure mode for a
disk write operation. It has been replaced with a query of errno when a write operation fails to output
the expected number of bytes (so the run-time system now copes as well as the operating system
does). 

01978959 (195086)
• Previously, it was not possible to use the old Microsoft bitmap fonts such as Courier, MS Serif and MS

Sans Serif with the PC_PRINTER_SET_FONT library routine. This has now been corrected.

Note: Helvetica and Times fonts are no longer available on Windows, and Arial and Times New
Roman fonts should be used instead.

02011925 (160003)
• The cobfile utility it is not supported for Docker images that do not contain the file command. See

your Development Hub product Help for more information.

(221036)
• When using the PC_PRINTER_DRAW_RECTANGLE library routine, if box-style is set to 1 (filled),

and no pen has been set using PC_PRINTER_SET_PEN, the rectangle fill will be solid black.

(127027)

Setup

Back to the list

• This release no longer requires Microsoft's Visual C++ 2013 redistributable.

00486278 (71117)

SQL: COBSQL

Back to the list

• COBSQL now exits when the CA-DB precompiler is specified but not installed.

(9638)
• COBSQL has been modified to handle EBCDIC conversion of SQL variables in the same group level as

redefined variables.

02074774 (190020)
• The SQLBGP option has been added to the IDE.

(138181)
• COBSQL has been modified to handle EBCDIC conversion of redefined variables that have inline

comments next to them.

02102682 (189011)
• Modified COBSQL to handle EBCDIC conversion when BEGIN DECLARE sections are broken into

multiple lines.

01780938 (104078)
• The COBSQL preprocessor has been modified to insert Procedure Division Initialization logic after each

ENTRY statement.

01780938 (118075)

SQL: HCO for DB2 LUW

Back to the list

• A new exit for ESXACUSTOMEXT has been added to the DB2 switch module. The build scripts have also
been updated with some new options to enable this logic.
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01688275 (104007)
• For custom exits, the XA-inquiry block must now be specified in the LINKAGE SECTION in the custom

exit sources.

02170335 (204264)
• The DB2 ECM now correctly handles EBCDIC content in VARCHAR host variables.

02127808 (193043)
• A problem with compiling VARCHAR or LONG VARCHAR arrays in a COBOL SQL program sometimes

has been resolved.

02105414 (152006)
• A COBOL or PL/I program using EXEC SQL INSERT or FETCH statements without a FOR N ROWS

clause with arrays caused compiler errors. This has been resolved.

(155003)
• A problem that occurred when a VARCHAR host variable was defined as COMP and the length was not

converted with charset(ebcdic) and dialect(entcobol) directives has been fixed.

02167287 (203243)
• A problem generating PL/I code using SQL array insert statements with the DB2 ECM has been fixed.

01820967 (104309)

SQL: HCO for SQL Server

Back to the list

• The MFHCO utility can now create DB2 LUW tables with more than 300 columns.

02144864 (202130)
• In this release, HCOSS Database Migration now supports Azure SQL Database and Managed Instance

in Azure.

(161030)
• A problem converting expression (CURRENT TIMESTAMP - CURRENT TIMEZONE) in an EXEC SQL

statement when compiling with SQL(DIALECT=MAINFRAME) has been fixed.

01858569 (131017)

SQL: Mainframe Batch Database Tools

Back to the list

• A problem retrieving DECIMAL data using SQLTP2 when the DECIMAL field was followed by other
fields has been fixed.

02140073 (201007)
• A problem when running SQLTUL on Linux caused an S806 error. This has been resolved.

02195601 02200011 (220086)
• A problem loading binary data in EBCDIC into a data set using MBDT SQUTB has been fixed.

(181081)
• A problem that prevented "SQLCODE: -9999, SQLSTATE: IM999" error to be returned without including

the explicit underlying cause of the error has been corrected by additionally calling the
GetDiagnostics function.

00780459 (95019)
• A comma (,) is now supported as a decimal separator when DSNTEP2 displays values of decimal

columns.

02017265 (163008)
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• An error occurred when DSNTIAUL unloaded a null value with its indicator set to a character other than
"?". This has been fixed.

02228124 (245142)
• A problem using MBDT SQLUTB when the decimal separator was set to comma (,) in Oracle has been

fixed.

(161097)
• A problem that occurred when the DATE reserved keyword was used as a table name but was specified

without quotation marks has been fixed.

02059727 (175083)
• A problem with loading data into a partition of a DB2 LUW table using SQLUTB with the REPLACE

option has been corrected by now deleting the data in the partition and displaying the the number of
rows affected in the SYSPRINT.

01794378 (106059)

SQL: OpenESQL

Back to the list

• A problem that prevented the ESMSSQL switch from detecting when the PIP1 transaction is occurring
caused setCurrentConnection to be performed on the incorrect connection. This has been fixed.

01916096 (142006)
• OpenESQL has been modified to process RELEASE TO SAVEPOINT statements in non-HCOSS

RDBMSs.

00370819 (13104)
• Non-DB2/SQL Server support is now enabled for DSNREXX.

02132700 (195090)
• A problem that caused the OpenESQL native runtime to incorrectly handle WITH HOLD FOR UPDATE

cursor against Oracle in 64-bit has been fixed.

00745593 (121047)
• OpenESQL now supports a SYNC clause specified in a variable-length host variable declaration.

02169632 (204218)
• A problem that prevented a properly executed EXEC SQL statement from returning the correct

RETURN-CODE has been fixed.

02036138 (167041)
• The OpenESQL managed runtime now handles the EBCDIC/ASCII conversion correctly when the

SQLDA descriptor is used for input/output host variables.

01852747 (118034)
• A compilation error when using the ODBC ECM and the CHARSET(EBCDIC) directive in a .NET

managed project using multiple COBOL SQL source files has been resolved.

02018148 (163009)
• A problem that sometimes prevented an XA connection used with dynamic registration from working

properly with MFDBFH with has been fixed.

00779680 (146073)
• A problem with compiling an EXEC SQL statement of DECLARE CURSOR in which CTE starts with

SELECT * has been resolved.

01798310 (105107)
• A problem that occurred when using CTE in SELECT INTO statement has been corrected.

02117758 (194003)
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• When an error occurs, the get error loop now exits if the last error message retrieved is the same as the
current one.

02172041 (209005)

SQL Option for DB2

Back to the list

• Java BigDecimal host variables sometimes erroneously returned an "X004 Number value overflow"
message. This has been corrected.

02035965 (166008)
• The clause EXCLUDE/INCLUDE NULL KEYS is now supported for a CREATE INDEX against a local

XDB location.

00366732 (12313)
• The XDB optimizer provided an incorrect string to pattern match when using Unicode host variables

with CHAR/VARCHAR field index searches. This has been corrected.

02031280 (163104)
• When using Unicode host variables such as those used by the XDB JDBC driver, the XDB engines

incorrectly padded zero-length variable-length strings with blanks when inserting into CHAR fields. This
has been fixed.

02013343 (162016)
• When using the Optimizer, an incorrect set of prequalified row IDs resulted due to an incorrect data type

from the expression evaluation code. This has been corrected.

02080612 (185011)
• A problem that generated an error when using FOR UPDATE OF before ORDER BY has been fixed.

00371171 (12415)
• An issue with the creation of a trigger containing some concat scalar operations in the triggered

statement has been resolved.

02169332 (204247)
• A memory access violation that occurred when a left outer on join of view to table was present in a

query has been resolved.

(3934)
• An issue caused by a trailing space in a quoted table or column name in the XDB XUTILB emulation of

DSNUTILB LOAD has been resolved.

01811482 (104199)
• A problem that prevented the SQL scalar function POSSTR to correctly find the hex binary value X'00'

within text strings has been fixed.

00365823 (12474)
• A problem that caused an X352 server exception when using Unicode with scalar subqueries has been

resolved.

00374928 (11375)
• A problem that caused an X352 server thread exception when running a query containing a LEFT and

INNER JOIN has been resolved.

2700290 (11082)
• The SYSTEM reserved word now supports a CONSTRAINT name in Data Definition Language (DDL).

02181636 (211039)
• A problem that prevented an output argument from being returned by a stored procedure has been

resolved.

02010981 (158137)
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• An issue with casting the host variable used in a z/OS DB2 12 OFFSET clause has been resolved.

00474163 (61110)

Visual Studio Code

Back to the list

• You no longer receive a Null Reference exception when running MicroFocus.VSCodeJIT.exe /r
on machines that do not have Visual COBOL or Enterprise Developer for Visual Studio installed.

01855303 (120034)
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Other Issues Resolved in This Release
The numbers listed are the Support Incident Numbers followed by the Defect number (in parentheses).

• 02150403 (203019)
• 02091353 (187001)
• 02121754 (202065)
• 02132897 02164401 (198046)
• 01995392 (158073)
• 02010044 (157065)
• 2836772 (7336)
• 02293789 (226006)
• 01912000 (142033)
• 01834420 (98086)
• 00620699 (71289)
• 01811748 (124010)
• 02135207 (193101)
• 02051091 (175018)
• 00725550 (92178)
• 01839124 02145513 (112009)
• 02045736 (166043)
• 01947033 (146111)
• 01994995 (195081)
• 02033743 (161099)
• 02110007 (191044)
• 02289051 (258146)
• 01794492 (105047)
• 00430214 (58005)
• 02254118 (253027)
• 02016027 (163039)
• 00367290 (31077)
• 01862519 (118040)
• 3188835 (11348)
• 00365049 (13049)
• 02161981 (204198)
• (259026)
• 00775199 (218016)
• (259059)
• (244058)
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Unsupported or Deprecated Functionality
This section includes information about features or functionality that are not supported.

• The SafeNet Sentinel licensing system has been deprecated and will be not available in this product
starting with the next major release after release 9.0. The SafeNet Sentinel licenses will not be
supported after release 9.0 and you need to use AutoPass licenses if you use these releases.

You can replace your SafeNet Sentinel licenses with AutoPass licenses starting with release 8.0.
Contact Micro Focus Customer Care for further information.

• The HOSTSIGNS Compiler directive is no longer supported. Micro Focus recommends that you use the
following Compiler directives instead: SIGN-FIXUP, HOST-NUMMOVE, and HOST-NUMCOMPARE.
This is a change since version 3.0 of this product.
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Additional Software Requirements
To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software.

Click here to see this information in the product Help for Enterprise Developer for Eclipse (Windows) on the
Product Documentation pages on Micro Focus Customer Care.

Click here to see this information in the product Help for Enterprise Developer for Eclipse (UNIX) on the
Product Documentation pages on Micro Focus Customer Care.
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Installation

Installing Enterprise Developer for Eclipse (Windows)

Before Installing

Downloading the Product
1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/

download/downloadCenter.
2. Select your account and click Entitlements.
3. Search for the product by using any of the available search parameters.
4. Click Show all entitlements.
5. Click Get Software in the Action column for the product you want to download or update.

In the File Type column, you see entries for "Software" for any GA products, and "Patch" for any patch
updates.

6. Click Download on the relevant row.

On Windows

System Requirements

Hardware Requirements

Enterprise Developer has the following requirements in addition to the requirements of Eclipse. See the
Eclipse documentation for details of its requirements.

In general, most modern machines will have the required processor and available RAM to run the Micro
Focus products under Windows effectively. For planning purposes, you should consider having a minimum
of 2GB of RAM though Micro Focus recommends at least 4GB of RAM for optimal performance.

The disk space requirements for Windows are, approximately:

Enterprise Developer

3.5GB

Note: The disk space requirements include the size of the Eclipse IDE and the version of Java and
the .NET Framework provided with the Enterprise Developer setup file. This includes the space
needed to cache information locally so that you can modify the installation without the original source
media.

Operating Systems Supported

For a list of supported operating systems, see Supported Operating Systems and Third-party Software in
your product documentation.

Also note the following:

• A 64-bit Windows is required. Enterprise Developer installs fully only on 64-bit Windows platforms. On
32-bit Windows, the setup file does not install some of the components. See Issues with the Installation
in Known Issues and Restrictions.

78 | Installation

https://sld.microfocus.com/mysoftware/download/downloadcenter
https://sld.microfocus.com/mysoftware/download/downloadcenter


You can produce both 64-bit and 32-bit applications with Enterprise Developer on 64-bit operating
systems.

• The Server Core form of Windows Server 2019 is not supported.

Software requirements

Note: This product includes OpenSSL version 1.1.1n-mf6 (modified).

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.

Requirements for the setup file

• A 64-bit Windows is required. Enterprise Developer installs fully only on 64-bit Windows platforms. On
32-bit Windows, the setup file does not install some of the components. See Issues with the Installation
in Known Issues and Restrictions.

• The setup file installs Enterprise Developer and the 64-bit version of Eclipse 4.20 (2021-06).

Enterprise Developer only supports the 64-bit version of Eclipse. You can use the 64-bit Eclipse to
create both 32-bit and 64-bit applications.

• The setup file installs Adoptium's OpenJDK Temurin 11.
• The setup file also installs Microsoft's Visual C++ 2012 and 2017 Redistributables.

Requirements for running the product on Windows

• Java 11 (64-bit) is required to run the Eclipse IDE. The minimum recommended version is Adoptium's
OpenJDK Temurin 11 (LTS) with HotSpot, which the Windows product installs automatically. You can
download Adoptium's OpenJDK Temurin 11 (LTS) with HotSpot from Adoptium's Web site and unpack
the archive anywhere on your machine.

• Enterprise Developer requires a 64-bit Java installation to run a 64-bit Eclipse.
• Microsoft Windows SDK and Microsoft Build Tools: Various actions and operations within your COBOL

development environment depend on certain files that Microsoft distributes in the following packages:
the Windows SDK package and the Microsoft Build Tools package. See Microsoft Package
Dependencies for a full list of actions and operations that require one or both of these packages.

By default, the product installation installs the latest versions of the Microsoft Windows 10 SDK, and the
Microsoft Build Tools for Visual Studio 2017, to their default locations.

If you need to use any other version of these packages, or use them installed to a non-default location,
use the cblms command line utility post-installation to manage this; see Managing the Microsoft Build
Tools and Windows SDK Packages for more information.

See Java Support Restrictions in the product help for any considerations when using Eclipse and Java.

License Manager requirements

• The Micro Focus License Administration tool requires Java to run. It supports Java 1.7 or later.
• For local servers, you do not need to install the Micro Focus License Administration tool separately, as

the setup file installs a new Enterprise Developer client and a new licensing server on the same
machine.

• If you have any network license servers, you must update them before you update the client machines.
• If you are upgrading from Enterprise Developer release 2.2 or earlier, uninstall the license manager

before installing the product.

You can download the new version of the license server software by following these steps:

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter.
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2. Select your account and click Downloads.
3. Select a product and a product version from your orders.
4. In the list of software downloads, locate the License Manager.
5. Click Download to download an archive with the installers.
6. Run the installer suitable for your Operating System to install License Manager on your machine.

Additional Software Requirements

To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software.

Click here to see this information in the product Help for Enterprise Developer for Eclipse (Windows) on the
Product Documentation pages on Micro Focus Customer Care.

Click here to see this information in the product Help for Enterprise Developer for Eclipse (UNIX) on the
Product Documentation pages on Micro Focus Customer Care.

Product Co-Existence

Note: The following applies to Windows only.

• Enterprise Developer and Enterprise Server (or Enterprise Test Server) cannot coexist on the same
machine.

• Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE
(Visual Studio or Eclipse) you install.

Installation Restrictions and Requirements

Before starting the installation you should consider the following:

• You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

• Various actions and operations within your COBOL development environment depend on certain
Microsoft files distributed in the following packages: the Windows SDK package and the Microsoft Build
Tools package. By default, a standard product installation downloads and installs these. Refer to
Microsoft Package Dependencies to see if these packages are required. If you do not plan to use your
development tool in a way that will depend on any of these packages, you can run a non-standard
installation, which will skip their download and installation, thus saving disk space and time taken for
installation. Refer to Advanced Installation Tasks for details on the available installation options.

• If you already have Microsoft Build Tools for Visual Studio 2017 installed, you must ensure that it
contains the Visual C++ build tools workload (or at least the individual components contained in that
workload) before you run this installation.

On UNIX

System Requirements for Micro Focus Enterprise Developer UNIX Components

Hardware Requirements

The disk space requirements for Micro Focus Enterprise Developer UNIX Components are approximately:
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Platform Installer type Setup

file size

Disk space

required for

the installation

Disk space

required for

running

the product

Licensing
technology

POWER
running AIX

Micro Focus 891 MB 3.56 GB 1.78 GB 41 MB

System Z
running Red
Hat Linux

Micro Focus 559 MB 2.24 GB 1.12 GB 39 MB

x86-64
running Red
Hat Linux

Micro Focus 1.1 GB 4.4 GB 2.2 GB 50 MB

Red Hat for
Docker

Micro Focus 863 MB 3.45 GB 1.73 GB 50 MB

Amazon x64 Micro Focus 885 MB 3.54 GB 1.77 GB 50 MB

Amazon for
Docker

Micro Focus 885 MB 3.54 GB 1.77 GB 50 MB

SPARC
running
Solaris

Micro Focus 803 MB 3.21 GB 1.61 GB 42 MB

System Z
running SUSE
SLES

Micro Focus 568 MB 2.27 GB 1.14 GB 39 MB

x64 running
SUSE SLES

Micro Focus 885 MB 3.54 GB 1.77 GB 50 MB

SUSE for
Docker

Micro Focus 884 MB 3.54 GB 1.77 GB 50 MB

x64 running
Ubuntu

Micro Focus 964 MB 3.86 GB 1.93 GB 50 MB

Ubuntu for
Docker

Micro Focus 887 MB 3.55 GB 1.77 GB 50 MB

x86-64
running
CentOS

Micro Focus 1.1 GB 4.4 GB 2.2 GB 50 MB

Operating Systems Supported

For a list of supported operating systems, see Supported Operating Systems and Third-party Software in
your product documentation.

On some platforms, there is only a 64-bit version of this product. 64-bit versions of the product support
compiling to and running 64-bit programs only.

Software Requirements for Micro Focus Enterprise Developer UNIX Components

The following topic lists the software requirements for Micro Focus Enterprise Developer UNIX
Components.

• Software required by the setup file
• Libraries required by the setup file
• Required environment variables
• License Manager requirements
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Software required by the setup file

• The "awk", "ed", "ps", "sed", tar", "sed" and "which" "tar" utilities must be installed and added to the
PATH.

• Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

• GNOME menus and buttons have been standardized across all applications so that icons are not
displayed by default. To keep the icons and the look and feel of previous versions, enable the
menus_have_icons property with the command:

gconftool-2 --type boolean --set /desktop/gnome/interface/menus_have_icons 
true

Libraries required by the setup file

The following table lists the required libraries for Red Hat and SUSE Linux platforms. The setup file checks
that both the 32-bit and 64-bit libraries listed below are installed on both 32-bit and on 64-bit Operating
Systems for this product to install and work correctly.

If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before you
start the installation.

Library 32-bit
Librar

y
Name

64-bit
Library
Name

Platform

s390 SUSE
121

SUSE 151 Red Hat 6x Red Hat 7 Red Hat 8

glibc glibc-
*.i686

glibc-
*.x86_64

glibc-
*.s390

X X X

libgcc libgcc
-
*.i686

libgcc-
*.x86_64

libgcc-
*.s390

X X X

libstdc++ libstdc
++-
*.i686

libstdc++-
*.x86_64

libstdc++-
*.s390

X X X

glibc-locale glibc-
locale
-32bit

glibc-
locale-2

X X

glibc-devel glibc-
devel-
*.i686

glibc-
devel-
*.x86_64

glibc-
devel-
*.s390

X X X

elfutils-libelf elfutils
-
libelf.i
386
or
elfutils
-
libelf.i
686

elfutils-
libelf.x86-
64

N/A X X X

libelf-devel** elfutils
-
devel.
i386

elfutils-
devel.x86
-64

N/A X X X
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Library 32-bit
Librar

y
Name

64-bit
Library
Name

Platform

s390 SUSE
121

SUSE 151 Red Hat 6x Red Hat 7 Red Hat 8

or
elfutils
-
devel.
i686

libelf-devel** libelf-
devel-
32bit-
0.137
-8.19

libelf-
devel-0.1
37-8.19

N/A X X X

libelf1** libelf1
-32bit-
0.137
-8.19

libelf1-0.1
37-8.19

N/A X X

gcc2 gcc*.i
686

gcc*x86_
64

X X X X X X

cpp2 cpp*x86_
64

X X X

ld2 Binutil
s*.i68
6

Binutils*x
86_64

X X X X X X

• Libraries marked with an 'X' are not included in the platform and need to be installed separately.
• 1On SUSE 12 and 15, you can only install the 64-bit version of Enterprise Developer. The glibc-

locale-32bit library is still required by the SafeNet Sentinel licensed components.
• 2On Red Hat, these libraries are required to enable COBOL and PL/I to compile.
• * Additional libraries required to use the core_on_error run-time system variable. The gdb packages (for

the GNU Project Debugger) can be installed from the install media for your OS.
• ** Operating system libraries required for PL/I support on both SUSE and Red Hat.

Visit the Red Hat Web site for more information.

Required environment variables

• To execute JVM COBOL code, you need to set the environment as follows:

• Set the JAVA_HOME environment variable. When installing the product, set this variable to a 64-bit
Java installation or the installation terminates. For example, execute the following:

export JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• Add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• You need to set the LANG environment variable to pick up localized messages. If you do not set it as
specified here, the installation will run but you might experience unexpected behavior from the
installer.
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The LANG settings are English and Japanese only so set it to one of the following locales:

C, default, en_GB, en_GB.UTF-8, en_US, en_US.UTF-8

ja_JP, ja_JP.SJIS, ja_JP.UTF-8, ja_JP.eucJP, ja_JP.eucjp, ja_JP.sjis, 
ja_JP.ujis, ja_JP.utf8, japanese

You can set LANG before running the setup file as follows:

export LANG=C

Alternatively, add it to the start of the setup command line:

LANG=C ./setupfilename

See Using the LANG Environment Variable for details.

License Manager requirements

• The Micro Focus License Administration tool requires Java to run. It supports Java 1.7 or later.
• For local servers, you do not need to install the Micro Focus License Administration tool separately, as

the setup file installs a new Enterprise Developer client and a new licensing server on the same
machine.

• If you have any network license servers, you must update them before you update the client machines.
• If you are upgrading from Enterprise Developer release 2.2 or earlier, uninstall the license manager

before installing the product.

You can download the new version of the license server software by following these steps:

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter.

2. Select your account and click Downloads.
3. Select a product and a product version from your orders.
4. In the list of software downloads, locate the License Manager.
5. Click Download to download an archive with the installers.
6. Run the installer suitable for your Operating System to install License Manager on your machine.

Issues with the Installation on UNIX and Linux

Installing on Linux

On Linux, the RPM installer for Enterprise Developer for Eclipse installs a 64-bit version of Java. When you
start the installation, if the 32-bit version of Java is already installed on your Linux machine, you might not
be able to install Enterprise Developer. This is a known issue with the Oracle Java installers for Linux which
prevents you from installing both the 32-bit and the 64-bit versions of Java on the same machine. To work
around this problem:

• Download the 64-bit Java distribution in a compressed .tar format from the Oracle Web site.
• Untar the distribution into a location different from the one used for the 32-bit Java version. For example,

untar in /usr/local/java64 and not in /usr/local/java.
• Set JAVA_HOME and LD_LIBRARY_PATH to the 64-bit version of Java so that it is used to install and

run Enterprise Developer.

Installing on Red Hat 8.x s390

On Red Hat 8.x s390, the RPM non-root install method is not supported due to errors given by cpio. You
receive the following messages:

error: unpacking of archive failed on file /usr/lib/.build-id/1b/
af99f26c6b4c00ca499a3199a574b73aeb3854;6092b79c: cpio: symlink failed - No 
such file or directory
error: Micro_Focus_cobol_server-7.0.0.0-100700.s390x: install failed
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As a result, the installation in this scenario is incomplete.

Installing while using AFS/Kerberos authentication

If you are using AFS/Kerberos authentication to log onto your Linux system then you need to ensure you
have a local user ID which SOA and Enterprise Developer components of the product can use. This user
ID must be set up prior to running the installer. When running the installer you need to specify -
ESadminID=[User ID] on the command line so it is used by the installer.

License Server

You need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the /etc/hosts file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.

For considerations when installing this product as an upgrade, for additional installation options or non-
default installations and for installing the mainframe components, see Advanced Installation Tasks in your
product Help.

Installing on Windows
Note:

• This version of the product is a full install.
• If you have an earlier version of Enterprise Developer installed on your machine, check Installing

as an Upgrade before you start the installation - see Advanced Installation Tasks.

These are the steps to install Enterprise Developer:

1. Run the ede_80.exe file and follow the wizard instructions to complete the installation.

By default, this installs Enterprise Developer in the %ProgramFiles(x86)%\Micro Focus
\Enterprise Developer folder and installs a full version of Eclipse 4.20 (2021-06) 64-bit, with the
Micro Focus plugins already installed, in the C:\Users\Public\Micro Focus\Product Name
\eclipse directory.

The setup file installs any missing prerequisite software as listed in the topic Software Requirements.

Note: See Advanced Installation Tasks for information about non-default installation tasks.

Installing Micro Focus Enterprise Developer UNIX Components
Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus installer for
installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for installing on Linux.
See your product Help for instructions on how to use the RPM installer.

Before starting the installation, see Software Requirements.
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These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:

chmod +x setup_entdev_8.0_platform

2. Run the installer from the Process User ID login:

./setup_entdev_8.0_platform

When the installer starts it will prompt you to enter the superuser password so it can perform operations
that require root permissions.

Note: On Ubuntu, the prompt for superuser password is not available. On this platform you must
either log in as root or use the sudo command to get root permissions before you run the installer.

The COBOL environment is installed by default into /opt/microfocus/EnterpriseDeveloper,
(COBDIR).

Enterprise Server System Administrator Process

During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server processes
except the one for the Micro Focus Directory Server (MFDS). The Directory Server process (Enterprise
Server Administration) runs as root as this allows it to access the system files and ports.

All Enterprise Server processes you start from Enterprise Server Administration run under the Process
User ID which can affects the file access and creation.

You must supply the user ID at the command line - specify -EsadminID=[ ID ] as part of your
command.

By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh and follow the
onscreen instructions.

SafeNet Sentinel considerations

• The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the -skipsafenet option, which skips the
installation of SafeNet:

./setup_entdev_8.0_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or shutdown the
running license daemons. If licensing needs to be updated later, you can rerun the
MFLicenseServerInstall.sh from within the $COBDIR/safenet folder with the force command
line option:

cd $COBDIR/safenet
./MFLicenseServerInstall.sh force

AutoPass Licensing considerations

• The installation of this product could affect the AutoPass licensed components running on your
machine. During installation, the licensing shuts down to allow files to be updated. To ensure the
processes running on your machine are not affected, you need to use the -skipautopass option, which
skips the installation of AutoPass:

./setup file -skipautopass
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• To protect the AutoPass installation from accidental updating, you can create an empty file named
SKIP_AUTOPASS_INSTALL in /opt/microfocus/licensing as follows:

touch /opt/microfocus/licensing/SKIP_AUTOPASS_INSTALL

While the file is present, the AutoPass installer does not make changes to the installation or shutdown
the running license daemons. If licensing needs to be updated later, you can rerun the
MFLicenseServerInstall.sh from within the $COBDIR/safenet folder with the force command
line option:

cd $COBDIR/safenet
./MFLicenseServerInstall.sh force

Advanced Installation Tasks
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install the additional components.

The advanced installation tasks include:

• Installing as an Upgrade - included in these Release Notes
• Command line installation options - included in these Release Notes
• Installing using an RPM installer on Linux - available in the product Help and on the Product

Documentation pages on Micro Focus Customer Care
• Installing and licensing Micro Focus Rumba - available in the product Help and on the Product

Documentation pages on Micro Focus Customer Care
• Installing into other instances of Eclipse - available in the product Help and on the Product

Documentation pages on Micro Focus Customer Care
• Installing the Mainframe Components, - Mainframe Access Server, Application Workflow Manager into

IDz, z/Server - available in the product Help and on the Product Documentation pages on Micro Focus
Customer Care

• Installing on Microsoft Terminal Server and Citrix - available in the product Help and on the Product
Documentation pages on Micro Focus Customer Care

Click here to see this information on the Product Documentation pages on Micro Focus Customer Care.

On Windows

Installing as an Upgrade

Installing this release as an upgrade will automatically uninstall any Patch Updates of the older version of
the product you have installed on your machine.

• This release can be installed as an upgrade to Enterprise Developer 7.0.

• If you have been using the mainframe components of Enterprise Developer for z Systems, see Installing
z/Server as an Upgrade for recommendations about how to upgrade your z/Server installation. Also,
check Backward Compatibility of AWM Models for information about changes that affect your existing
AWM models.

• Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server
configuration. To do this, on the Enterprise Server Administration home page, click Export and then
select Export Enterprise Server configuration and Security Manager definitions. This creates a
backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import on the Enterprise
Server Administration home page.
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Enterprise Developer Installation Options

To see what parameters you can use, execute the following from the command line:

install-file /help

where install-file for the following products is as follows:

Enterprise Developer ede_80.exe

See the Examples section further in this topic for examples of some of the parameters you can use.

Directory considerations

• You must have read and write access for every directory accessed during the installation.
• You can override the default installation folder using the InstallFolder parameter.

• Installing creates a group of log files prefixed Micro_Focus_ in the %temp% folder, by default. To
change the location or name, use the /log parameter on your Setup command line and specify the
path and file name, for example:

/log drive:\path\LogFilename

Skipping installation of the Microsoft package dependencies

A standard installation downloads and installs the latest versions of the Microsoft Build Tools (for Visual
Studio 2017) and the Windows 10 SDK packages to their default locations. Using the following option, you
can skip installation of these packages, thus reducing the footprint and duration of the installation. See
Microsoft Package Dependencies to see if you can safely skip installing these packages.

ede_80.exe skipmstools=1 

Offline installations

An offline installation is one where the client running an install is not connected to the internet; the problem
this presents is that the installer cannot download and install certain file and package dependencies; see
Microsoft Package Dependencies. In such circumstances, an administrator (or at least someone connected
to the internet) must download and make any dependencies available on the local network beforehand.

To prepare an offline installation, the administrator should run their own (online) installation using the
downloadmstools parameter: this downloads the package dependencies to <directory>, which should
be a fully-qualified path to a location accessible to the client when they run an installation.

start /wait ede_80.exe /q downloadmstools=<directory>

A client can then run an offline installation by pointing their installer at the location of the packages:

ede_80.exe installmstools=<directory>

This command runs a full product install; during which it uses the locally-accessible <directory> to install
the package dependencies.

Installing silently
You can install Micro Focus products silently by specifying /q at the command line and using command line
parameters to specify the installation directory (installfolder=path), user information, and which
features to install. You must execute the command with superuser permissions.

start /wait install-file.exe /q [parameters]

Examples

• To silently install Enterprise Developer into a directory other than the default:

start /wait ede_80.exe /q InstallFolder=c:\DirectoryName
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• If you want to silently install the Eclipse IDE in a location other than the default, execute:

start /wait ede_80.exe /q InstallFolder2=c:\EclipseInstallDirectory

• To silently install Rumba+ Desktop during the silent install of Enterprise Developer:

start /wait ede_80.exe /q RumbaCheckbox=1

Microsoft Package Dependencies

Various actions and operations within your COBOL development environment depend on certain files that
Microsoft distributes in the following packages: the Windows SDK package and the Microsoft Build Tools
package.

There is a dependency on the Microsoft Windows SDK if you:

• Produce COBOL .exe or .dll files.
• Call Windows APIs from your COBOL .exe or .dll files.
• Link a C object file into a COBOL .exe or .dll file.
• Call Windows APIs from a C object file linked into a COBOL .exe or .dll file.
• Create MIDL files for OLE RPC.

There is a dependency on the Microsoft Build Tools if you:

• Produce COBOL .exe or .dll files.
• Manage .lib files.
• Convert resource files to object modules.

If you distribute a COBOL product installation to clients that do not have access to the internet, then you
need to have downloaded these packages and placed them in an accessible place on the network before
clients can run an 'offline installation'. The installer includes options to achieve this: downloadmstools
enables you to download the required packages to a specific location; and installmstools enables an
offline client to install the packages from a local network location.

If you do not use any of the features described above, you can use an install parameter (skipmstools=1)
that will skip the download and installation of these dependencies.

All of these installation options are discussed in more detail in the Installation Options topic for your
product.

One of the final steps of the installation process configures the downloaded and installed package versions
for use in your COBOL environment. You can view these versions using the Microsoft Build Tools and
Windows SDK Configuration Utility - see Managing the Microsoft Build Tools and Windows SDK Packages.
This utility also enables you to specify alternative versions should you need to depend on a specific
package other than the one downloaded, or one stored in a non-default location.

Installing and Licensing Micro Focus Rumba+ Desktop

The Enterprise Developer setup file includes Micro Focus Rumba+ Desktop 10.1 which you can install as
an optional component. The license for Enterprise Developer also licenses all components of Rumba+
Desktop (for example, Rumba+ Desktop Office, Rumba+ Desktop for Mainframe, UNIX, AS400, and the
TN3270 mainframe display within Enterprise Developer).

Note: Micro Focus Rumba+ Desktop versions 10.1 provide integration with Enterprise Developer
where you can use a Rumba+ Desktop TN3270 Mainframe Display within the IDE in order to run
applications.

Installation considerations:

• If you are installing Enterprise Developer onto a machine that does not have Rumba+ Desktop installed,
it is recommended that you select the Rumba+ Desktop option when you start the installation. This
installs all of the components of Rumba+ Desktop including the one you need to establish a mainframe
3270 connection (Rumba+ Desktop for Mainframe).
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• Installing Rumba+ Desktop as part of this release of Enterprise Developer will update any older version
of Rumba+ Desktop installed and licensed on your machine.

Note: Micro Focus recommends that you upgrade older versions of Rumba+ Desktop to the one
installed with Enterprise Developer. However, if you want to keep an older version of Rumba+
Desktop, you can choose not to install Rumba+ Desktop when you start the Enterprise Developer
installation.

• If a version of Rumba+ Desktop more recent than version 10.1 is installed and licensed on your
machine, you can choose not to install Rumba+ Desktop as part of the Enterprise Developer
installation.

On UNIX

Installing as an Upgrade

This release works concurrently with the previous version of Micro Focus Enterprise Developer UNIX
Components, so you do not need to uninstall it.

Install the latest version in a different location and set the environment to point to it. To do this, run the
Micro Focus Enterprise Developer UNIX Components installer with the –installlocation option:

1. Execute the following command:

./InstallFile -installlocation="/opt/microfocus/EnterpriseDeveloper"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

2. Execute cobsetenv to set the environment and point to the new install location:

. <product-install-dir>/bin/cobsetenv

Note: cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Preserving the MFDS and Enterprise Server region configuration

The following information applies when you are upgrading from releases 6.0 or 7.0.

If you install this release to the same install location as release 6.0 or 7.0, the product in the current
location is moved to a backup directory name.

For example, if the 7.0 product is installed in the default install location, /opt/microfocus/
EnterpriseDeveloper, during the upgrade it is moved to /opt/microfocus/
EnterpriseDeveloper.BKP.YYYY-MM-DD.HH:MM:SS. The new release will be installed in /opt/
microfocus/EnterpriseDeveloper.

Note that your original installation might include some files that you changed or added to, and you need
those changes preserved in the new installation.

During the upgrade, the installer moves a number of changed files to a different configuration location and
symbolically links them back into the new release install location. The configuration location is one of the
following:

• The default config location is /opt/microfocus/config/.
• For non-root installation, the default location is $HOME/microfocus/config/.
• To specify your own configuration location, run the setup file with the following command-line option: -

mfconfiglocation=[location]

The setup file creates a directory in the configuration location using the sum of the value of the $COBDIR
path. This is so that each configuration area is unique to each product installation. The configuration files
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and directories are then placed in this COBDIR hash-numbered directory. In the examples below, the install
location generates a hash of 12345.

The file /opt/microfocus/config/12345/COBDIRlocation.txt details the COBDIR the
configuration area is associated with.

Currently, the setup file only moves the following files and directories:

Source Destination

secrets /opt/microfocus/config/12345/secrets/

commonwebadmin.json /opt/microfocus/config/12345/escwa/
commonwebadmin.json

mfdsacfg.xml /opt/microfocus/config/12345/mfds/
mfdsacfg.xml

mfds /opt/microfocus/config/12345/mfds/
mfds/

If you have changed any other files in the original installation, you need to be copy these manually from the
backup directory, /opt/microfocus/EnterpriseDeveloper.BKP.YYYY-MM-DD.HH:MM:SS, into the
install location after the upgrade installation is complete.

Micro Focus Enterprise Developer UNIX Components Installation Options

Installing into a different location

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./setup_entdev_8.0_platform -installlocation="full path of new location"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter the -
help option.

Configuring the Enterprise Server installation

You can use the following options to configure the Enterprise Server installation: [ -ESsysLog="Y/N" ]
[ -ESadminID="User ID" ] [ -CASrtDir="location" ], where:

-ESsysLog Use this to enable ("Y") or disable ("N") Enterprise Server system logging. Logging is
enabled by default. Log files are saved in /var/mfcobol/logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command line -
for example, -ESadminID="esadm". The default user ID is the one that runs the installer.

-CASrtDir Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.
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Installing Silently

You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.

You can use the following command line arguments to install silently on UNIX/Linux. You need to execute
the commands as root:

–silent -IacceptEULA

For example, execute:

setup_filename –silent -IacceptEULA

After Installing
• See Changes in Behavior or Usage in your product documentation and in the Release Notes for

important information about changes in this release that might affect existing applications.
• Check the Product Documentation section of the Micro Focus Customer Support Documentation Web

site for any documentation updates.

Configuring Enterprise Developer
If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the perspective you
are working with after installation:

1. Open the existing workspace with this product.

You may receive some warnings or errors which you can ignore.
2. Make sure you are in the perspective you need to reset by clicking Window > Perspective > Open

Perspective > Other.
3. From the Open Perspective dialog box, click the perspective you want to reset.
4. Click OK.
5. Click Window > Perspective > Reset Perspective.
6. When prompted, click Yes.
7. Reapply any customizations.

On Windows

Using an X Server on Windows

Some features of Enterprise Developer for Eclipse on Windows require an X Server installation such as
Micro Focus Reflection Desktop for X or Micro Focus ViewNow X.

Managing the Microsoft Build Tools and Windows SDK Packages

There are a number of COBOL development features that depend on the Microsoft Build Tools and
Windows SDK packages. By default, the product installer downloads and installs these packages to their
default locations. The installer then sets your COBOL environment to depend on those downloaded
versions.

You can use the Microsoft Build Tools and Windows SDK Packages configuration utility - cblms - to view
which versions are in use, and also configure your COBOL environment if you require something other
than the standard usage.

There is an option within the product installer to skip the installation of the default packages
(skipmstools=1); however, this does skip both packages, so make sure that you do already have the
package(s) that you require before setting this - see Microsoft Package Dependencies for details on the
package(s) you may require.
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The Microsoft Build Tools and Windows SDK Configuration Utility

Use the cblms command line utility to view and set the package versions in effect for your COBOL environment.

Important: If you are updating or clearing package versions, you must run this utility from a command
prompt with administrative privileges.

Syntax:
cblms <option>

Parameters:

Note: <option> settings are case insensitive.

<option> can be one of:

-U
Updates the COBOL environment to use the latest versions of the Microsoft Build Tools
and SDK packages that are located in the default folders. Any open IDE instance or
command prompt must be restarted before these changes take effect.

-U<ms-pkg>
Updates the COBOL environment to use the latest version of the particular package type
that is located in the default folder. Any open IDE instance or command prompt must be
restarted before these changes take effect.

-U<ms-pkg>:<version>
Updates the COBOL environment to use a specific version of the particular package type
that is located in the default folder.Any open IDE instance or command prompt must be
restarted before these changes take effect.

-U<ms-pkg>:<path>
Updates the COBOL environment to use the latest version of the particular package type
that is located in the (non-default) folder specified. Any open IDE instance or command
prompt must be restarted before these changes take effect.

-U<ms-pkg>:<path>?<version>
Updates the COBOL environment to use a specific version of the particular package type
that is located in the (non-default) folder specified. Any open IDE instance or command
prompt must be restarted before these changes take effect.

-L
Lists all versions of the Microsoft Build Tools and SDK packages that are located in the
default folders.

-L<ms-pkg>
Lists all versions of a particular package type that are located in the default folder.

-L<ms-pkg>:<path>
Lists all versions of a particular package type that are located in the (non-default) folder
specified.

-Q
Displays the versions currently in use by the COBOL environment.

-Q<ms-pkg>
Displays the version of the selected package type that is currently in use by the COBOL
environment.

-R
Clears all version information. (Only use this option when instructed to by Customer Care.)
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-H
Displays the available command line options.

Legend:

<ms-pkg> <ms-pkg> can be one of S or SDK for the Microsoft SDK, or B or BT for the Microsoft Build
Tools.

<path> <path> is the path in which to locate packages that are not installed to the default location for
their package type.

<version> <version> is the package version with which to update when the latest version is not the one
required. When specifying version, it must be in the form:

• n.n.n.n for a Windows SDK
• n.n.n for Build Tools
• n for list ID - the list ID is displayed using cblms -L.

The following example updates the COBOL environment to use version 10.0.17134.0 of
the Windows 10 SDK, installed in C:\WinSDK\10.

cblms -USDK:C:\WinSDK\10\10.0.17134.0

Viewing the Product Help

Enterprise Developer is configured to display the product help available online on the Micro Focus
Customer Care website: https://www.microfocus.com/en-us/support/documentation/.

You can view the Enterprise Developer product help in one of the following ways:

Choose whether to view the help online or locally

You can configure Eclipse to show the Enterprise Developer help either online or locally:

1. In Eclipse, click Window > Preferences > Micro Focus > Help.
2. Either disable or enable Use online documentation, depending on whether you want to see the

documentation locally or online.

Online help (default)

• Click Help > Micro Focus > Product Documentation.
• Alternatively, press F1 inside the editor or from a UI part.

This opens a browser with the Enterprise Developer help.

Note: Ensure that you have an up-to-date version of your browser.

Local help

1. Configure Eclipse to use local help as detailed above.
2. Access the local help in one of the following ways:

• Click Help > Help Contents to open the Help Viewer, then open the Micro Focus-branded
documentation.

• Alternatively, press F1 inside the editor or after clicking a dialog within the UI.
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Repairing on Windows

If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

Uninstalling

To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.

During the uninstall process, only those files added during the installation (to the installation and Samples
directories) are removed. If the installation installed the Microsoft Windows 10 SDK or Microsoft Build Tools
packages, these are left in place, although the Micro Focus-related registry entries for these packages are
removed.

If the product directory has not been removed, delete any unwanted files and subdirectories within it using
Windows Explorer.

Note: The installer creates separate installations for Micro Focus Enterprise Developer Micro Focus
Analysis Services Integration, and Micro Focus License Administration. Uninstalling only Enterprise
Developer does not automatically uninstall the Micro Focus License Administration or any of the
prerequisite software.

To completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Some registry entries are not removed by the uninstallation process and you need to manually delete
them.

The following folders might not be removed:

• The Micro Focus Product Name folder in the Start menu - you can delete it manually.
• %systemdrive%\Users\Public\Documents\Micro Focus - includes the binaries and the log

files of the samples which you have built.
• %ProgramData%\Micro Focus - includes some data files used by the Micro Focus licensing system.
• %Program Files%\Micro Focus - you can delete it manually.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:

start /wait install-file.exe /quiet /uninstall

In addition, the following registry entries are not removed. These are created the first time that an
Enterprise Server that has been enabled for performance monitoring starts up:

• Micro Focus Server\Performance\Active Servers
• Micro Focus Server\Performance\PerfIniFile

On UNIX
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Configuring the Remote System Explorer Support

Note: The following only applies if you are using Micro Focus Enterprise Developer UNIX
Components with Enterprise Developer for Eclipse.

The remote development support from the Eclipse IDE relies upon Micro Focus Enterprise Developer UNIX
Components running on the UNIX machine and handling all requests from the IDE for building and
debugging programs. Micro Focus Enterprise Developer UNIX Components provides a UNIX daemon, the
Remote Development Option (RDO) daemon, which initiates the RDO as Eclipse clients connect to it.
Whichever environment is used to start the RDO daemon will be inherited for all servers and hence all build
and debug sessions.

Configuring the Environment

You may need to configure some aspects of the environment before you start the daemon. This is because
when a build or debug session is initiated from one of the Eclipse clients, the environment used will be
inherited from whatever was used to start the daemon. A typical example of the kind of environment that
might need to be set up would include database locations and settings for SQL access at build/run time.

Starting the Daemon

Important: Before starting the daemon you must have the following on your UNIX machine:

• A version of Perl.
• A version of Java 8 or later.
• The as (assembler) and ld (linking) programs on the path, as specified by the PATH environment

variable.

The daemon can be run with or without parameters. If no parameters are specified, the process relies on
the default values in $COBDIR/remotedev/rdo.cfg.

Use the following syntax to start the daemon (with super-user authority) on the remote host:

$COBDIR/remotedev/startrdodaemon [<port> <low port>-<high port>] 

where:

• <port> is the port number that the daemon should use to listen for connections from Eclipse. If no value
is given, it will default to the value specified in $COBDIR/remotedev/rdo.cfg; the default value on
installation is 4075.

Example: To start the daemon listening on port 4999:

$COBDIR/remotedev/startrdodaemon 4999

This command will override the default port in rdo.cfg.
• <low port>-<high port> is the range of ports on which the servers (launched by the daemon) should use

to communicate with Eclipse on the client machine. If no values are given, the range defaults to that
specified in $COBDIR/remotedev/rdo.cfg; the default range on installation is 10000-10003.

Example: To instruct the daemon (on port 4999) to instantiate servers using a range of ports
4090-4993:

$COBDIR/remotedev/startrdodaemon 4999 4090-4993

This command will also override the default ports in rdo.cfg.

If the server has an active firewall, it is important that these ports are open in the firewall settings. You can
use the configrdo utility to set the default ports in rdo.cfg to ones already open in the firewall. If you
are running on Red Hat 7.2 (or later) or CentOS 7.2 (or later), you can also use the utility to open the
required ports in the active firewall. See Configuring the firewall for more information.
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Stopping the Daemon

To stop the daemon, type the following command with super-user authority:

$COBDIR/remotedev/stoprdodaemon <port>

Enabling SHIFT-JIS

By default, support for the character encoding for the Japanese language, Shift-JIS, is not available on
Ubuntu and on RedHat OS version 8 or later.

You need to generate the Shift JIS locale on your machine to be able to execute Shift-JIS applications on
these platforms. You can do this as follows:

1. On RedHat 8, ensure that the glibc-locale-source package is installed.
2. Execute the following command with superuser rights in order to generate a Shift-JIS locale using the

charset:

sudo localedef -f SHIFT_JIS -i ja_JP ja_JP.sjis

3. Set the COBUTF8 environment variable to the generated Shift-SJIS locale and LANG to a UTF8 locale:

export COBUTF8=ja_JP.sjis
export LANG=ja_JP.UTF-8

4. Run the cobutf8 utility:

cobutf8 <command>

See your product documentation for more details about cobutf8.

Repairing on UNIX

If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Uninstalling

Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_EnterpriseDeveloper8.0.sh script in the $COBDIR/bin
directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Installing Enterprise Developer for Eclipse (UNIX)
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Before Installing

Downloading the Product
1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/

download/downloadCenter.
2. Select your account and click Entitlements.
3. Search for the product by using any of the available search parameters.
4. Click Show all entitlements.
5. Click Get Software in the Action column for the product you want to download or update.

In the File Type column, you see entries for "Software" for any GA products, and "Patch" for any patch
updates.

6. Click Download on the relevant row.

System Requirements for Enterprise Developer for Eclipse (UNIX)

Hardware Requirements for Enterprise Developer for Eclipse

Enterprise Developer has the following requirements in addition to the requirements of Eclipse. See the
Eclipse documentation for details of its requirements.

The disk space requirements are approximately:

Platform Installer type Setup

file size

Disk space

required for

the installation

Disk space

required for

running

the product

Licensing
technology

x86-64
running Red
Hat Linux

Micro Focus 1.77 GB 7.07 GB 3.53 GB 50 MB

x86-64
running
CentOS

Micro Focus 1.77 GB 7.07 GB 3.53 GB 50 MB

x64 running
SUSE SLES

Micro Focus 1.55 GB 6.19 GB 3.1 GB 50 MB

System Z
running SUSE
SLES

Micro Focus 888 MB 3.55 GB 1.78 GB 50 MB

Amazon Linux
2

Micro Focus 1.55 GB 6.19 GB 3.1 GB 50 MB

x64 running
Ubuntu

Micro Focus 1.63 GB 6.51 GB 3.25 GB 50 MB

Operating Systems Supported

For a list of supported operating systems, see Supported Operating Systems and Third-party Software in
your product documentation.

On some platforms, there is only a 64-bit version of this product. 64-bit versions of the product support
compiling to and running 64-bit programs only.
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Software Requirements

The setup file requires that the following software and libraries are installed before you start the installation,
and that certain environment variables are set.

• Software required by the setup file
• Libraries required by the setup file
• Required environment variables
• Software installed by the setup file
• Requirements for running the product
• License Manager requirements

Software required by the setup file

The following software must be installed in advance:

• Java versions 11 through 15 from Adoptium (such as the Adoptium OpenJDK Temurin 11 (LTS) with
HotSpot) and Oracle are required for Enterprise Developer for Eclipse.

• The unzip utility.
• The "awk", "ed", "ps", "sed", tar", "sed", and "which" utilities must be installed and added to the PATH.
• If SELinux is installed and you plan to use anything other than core COBOL functionality, or plan to use

Enterprise Server within an environment with ASLR enabled, the "SELINUX" configuration must be
disabled. To do this, set SELINUX=disabled in /etc/selinux/config.

Libraries required by the setup file

The 32-bit libraries listed below are required on both 32-bit and on 64-bit Operating Systems for this
product to install and work correctly.

If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before you
start the installation.

Library Bitism Platform

32-
bit

64-
bit

SUSE 121 SUSE 151 Red Hat 7 Red Hat 8 Ubuntu
20.4

Amazon
Linux 2

glibc2 X X X X X

libgcc X X X X X

libgc1c2 X X

libstdc++ X X X X X

glibc-locale3 X X X X

libXtst6 X X X X

libXtst X X X X

glibc-devel X X X

gtk3 X X7 X7 X7

PackageKit-
gtk3

X X7 X7 X7

libcanberra-
gtk3

X X7 X7 X7

webkitgtk3 X X7 X7

webkit2gtk3 X X7
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Library Bitism Platform

32-
bit

64-
bit

SUSE 121 SUSE 151 Red Hat 7 Red Hat 8 Ubuntu
20.4

Amazon
Linux 2

xterm Any
versi
on

Any
versi
on

X X X X

unzip Any
versi
on

Any
versi
on

X X X X

libgnome X X

libelf-
devel-0.137-8
.19**

X

libelf1-0.137-
8.19**

X

libelf1-32bit-0.
137-8.19**

X

libgtk-3-0 X X7 X7 X

gtk3-tools X X7 X7

gcc45 X X X X X X X

cpp4 X X X X

ld4 X X X X X

libnotify-tools6 X X X X

libnotify X X

libjasper1 X X X

libjasper4 X X

Note:

• Libraries marked with an 'X' are not included in the platform and need to be installed separately.
• 1On SUSE 12 or 15, you can only install the 64-bit version of Enterprise Developer. The glibc-

locale-32bit library is still required by the SafeNet licensing components.
• * Additional libraries required to use the core_on_error runtime variable. The gdb packages (for the

GNU Project Debugger) can be installed from the install media for your OS.
• 2The glibc-locale-32bit library is only required if you want to install the SafeNet licensing

components. If this is present, the installer installs and configures both SafeNet and AutoPass
licensing. If glibc-locale-32bit is not installed, the installer only installs AutoPass licensing.

• 3On 64-bit Red Hat 7, you only need to install glibc-2.17*.x86_64 and glibc-2.17*.i686.
• 4On Red Hat, these libraries are required to enable COBOL and PL/I to compile.
• 5On Red Hat, only the 64-bit gcc libraries are required.
• 6For SUSE 12 and later, you might need to install the Notifications Library tools (libnotify-tools).

This is to enable notifications to be displayed by the notify-send tool when starting Enterprise
Developer for Eclipse from a desktop icon. Execute the following command to install the libnotify-
tools library:

zypper install libnotify-tools

• 7The minimum GTK support required is 3.22. Certain platforms meet this requirement without the
need of installing the libraries manually; for example Red Hat 7.4 and SUSE 12 SP3.
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• **Operating system libraries required for PL/I support on both SUSE and Red Hat.

Visit the Red Hat Web site for more information.

Required environment variables

Before you start the installation, you need to set the environment as follows:

• Set the JAVA_HOME environment variable. When installing the product, set this variable to a 64-bit
Java installation or the installation terminates. For example, execute the following:

export JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• Add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• You need to set the LANG environment variable to pick up localized messages. If you do not set it as
specified here, the installation will run but you might experience unexpected behavior from the installer.

The LANG settings are English and Japanese only so set it to one of the following locales:

C, default, en_GB, en_GB.UTF-8, en_US, en_US.UTF-8

ja_JP, ja_JP.SJIS, ja_JP.UTF-8, ja_JP.eucJP, ja_JP.eucjp, ja_JP.sjis, 
ja_JP.ujis, ja_JP.utf8, japanese

You can set LANG before running the setup file as follows:

export LANG=C

Alternatively, add it to the start of the setup command line:

LANG=C ./setupfilename

See Using the LANG Environment Variable for details.

Software installed by the setup file

• The setup file installs Enterprise Developer and the 64-bit version of Eclipse 4.20 (2021-06). After the
installation, you can install Enterprise Developer as a plug-in into other Eclipse 4.20 (2021-06)
instances available on the same machine - see Installing Enterprise Developer into other instances of
Eclipse.

Note: On SUSE platforms, you can only use the 64-bit version of Eclipse to produce 64-bit
applications; on other 64-bit platforms, you can use Eclipse to produce both 32-bit and 64-bit
applications.

• Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

Requirements for running the product

• Java 11 (64-bit) is required to run the Eclipse IDE. The minimum recommended version is Adoptium's
OpenJDK Temurin 11 (LTS) with HotSpot, which the Windows product installs automatically. You can
download Adoptium's OpenJDK Temurin 11 (LTS) with HotSpot from Adoptium's Web site and unpack
the archive anywhere on your machine.

License Manager requirements

• For local servers, you do not need to install the Micro Focus License Administration tool separately, as
the setup file installs a new Enterprise Developer client and a new licensing server on the same
machine.

• If you have any network license servers, you must update them before you update the client machines.
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• If you are upgrading from Enterprise Developer release 2.2 or earlier, uninstall the license manager
before installing the product.

You can download the new version of the license server software by following these steps:

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter.

2. Select your account and click Downloads.
3. Select a product and a product version from your orders.
4. In the list of software downloads, locate the License Manager.
5. Click Download to download an archive with the installers.
6. Run the installer suitable for your Operating System to install License Manager on your machine.

Issues with the Installation on UNIX and Linux

Installing on Linux

On Linux, the RPM installer for Enterprise Developer for Eclipse installs a 64-bit version of Java. When you
start the installation, if the 32-bit version of Java is already installed on your Linux machine, you might not
be able to install Enterprise Developer. This is a known issue with the Oracle Java installers for Linux which
prevents you from installing both the 32-bit and the 64-bit versions of Java on the same machine. To work
around this problem:

• Download the 64-bit Java distribution in a compressed .tar format from the Oracle Web site.
• Untar the distribution into a location different from the one used for the 32-bit Java version. For example,

untar in /usr/local/java64 and not in /usr/local/java.
• Set JAVA_HOME and LD_LIBRARY_PATH to the 64-bit version of Java so that it is used to install and

run Enterprise Developer.

Installing on Red Hat 8.x s390

On Red Hat 8.x s390, the RPM non-root install method is not supported due to errors given by cpio. You
receive the following messages:

error: unpacking of archive failed on file /usr/lib/.build-id/1b/
af99f26c6b4c00ca499a3199a574b73aeb3854;6092b79c: cpio: symlink failed - No 
such file or directory
error: Micro_Focus_cobol_server-7.0.0.0-100700.s390x: install failed

As a result, the installation in this scenario is incomplete.

Installing while using AFS/Kerberos authentication

If you are using AFS/Kerberos authentication to log onto your Linux system then you need to ensure you
have a local user ID which SOA and Enterprise Developer components of the product can use. This user
ID must be set up prior to running the installer. When running the installer you need to specify -
ESadminID=[User ID] on the command line so it is used by the installer.

License Server

You need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the /etc/hosts file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.
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Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.

For considerations when installing this product as an upgrade, for additional installation options or non-
default installations and for installing the mainframe components, see Advanced Installation Tasks in your
product Help.

Installing the software
Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus installer for
installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for installing on Linux.
See your product Help for instructions on how to use the RPM installer.

Before starting the installation, see Software Requirements.

These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:

chmod +x setup_entdev_edeclipse_8.0_platform

2. Run the setup file with superuser permissions:

./setup_entdev_edeclipse_8.0_platform

If you don't run this as superuser, you are prompted to enter the superuser password during the install.

The COBOL environment is installed by default into /opt/microfocus/EnterpriseDeveloper,
(COBDIR). A full version of Eclipse, with the Micro Focus plugins already installed, is present in the
$COBDIR/eclipse directory.

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./setup_entdev_edeclipse_8.0_platform -installlocation="full path of new 
location"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter
the -help option.

Note: See Installing in an Ubuntu Docker Image Running on Windows 11 for specific installation
instructions for this scenario.

SafeNet Sentinel considerations

• The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the -skipsafenet option, which skips the
installation of SafeNet:

. /setup_entdev_edeclipse_8.0_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL
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While the file is present, the SafeNet installer does not make changes to the installation or shutdown the
running license daemons. If licensing needs to be updated later, you can rerun the
MFLicenseServerInstall.sh from within the $COBDIR/safenet folder with the force command
line option:

cd $COBDIR/safenet
./MFLicenseServerInstall.sh force

AutoPass Licensing considerations

• The installation of this product could affect the AutoPass licensed components running on your
machine. During installation, the licensing shuts down to allow files to be updated. To ensure the
processes running on your machine are not affected, you need to use the -skipautopass option, which
skips the installation of AutoPass:

./setup file -skipautopass

• To protect the AutoPass installation from accidental updating, you can create an empty file named
SKIP_AUTOPASS_INSTALL in /opt/microfocus/licensing as follows:

touch /opt/microfocus/licensing/SKIP_AUTOPASS_INSTALL

While the file is present, the AutoPass installer does not make changes to the installation or shutdown
the running license daemons. If licensing needs to be updated later, you can rerun the
MFLicenseServerInstall.sh from within the $COBDIR/safenet folder with the force command
line option:

cd $COBDIR/safenet
./MFLicenseServerInstall.sh force

Setting up the environment
If you have installed the product to a directory other than the default one, you need to set the environment
as described below.

Note: The default directory is /opt/microfocus/EnterpriseDeveloper.

1. To set up your product, execute:

. <product-install-dir>/bin/cobsetenv

2. To verify that your product is installed, execute:

cob -V

Important: These commands set the environment only for the current shell. You need to execute
them for each new shell that you start.

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(such as /etc/profile, /etc/bashrc).

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Starting the product
To start Eclipse:

• If you are using a GUI interface, double-click the product icon (automatically installed on your desktop).

Note: The installer automatically creates a shortcut icon for the product on the desktop for the user
for which you ran the install script. If you need to create desktop icons for other users' desktops on
the same machine, or if the icon was not created on the desktop for the root user, run the following
shell script as the user you need to login as: $COBDIR/bin/createdesktopicon.sh
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• If you are using a non-GUI interface, such as a terminal emulator, type the following from a command
prompt:

eclipse

Advanced Installation Tasks
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install the additional components.

The advanced installation tasks include:

• Installing as an Upgrade - included in these Release Notes
• Command line installation options - included in these Release Notes
• Installing using an RPM installer on Linux - available in the product Help and in the Micro Focus

Infocenter
• Installing and licensing Micro Focus Rumba - available in the product Help and in the Micro Focus

Infocenter
• Installing into other instances of Eclipse - available in the product Help and in the Micro Focus

Infocenter
• Installing the Mainframe Components, - Mainframe Access Server, Application Workflow Manager into

IDz, z/Server - available in the product Help and in the Micro Focus Infocenter
• Installing on Microsoft Terminal Server and Citrix - available in the product Help and in the Micro Focus

Infocenter

Click here to see this information on the Product Documentation pages on Micro Focus Customer Care.

Installing in an Ubuntu WSL2 on Windows
The following instructions apply when you install the product inside Ubuntu 20.04 WSL2 on Windows.

Note: The embedded Rumba Mainframe Display view is not supported in this scenario. You can use
the HACloud TN3270 Session Server which is available with the product instead. See Terminal
Emulation with Micro Focus Host Access for the Cloud.

Prerequisites

You need to have a new instance of a Ubuntu 20.04 WSL2 running on Windows.

1. In Windows, open the Ubuntu WSL2 console.
2. Download and install Java. Eclipse supports versions 11 through to 15.
3. Create a symbolic link in Ubuntu from java-install-dir/bin/java to /usr/bin/java.

This enables the installer to locate Java when you run commands as the root user.
4. Execute the following commands to install the prerequisites for Enterprise Developer:

sudo apt-get update
sudo apt-get install libgc1c2
sudo apt-get install libgtk-3-0
sudo apt-get install libnotify-bin
sudo apt-get install unzip
sudo apt-get install xterm
sudo apt-get install nasm
sudo apt-get install gcc

Installing the product

• To install the product, execute:

sudo ./setup_enterprisedeveloper_deveclipse_8.0_ubuntu_x64

• Follow the rest of the instructions in these Install Notes to license the product, and to set the
environment.
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Known issues in Ubuntu running on Windows 11

• The Eclipse icon in the Windows Start menu does not work.
• If you reset Ubuntu 20.04 WSL2, the Micro Focus icons created in Ubuntu are not removed from the

Start menu.

Installing as an upgrade
This release works concurrently with the previous version of Enterprise Developer, so you do not need to
uninstall it.

Install the latest version in a different location and set the environment to point to it. To do this, run the
Enterprise Developer installer with the –installlocation option:

1. Execute the following command:

. /InstallFile -installlocation="/opt/microfocus/EnterpriseDeveloper"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

2. Execute cobsetenv to set the environment and point to the new install location:

. <product-install-dir>/bin/cobsetenv

Note: cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Preserving the MFDS and Enterprise Server region configuration

The following information applies when you are upgrading from releases 6.0 or 7.0.

If you install this release to the same install location as release 6.0 or 7.0, the product in the current
location is moved to a backup directory name.

For example, if the 7.0 product is installed in the default install location, /opt/microfocus/
EnterpriseDeveloper, during the upgrade it is moved to /opt/microfocus/
EnterpriseDeveloper.BKP.YYYY-MM-DD.HH:MM:SS. The new release will be installed in /opt/
microfocus/EnterpriseDeveloper.

Note that your original installation might include some files that you changed or added to, and you need
those changes preserved in the new installation.

During the upgrade, the installer moves a number of changed files to a different configuration location and
symbolically links them back into the new release install location. The configuration location is one of the
following:

• The default config location is /opt/microfocus/config/.
• For non-root installation, the default location is $HOME/microfocus/config/.
• To specify your own configuration location, run the setup file with the following command-line option: -

mfconfiglocation=[location]

The setup file creates a directory in the configuration location using the sum of the value of the $COBDIR
path. This is so that each configuration area is unique to each product installation. The configuration files
and directories are then placed in this COBDIR hash-numbered directory. In the examples below, the install
location generates a hash of 12345.

The file /opt/microfocus/config/12345/COBDIRlocation.txt details the COBDIR the
configuration area is associated with.

Currently, the setup file only moves the following files and directories:
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Source Destination

secrets /opt/microfocus/config/12345/secrets/

commonwebadmin.json /opt/microfocus/config/12345/escwa/
commonwebadmin.json

mfdsacfg.xml /opt/microfocus/config/12345/mfds/
mfdsacfg.xml

mfds /opt/microfocus/config/12345/mfds/
mfds/

If you have changed any other files in the original installation, you need to be copy these manually from the
backup directory, /opt/microfocus/EnterpriseDeveloper.BKP.YYYY-MM-DD.HH:MM:SS, into the
install location after the upgrade installation is complete.

Installation Options

Installing into a different location

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./setup_entdev_edeclipse_8.0_platform -installlocation="full path of new 
location"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter the -
help option.

Configuring Enterprise Server

You can use the following options to configure the Enterprise Server installation: [ -ESsysLog="Y/N" ]
[ -ESadminID="User ID" ] [ -CASrtDir="location" ], where:

-ESsysLog Use this to enable ("Y") or disable ("N") Enterprise Server system logging. Logging is
enabled by default. Log files are saved in /var/mfcobol/logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command line -
for example, -ESadminID="esadm". The default user ID is the one that runs the installer.

-CASrtDir Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Installing Silently

You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.

You can use the following command line arguments to install silently on UNIX/Linux. You need to execute
the commands as root:

–silent -IacceptEULA
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For example, execute:

setup_filename –silent -IacceptEULA

After Installing
• See Changes in Behavior or Usage in your product documentation and in the Release Notes for

important information about changes in this release that might affect existing applications.
• Check the Product Documentation section of the Micro Focus Customer Support Documentation Web

site for any documentation updates.

Configuring Enterprise Developer
If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the perspective you
are working with after installation:

1. Open the existing workspace with this product.

You may receive some warnings or errors which you can ignore.
2. Make sure you are in the perspective you need to reset by clicking Window > Perspective > Open

Perspective > Other.
3. From the Open Perspective dialog box, click the perspective you want to reset.
4. Click OK.
5. Click Window > Perspective > Reset Perspective.
6. When prompted, click Yes.
7. Reapply any customizations.

Configuring the Environment for Developing RDBMS Applications on
UNIX

Note:

• If you are working with remote projects, you need to configure the environment before you start the
remote server process.

• On UNIX, if you are working with local projects, you need to configure the environment before you
start Eclipse.

1. Ensure the COBOL and the third-party software environments are set.
2. Set up the RDBMS environment.

Refer to your RDBMS vendor documentation for details.
3. Set COBCPY as required in order for the IDE to locate any copybooks that are external to your project.
4. If working with Pro*COBOL/Cobsql applications you need to set COBOPT. This sets the appropriate

linker options for the platform and the COBOL working mode:

To do this, execute the following at the command line:

$COBDIR/src/oracle/set_cobopt_oracle
COBOPT=$PWD/cobopt.ora
export COBOPT

Enabling SHIFT-JIS
By default, support for the character encoding for the Japanese language, Shift-JIS, is not available on
Ubuntu and on RedHat OS version 8 or later.

You need to generate the Shift JIS locale on your machine to be able to execute Shift-JIS applications on
these platforms. You can do this as follows:
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1. On RedHat 8, ensure that the glibc-locale-source package is installed.
2. Execute the following command with superuser rights in order to generate a Shift-JIS locale using the

charset:

sudo localedef -f SHIFT_JIS -i ja_JP ja_JP.sjis

3. Set the COBUTF8 environment variable to the generated Shift-SJIS locale and LANG to a UTF8 locale:

export COBUTF8=ja_JP.sjis
export LANG=ja_JP.UTF-8

4. Run the cobutf8 utility:

cobutf8 <command>

See your product documentation for more details about cobutf8.

Viewing the Product Help
Enterprise Developer is configured to display the product help available online on the Micro Focus
Customer Care website: https://www.microfocus.com/en-us/support/documentation/.

You can view the Enterprise Developer product help in one of the following ways:

Choose whether to view the help online or locally

You can configure Eclipse to show the Enterprise Developer help either online or locally:

1. In Eclipse, click Window > Preferences > Micro Focus > Help.
2. Either disable or enable Use online documentation, depending on whether you want to see the

documentation locally or online.

Online help (default)

• Click Help > Micro Focus > Product Documentation.
• Alternatively, press F1 inside the editor or from a UI part.

This opens a browser with the Enterprise Developer help.

Note: Ensure that you have an up-to-date version of your browser.

Local help

1. Configure Eclipse to use local help as detailed above.
2. Access the local help in one of the following ways:

• Click Help > Help Contents to open the Help Viewer, then open the Micro Focus-branded
documentation.

• Alternatively, press F1 inside the editor or after clicking a dialog within the UI.

Repairing
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Uninstalling
Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_EnterpriseDeveloper8.0.sh script in the $COBDIR/bin
directory.
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Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
Note:

• If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.

• The latest version of the SafeNet licensing software is required. See the Software Requirements
section in this document for more details.

• If you are unsure of what your license entitlement is or if you wish to purchase additional licenses,
contact your sales representative or Micro Focus Customer Care.

To start Micro Focus License Administration

Windows: To start the GUI Micro Focus License Administration

Windows 10 From your Windows desktop, click Start > Micro Focus License Manager > License
Administration.

Windows 11 Click the Start button in the Task Bar. Use the search field in the Start menu to find and
start License Administration.

Windows: To start the command-line Micro Focus License Administration tool

1. At a command prompt, navigate to:

C:\Program Files (x86)\Micro Focus\Licensing

2. Type cesadmintool.bat, and press Enter.

UNIX

Log on as root, and from a command prompt type:

/var/microfocuslicensing/bin/cesadmintool.sh

Installing licenses
You need either a license file (with a .mflic extension for Sentinel RMS licenses or an .xml extension for
AutoPass licenses) or an authorization code which consists of a string of 16 alphanumeric characters
(Sentinel RMS licenses only). You need to install AutoPass licenses into the existing Micro Focus License
Administration tool, and not in the AutoPass License Server.

If you have a license file

Windows: To use the GUI Micro Focus License Administration

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:

• Click Browse next to the License file field and select the license file (which has an extension
of .mflic or .xml).
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• Drag and drop the license file from Windows Explorer to the License file field.
4. Click Install Licenses.

Alternatively, you can install the license file from within the IDE as follows:

1. Start Enterprise Developer.
2. Click Help > Micro Focus > Product Licensing to open the Product Licensing dialog box.
3. Ensure I have a full Enterprise Developer Team Edition license is checked.
4. Click Browse next to the License file field.
5. Select the license file (which has an extension of either .mflic or .xml), and then click Open.
6. Click Finish to install the license.

Windows: To use the command-line Micro Focus License Administration tool

1. Start the command-line Micro Focus License Administration tool.
2. Select the Manual License Installation option by entering 4.
3. Enter the name and location of the license file.

UNIX

1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.

2. Enter the name and location of the license file.

If you have an authorization code
Note: Authorization codes are only available with Sentinel RMS licensing.

Authorizing your product when you have an Internet connection
Note:

• This topic only applies if you have an authorization code. Authorization codes are only available
with Sentinel RMS licensing.

• It is not possible to install licenses remotely. You must be logged into the machine on which you
are installing the licenses.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

Windows: To use the GUI Micro Focus License Administration

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Type the authorization code in the Enter authorization code field.
4. Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

Windows: To use the command-line Micro Focus License Administration tool

1. Start the command-line Micro Focus License Administration tool.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter.
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UNIX

1. Start Micro Focus License Administration.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter.

Authorizing your product when you don't have an Internet connection
Note: This topic only applies if you have an authorization code. Authorization codes are only available
with Sentinel RMS licensing.

This method of authorization is required if the machine you want to license does not have an Internet
connection or if normal (automatic) authorization fails.

Windows: To use the GUI Micro Focus License Administration

1. Start Micro Focus License Administration.
2. On the Install tab, click Manual Authorization.
3. Make a note of the contents of the Machine ID field. You will need this later.
4. Do one of the following:

• If your machine has an Internet connection, click the Customer Care Web link in the Manual
Authorization Information window.

• If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus Customer Care Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character

alphanumeric string supplied when you purchased your product.
6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License

file field on the Install page.
10.Click Install Licenses.

Windows: To use the command-line Micro Focus License Administration tool

In order to authorize your product from the command-line Micro Focus License Administration tool you
must have the following:

• Access to a computer which is connected to the Internet.
• Your authorization code (a 16-character alphanumeric string).
• The machine ID. To get this, start the Micro Focus License Administration tool and select the Get

Machine Id option by entering 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.

1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.

2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.

3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by

entering 4.
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7. Enter the name and location of the license file.

UNIX

In order to authorize your product you must have the following:

• Access to a computer which is connected to the Internet.
• Your authorization code (a 16-character alphanumeric string).
• The machine ID. To get this, start the Micro Focus License Administration tool and select the Get

Machine Id option by entering 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.

1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.

2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.

3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by

entering 4.
7. Enter the name and location of the license file.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for
Enterprise Developer, contact your sales representative or Micro Focus Customer Care.
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Updates and Customer Care
Our Web site provides up-to-date information of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• Product Updates on Software Licenses and Downloads, where you can download fixes and
documentation updates.

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter .

2. Select your account and click Entitlements.
3. Search for the product by using any of the available search parameters.
4. Click Show all entitlements.
5. Click Get Software in the Action column for the product you want to download or update.

In the File Type column, you see entries for "Software" for any GA products, and "Patch" for any
patch updates.

6. Click Download on the relevant row.
• The Examples and Utilities section of the Micro Focus Customer Care Web site, including demos and

additional product documentation. Go to https://supportline.microfocus.com/examplesandutilities/
index.aspx.

• The Support Resources section of the Micro Focus Customer Care Web site, that includes
troubleshooting guides and information about how to raise an incident. Go to https://
supportline.microfocus.com/supportresources.aspx

To connect, enter https://www.microfocus.com/en-us/home/ in your browser to go to the Micro Focus home
page, then click Support & Services > Support. Type or select the product you require from the product
selection dropdown, and then click Support Login.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, https://www.microfocus.com/support-and-services/contact-support/. If you obtained the product from
another source, such as an authorized distributor, contact them for help first. If they are unable to help,
contact us.

Also, visit:

• The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See https://community.microfocus.com.

• The Micro Focus YouTube channel for videos related to your product. See Micro Focus Channel on
YouTube.

https://www.microfocus.com/en-us/resource-center/webinar
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Information We Need
If your purpose in contacting Micro Focus is to raise a support issue with Customer Care, you should
collect some basic information before you contact us, and be ready to share it when you do.

Click here to see the Preparing to Raise a Support Case topic on the Product Documentation pages on
Micro Focus Customer Care.

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus Customer
Care, your support representative might request that you provide additional debug files (as well as source
and data files) to help us determine the cause of the problem. If so, they will advise you how to create
them.
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Copyright and Disclaimer
© Copyright 2022 Micro Focus or one of its affiliates.

The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS IS" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.

Any links to third-party Web sites take you outside Micro Focus Web sites, and Micro Focus has no control
over and is not responsible for information on third-party sites.

This product includes software developed by Computing Services at Carnegie Mellon University (http://
www.cmu.edu/computing/).
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